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About This Document

Related Version

The following table lists the product version related to this document.

Product Name Version

iManager U2000 V100R002C01

Intended Audience

This document describes how to install the U2000 and obtain the reference information required
during the installation.

This document is intended for:

®  Technical support engineers
® Maintenance engineers

® Installation and commissioning engineers

Symbol Conventions

The symbols that may be found in this document are defined as follows.

Symbol Description
Indicates a hazard with a high level of risk, which if not
DANGER avoided, will result in death or serious injury.
Indicates a hazard with a medium or low level of risk, which
WARNING if not avoided, could result in minor or moderate injury.
Indicates a potentially hazardous situation, which if not
CAUTION avoided, could result in equipment damage, data loss,
performance degradation, or unexpected results.
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Symbol Description
o= TIP Indicates a tip that may help you solve a problem or save
time.
(] noTE Provides additional information to emphasize or supplement
important points of the main text.

Command Conventions

The command conventions that may be found in this document are defined as follows.

Convention Description

Boldface The keywords of a command line are in boldface.

Italic Command arguments are in italics.

[] Items (keywords or arguments) in brackets [ ] are optional.
{x]y]|..} Optional items are grouped in braces and separated by

vertical bars. One item is selected.

[x]y]...] Optional items are grouped in brackets and separated by
vertical bars. One item is selected or no item is selected.

{(x|yl]..}" Optional items are grouped in braces and separated by
vertical bars. A minimum of one item or a maximum of all
items can be selected.

[x|y]|..1T Optional items are grouped in brackets and separated by
vertical bars. Several items or no item can be selected.

GUI Conventions

The GUI conventions that may be found in this document are defined as follows.

Convention Description

Boldface Buttons, menus, parameters, tabs, window, and dialog titles
are in boldface. For example, click OK.

> Multi-level menus are in boldface and separated by the ">"
signs. For example, choose File > Create > Folder.
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Change History

Updates between document issues are cumulative. Therefore, the latest document issue contains
all updates made in previous issues.

Changes in Issue 05 (2010-11-19)

The fifth commercial release has the following updates:

Fixed some bugs.

Changes in Issue 04 (2010-09-24)

The fourth commercial release has the following updates:

Fixed some bugs.

Changes in Issue 03 (2010-08-16)

The third commercial release has the following updates:

Fixed some bugs.

Changes in Issue 02 (2010-07-16)

The second commercial release has the following updates:

Fixed some bugs.

Changes in Issue 01 (2010-05-18)

Initial release.
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1 Installation Overview

Installation Overview

This topic explains the terms involved with installing the U2000 into a SUSE Linux operating
system (OS).

A CAUTION

Servers are pre-installed with software from Huawei and can be commissioned immediately.
For more information, see the iManager U2000 Commissioning Guide. If servers are purchased
from other suppliers, install software according to the U2000 deployment.

Definitions for terms as used in this document:

Server: A server can refer to the hardware and/or software. In the client/server structure, a
server refers to the server program. The term refers to hardware when used in reference to
a computer where a server program runs.

Client: Refers to the client application of the software in a client/server structure. The client
application can run on a computer along with the server application or on a separate
computer. The term refers to hardware when used in reference to the computer where a
client application runs.

Workstation and host: A workstation functions the same as a host. Generally, a workstation
or host refers to the computer where services run in a SUSE Linux OS.

Master server: A master server refers to the server where the core processes of the
U2000 and database service are installed and deployed.

Slave server: It is used for a distributed system. A slave server is used to share the load of
the master server. It is placed at the same site of the master server and mounted to the
master server of the distributed system.

Distributed system: The distributed system includes the master server and slave server. The
master server and slave server constitute a site that takes on the functions of the U2000
server. The master server is the core of the distributed system. The database server and the
core components of the U2000 run on the master server. The non-core components of the
U2000 are running on the slave server, with the purpose of reducing the CPU usage and
memory usage of the master server so that the load on the master and slave servers can be
balanced. If the blade server has only one blade, the Slave server is not available.
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Figure 1-1 Network diagram of the single-server system (SUSE Linux-distributed)
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Component: Refers to a functional unit of software that you can select to install. A
component can consist of multiple deployment packages.

Deployment package: Refers to a software unit that is deployed on a computer.

In a distributed system, the deployment packages of a component may be deployed on
different computers.

Deployment packages are classified into the following types:

- System single-instance: These types of deployment packages can be installed on only
one server and each component can be deployed with only one instance.

- Single-server single-instance: These types of deployment packages can be installed on
multiple servers and each component can be deployed with only one instance on each
server.

- Single-server multi-instance: These types of deployment packages can be installed on
multiple servers and each component can be deployed with multiple instances on each
server.

1-2
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Installation Process

This topic describes the process of installing a single-server system (SUSE Linux-distributed)
in the Solaris OS, the reference chapters, and the time required for installation.

©== TIP

Installation engineers not familiar with SUSE Linux OS should read D Getting Started to learn about the
basic operations of the system.

The following table shows the reference chapters and the time required for installing a single-
server system (SUSE Linux-distributed).

A CAUTION

The OSs of the master server and slave server can be installed and configured at the same time.

If the blade server has only one blade, skip the operation for the slave server.

Table 2-1 Description about the process of installing the single-server system (SUSE Linux-
distributed)

Stage Description Chapter Duratio
n (Min)

1 This topic describes how to prepare | 3 Installation Preparations | 40
for installation of a single-server
system (SUSE Linux-distributed).

2 This topic describes how to 4 Configuring Hardware 30
configure server hardware according
to the models of the master server
and slave server, and how to
configure disk array hardware of the
master server as required.

3 This topic describes how to poweron | 5 Powering On a Server 10
the master server and slave server.

Issue 05 (2010-11-19) Huawei Proprietary and Confidential 2-1
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Stage Description Chapter Duratio
n (Min)
4 This topic describes how to install 6 Installing the SUSE Linux | 80
the Solaris OS on the master server | OS and Its Patches by Using
and slave server. the Quick Installation CD-
ROM
5 This topic describes how to install 7 Installing U2000 Software | 130
U2000 software. Before starting the
U2000 installation program, you
must preconfigure the systems of the
master server and the slave server.
6 This topic describes how to install a | 8 Loading a U2000 License | 5
U2000 license. Before using the
U2000, you must install a U2000.
7 This topic describes how to check 9 Verifying Installation of a | 10

installation of the single-server
system (SUSE Linux-distributed).

Single-Server System
(SUSE Linux-Distributed)

2-2
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Installation Preparations

About This Chapter

This topic describes how to prepare the software, hardware, and environment for the installation
of the single-server system (SUSE Linux-distributed).

3.1 Configuration Requirement
This topic describes hardware and software configuration requirements of the master and slave
servers of the single-server system (SUSE Linux-distributed).

3.2 Networking Structure
This topic describes the networking structure of a distributed system. Before installing a
distributed system, you must get familiar with the networking structure.

3.3 Installation Environment Requirements

This topic describes the environment conditions, such as the telecommunications room
environment, cable condition, and networking condition of the telecommunications room, that
you must get familiar with before you install a U2000.

3.4 Collecting Installation Information

This topic describes how to collect installation information. Before installing a distributed
system, collect required information, including the host name, IP address, route, time zone and
time, user password, installation path, component quantity, and instance quantity.

3.5 Checking Required Software
This topic describes how to verify that the software meets U2000 installation requirements.

3.6 Checking Hardware Connections
This topic describes how to check that hardware is installed and connected properly.

3.7 Applying for a U2000 License
This topic describes how to apply for a U2000 license.
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3.1 Configuration Requirement

This topic describes hardware and software configuration requirements of the master and slave
servers of the single-server system (SUSE Linux-distributed).
Hardware Configuration

The single-server system (SUSE Linux-distributed) can run on the SUSE Linux platform. The
following table lists the configuration requirements on the hardware of the master and slave
servers.

Table 3-1 Configuration requirements on server hardware

Hardware Description

Blade server ATAE-T8223 cabinet + BH23C server blade (CPU: 2 x Intel Xeon
Quad Core 2.13 GHz, memory: 16 GB, disk: 2 x 146 GB, network port:
4 or more)

Blade center E cabinet + IBM HS22 (CPU: 2 x Intel Xeon Quad Core
2.4 GHz or greater, memory: 16 GB, disk: 2 x 146 GB, network port:
4 or more)

Blade center E cabinet + IBM HS21 (CPU: 2 x Intel Xeon Quad Core
2.5 GHz, memory: 16 GB, disk: 2 x 146 GB, network port: 4 or more)

Disk array OceanStor S2600: 6 x 300 GB

1 NoTE

Disk arrays must meet the preceding configuration requirements. To use disk arrays with other
configurations, contact Huawei engineers to check whether such disk arrays are applicable to the single-
server system (SUSE Linux-distributed).

Software Configuration

The following table lists the configuration requirement on the software of the master and slave
servers of the single-server system (SUSE Linux-distributed).

Table 3-2 Configuration requirements on server software

Software Description

Operating system SUSE Linux Enterprise Server 10 with SP3

Database Oracle 11g Enterprise Edition Release 11.1.0.7
NMS software U2000 software
NOTE

The U2000 software can be installed on the OS with either the simplified Chinese
version or English version.
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3.2 Networking Structure

This topic describes the networking structure of a distributed system. Before installing a
distributed system, you must get familiar with the networking structure.

The following figure shows the networking structure of a distributed system.

Figure 3-1 Networking diagram for a distributed system
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Networking Diagram for a Distributed System

® In actual networking, the cables indicated by dotted lines in the preceding figure do not
need to be connected manually, and the connection is implemented inside the server chassis.
Details about the structure of a blade server chassis and the communications between a
public network and private network are as follows:

- Two switching planes are inside the chassis of an ATAE blade server: base plane and
fabric plane. The ATAE blade server is connected to a public network by the base plane.
The fabric plane is used for internal communications inside a distributed system.

- Four modules are inside the chassis of an IBM blade server: I/O module 1, I/O module
2, I/0 module 3, and I/O module 4. The IBM blade server is connected to a public
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network by I/0 module 1 and I/O module 2. I/O module 3 and IO module 4 are used
for communications inside a distributed system.

A distributed system communicates with an external network using a public network. For
example, the connections to clients and equipment.

A disk array is used to store database data to improve database performance.

A maximum number of five slave servers are supported.

Connection Description of Communications in a Distributed System

The master server and slave server communicate with each other using a private network.
By default, the private network is configured with bond to ensure that the master server
and slave server communicate with each other properly in the case of an NIC fault.

The clients of both the U2000 and the network management system maintenance suite
communicate with the master server and slave server using a DCN. That is, during the login
to the client of either the U2000 or the network management system maintenance suite, the
public IP address of the master server is selected. To ensure that the master server and slave
server properly communicate with each other on an external network in the case of an NIC
fault, the external probe is configured with bond by default.

Both network elements (NEs) and the upper-layer NMS communicate with the distributed
system (including the master server and slave server) through the DCN.

3.3 Installation Environment Requirements

This topic describes the environment conditions, such as the telecommunications room
environment, cable condition, and networking condition of the telecommunications room, that
you must get familiar with before you install a U2000.

Before installing a U2000, check the environment according to the following table.

Table 3-3 Installation environment requirements

Item Requirement

Temperature | The required temperature range is from 15°C to 30°C for long-term working

conditions and from 0°C to 45°C for short-term working conditions.

Humidity The required humidity range is from 40% to 65% for long-term working

conditions and from 20% to 90% for short-term working conditions.

Dust Dust density is less than or equal to 3 x 104/m3 for particles with a diameter

larger than 5 um.

Floor Flooring is anti-static movable and must be grounded.

Space The telecommunications room has good ventilation and enough space for

operation and maintenance.

Power The power supply must be an independent external power supply system that

supply provides stable electricity; UPS is recommended.

Circuit The network where the server locates is functioning properly and is accessible.
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Item Requirement

Network The routers connecting each server have been configured. For instructions on
how to install routers, see the manuals delivered with the routers, or contact
router suppliers. The networks of routers (including routers and the DCNs) in
every telecommunications room are functioning properly.

3.4 Collecting Installation Information

This topic describes how to collect installation information. Before installing a distributed
system, collect required information, including the host name, IP address, route, time zone and
time, user password, installation path, component quantity, and instance quantity.

Complete planning for the information listed in the following tables according to the iManager
U2000 Planning Guide. Collect and record the installation information in the tables.

o= TIP
Print the following tables and fill in the blanks with the site-specific planning information.

Examples provided in the tables are the default values of servers that come pre-installed with software from
Huawei.

Table 3-4 Host name list

Item Example Plan
Master server Masterserver
Slave serverN SlaveserverN

[ noTE

In the preceding table, N represents the serial number for aslave server. The host names for slave servers
can be increased in sequence along with the increase of the number of slave servers. For example, the host
name can be Slaveserverl. A maximum number of five slave servers are supported.

Table 3-5 Controller IP address list

Item Example Plan
Blade IP ® ATAE blade server:
server address 129.9.1.20/255.255.255.0/12
for the 9.9.1.254
petwork ® IBM blade server:
interface 129.9.1.30/255.255.255.0/12
on the 9.9.1.254
SMM
Disk Primary 129.9.1.10/255.255.255.0/129.9
array controller | .1.254
P
address
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Item Example Plan
Secondar | 129.9.1.11/255.255.255.0/129.9
y .1.254
controller
1P
address
[ noTE

The IP address is in the IP address/subnet mask/gateway format.

Table 3-6 System IP address list

Item Example Plan
System network ethO
interface
System IP address | ® Master server:
129.9.1.30/255.255.255.0/129.
9.1.254
® Slave server:
129.9.1.31/255.255.255.0/129.
9.1.254
o .
® slave server: 129.9.1.N/
255.255.255.0/129.9.1.254
[0 noTE

If multiple distributed NMSs are installed in a shelf, ensure that the private network segments of the
distributed NMSs are different from one another.

Table 3-7 Private network segment list

Item

Example

Plan

Private network segment 1 192.168.100.0

Private network segment 2 192.168.101.0
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Table 3-8 Route list

Item

Example

Plan

Routing network
segment 1

129.9.10.0\255.255.255.0

Routing network
segment 2

10.71.6.0\255.255.255.0

Routing network
segment N

10.121.124.0\255.255.255.0

1 NoTE

Installation engineers need to add routes to the client and management network to ensure communication
between the U2000 and the client, and between the U2000 and the management network.

Table 3-9 Time zone and time list

Item Example Plan
Time zone Asia > Shanghai
Time 14:00
Table 3-10 List of users and passwords
User Example Plan
Password for the huaweiosta
root user for the
ATAE blade server
management board
USERID for the user | PASSWORD
for the IBM blade NOTE

server management
board

When you enter the initial
password, note that the character
after letter "W" is a digit "0", but not
a letter "O".

Administrator admin | 123456
for the OceanStor

S2600 disk array

OS user root root

OS user oracle oracle
Database supper user | changeme
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User Example Plan
Database user NMSuser

U2000 user admin adminl23

network management | admin
system maintenance
suite user admin

(1 noTE

No database user is available for a slave server.

If multiple U2000s are installed in a subrack, setting different passwords for database users is recommended.

Table 3-11 Quantity list of configured components and instances

Example Plan

® One instance for SDH NE
management

® One instance for PTN NE
management

® One instance for router NE
management

Before manually install an OS, determine the disk partitioning scheme. If a quick installation
DVD is used to install an OS, the installation software automatically partitions disks according
to the disk size. For details about disk partitioning planning, see H Planning Disk Partitions.

3.5 Checking Required Software

This topic describes how to verify that the software meets U2000 installation requirements.

The U2000 can be installed by using software packages or DVDs, as follows:
® Using software packages: Required software packages must be on-hand.
® Using DVDs: Required DVDs must be on-hand.

Using Software Packages

Before installing the U2000, ensure that the SUSE Linux OS installation DVD and software
packages are on-hand.

Perform the following operations:
o= TIP

Read the Read Me file before downloading the software packages. The Read Me file is stored in the same
path as software packages.
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Access http://support.huawei.com and choose Software Center > Version Software >
Network OSS&Service > iManager U2000 > iManager U2000 > iManager U2000 >
iManager U2000 V100R002.

Select the version to be installed.

Download required software packages listed in Table 3-12. It is recommended that you
use the download tool (for example, Flashget). If you use Windows Internet Explorer, some
software packages may be renamed automatically after being downloaded to the local
computer. In this case, you must manually change the software package names to the same
as those on the http://support.huawei.com.

Use the MDS5 to verify correctness of the software packages. For details, see A.3.12 How
to Check Downloaded Software Packages by Using MDS Software.

Use the WinRAR to decompress the U2000Version_server _db_sles x64.partl.rar and
U2000Version_server_db_sles_x64.part2.rar software packages. The filename after
decompression is U2000version_server _db_sles x64.tar.

(1 noTE

® The SUSE Linux OS can be installed only by using DVDs. Therefore, if you install the U2000 by using
software packages, ensure that the SUSE Linux OS installation DVD is available.

® In an installation DVD or installation package, version indicates the detailed version number of the
U2000.

Table 3-12 Software package list

Software Medium Name Description
SUSE Linux | Install the SUSE Linux OS by using | It must be available. It is used to
(O] the quick installation DVD or the install the SUSE Linux OS.
installation | standard installation DVD.
DVD ® Quick installation DVD:
U2000version _
server_os_sles x64 dvdl
® Standard installation DVD:
SUSE Linux 10 Enterprise Server
10 SP3
Database Database software It must be available. It is used to
software package:U2000version install the database.
package server_db_sles x64.tar
NOTE
Because the database software package
is too large, it is decompressed and
divided into the following two packages:
1. U2000Version_
server_db_sles x64.partl.rar
2. U2000Version_
server_db_sles x64.part2.rar
U2000 Basic It must be available. It is used to
server component:U2000version install the U2000.
software server nmsbase_sles x64.tar
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Using DVDs

Software

Medium Name

Description

Core
component:U2000version
server_nmscore_sles x64.tar

It must be available. It is used to
install the U2000. It must be
available.

Transport
component:U2000version
server nmstrans_sles x64.tar

Itis required only if the U2000 needs
to manage Huawei transport
equipment. Huawei transport
equipment includes:

MSTP equipment
WDM equipment
NA WDM equipment
Submarine equipment

RTN equipment

PTN equipment

1P
component:U2000version
server nmsip_sles x64.tar

Itis required only if the U2000 needs
to manage Huawei IP equipment.
Huawei IP equipment includes:

Routers

Switches

Metro service equipment
Broadband access equipment
VolIP gateways

Firewalls

Service inspection gateway

SVN equipment

Access
component:U2000version__
server_nmsaccess_sles x64.tar

Itis required only if the U2000 needs
to manage Huawei access
equipment. Huawei access equipment
includes:

® FTTx equipment
® MSAN equipment
® DSLAM equipment

Before installing the U2000 by using DVDs, ensure that the following DVDs are available.
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Table 3-13 DVD list

Software DVD Name
SUSE Linux OS Install the SUSE Linux OS by using the quick installation DVD or
installation DVD the standard installation DVD.

@® Quick installation DVD:
U2000version_server _os_sles x64 dvdl

® Standard installation DVD: SUSE Linux 10 Enterprise Server 10
SP3

Database software U2000version_server db sles x64 dvd3
DVD

U2000 server software | U2000version_server nms_sles x64 dvd4
DVD

3.6 Checking Hardware Connections

Prerequisite

Procedure

This topic describes how to check that hardware is installed and connected properly.

The server hardware must have been installed and equipment cables must have been connected.

Ensure that the power cables and ground wires for all components are tightly connected and in
good contact and that the polarities are properly placed.

Ensure that all cables are bundled and free of visible damage.

Check whether the label (slot x, shelf x) of the associated slot is available on the card.
If not, attach a label (slot x, shelf x) to the card.

(1 noTE

Labels are used to identify the mappings between cards and slots after U2000 installation.

Check hardware connections and network cable connections according to the hardware
connection diagram.

® If an IBM blade server is used, connect cables according to the following figure.
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Figure 3-2 Cable connection for an IBM blade server
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® Inan ATAE blade server is used, connect cables according to the following figure. The blade
server must be connected to an external network through the base plane of a switching board.
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Figure 3-3 Cable connection for an ATAE blade server
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5 Optional: Ifthe blade server is the ATAE blade server, check the connection between the ATAE
blade server card and the USB drive.

The following figure shows the connection between the ATAE server card and the USB drive.
After the card and the USB drive are connected, insert a disk to check the disk reading indicator.
If the indicator is green and flashes, the drive works properly.

Figure 3-4 Diagram of the connection between the ATAE server card and the USB drive
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6 Check the plugs and sockets.

1. Ensure that the latches of cable plugs are locked fast and the plugs of coaxial cables are
secured tightly.

2. Ensure that the pins in each socket are complete and in good order. Curved pins may cause
short circuits.

7 Ensure that all debris (cable straps, stubs, or moisture-absorbent packets) are picked up.

8 Remove unnecessary items from the telecommunications room. The workbench must be neat
and the movable floor must be level and clean.

——End

3.7 Applying for a U2000 License

This topic describes how to apply for a U2000 license.

Context
®  Thelicense file is not delivered to customers along with a U2000 installation DVD. Contact
Huawei engineers for the application of a master server license according to the contract
number and ESNs of the server.
® An ESN is a string consisting of 40-digit numerals or letters obtained through encrypted
calculation on the MAC addresses of the U2000 server network interface. The number of
ESNss is the same as the number of network interfaces on the U2000 server.
The U2000 license is valid as long as it is bound to any of the server ESNs. To avoid
applying for a new license due to replacing certain network interface cards (NICs), save
all the ESNs to ensure proper use of the U2000 license.
Procedure
1 Obtain the contract number.
2 View ESNs of the master server.
Method 1: Use the ESN tool to generate ESNs before installing a U2000.
(0 noTE
Make the following preparations:
® Obtain the ESN tool software package named U2000version_ESN_sles x64.tar.
® Copy the ESN tool software package to a PC.
1. FTP the ESN tool to the U2000 server in binary mode. For example, upload the ESN tool
to the /opt path. Details are as follows:
a. Login to the computer where the ESN tool is stored.
Choose start > Run. Enter ftp system IP address of the server and click OK. The
FTP connection will be established and the command line interface (CLI) will be
displayed.
c. Enter root as the name of the OS user.
User (IP address:(none)) :root
d.  Enter the password of user root.
Password:
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e. Set the format of the file to be transferred by means of FTP to bin.
ftp> bin

f.  Access the directory on the computer where the ESN tool is stored.
ftp> led PC directory

g.  Access the /opt directory.
ftp> ed /opt

h.  Run the put command to upload the ESN tool to the server.
ftp> put ""

i.  Run the following command to exit the FTP program:
ftp> quit

2. Run the following commands to decompress the ESN tool package:

# cd /opt
# tar xvf U2000version ESN solaris SPARC.tar

3. Run the following command to view the ESN:
# ./esn
Information similar to the following is displayed:

ESN0:EBB74B99612CEDC82AD0OA59886EC5018CE44DDD4
ESN1:BDA706C825FE0543DC028209778AA66396545412
ESN2:E1BOOEEF6947DD95687AA5C608B72ACC532AB2BD
ESN3:F72F9ECO8AEE78AAO05A42EFD7BFD89F5E03139C4

Mode 2: View the ESN using the ESN tool of the NMS after installing the U2000.
1. Login to the OS as user root.

2. Run the following commands to view the ESN:

# . /export/home/nmsuser/.profile
# ed /opt/U2000/server/lbin
# ./esn

L noTE

Leave a space between the dot (.) and the command /export/home/nmsuser/.profile.

Information similar to the following is displayed:

ESNO:EBB74B99612CEDC82AD0OA59886EC5018CE44DDD4
ESN1:BDA706C825FE0543DC028209778AA66396545412
ESN2:E1BOOEEF6947DD95687AA5C608B72ACC532AB2BD
ESN3:F72F9ECO8AEE78AAOSA42EFD7BFD89F5E03139C4

3 Send the contract number and the server ESN to Huawei engineers or the local Huawei office.
(1] noTE

Huawei engineers need the contract number and ESN to procure the license from http://
license.huawei.com. For details about how to apply for the license file, see the iManager
U2000VI00R002C01 License Instructions.
4 Huawei engineers will send the license file after it is procured.
The NMS license file is stored in the .dat format.

—End
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Configuring Hardware

About This Chapter

This topic describes how to configure hardware. Before installing the U2000, you must set I[P
addresses for the remote management console and the disk array controller on the blade server.

4.1 Configuring the Remote Management Console of an IBM Blade Server

This topic describes how to configure the remote management console of an IBM blade server.
After that, you can remotely maintain and manage the IBM blade server through the Internet
Explorer.

4.2 Configuring the Remote Management Console of an ATAE Blade Server

You can configure the IP address of the network port on the SMM board on an ATAE blade
server through a serial port. This facilitates the access to the ATAE blade server management
software through the Internet Explorer, thus to manage the ATAE blade server.

4.3 Configuring the SC IP Address of the OceanStor S2600 Disk Array
This topic describes how to configure the SC IP address of OceanStor S2600 disk array.
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4.1 Configuring the Remote Management Console of an
IBM Blade Server

Prerequisite

Procedure

This topic describes how to configure the remote management console of an IBM blade server.
After that, you can remotely maintain and manage the IBM blade server through the Internet
Explorer.

The PC where the Windows OS, and JRE1.4.2_08 or later are installed must be available.

Connect the control network port of the management module of the IBM blade server to the
network port on the PC with a network cable, as shown in the following figure.

IBM Blade server

o

|

[
-
N P v—-—.]
1 1 =
1 lll o | ¥ .y
I (|E=
o ([E=
o Console

On the PC, modify the IP address and subnet mask of the network adapter that is connected to
the network port of the management module of the IBM blade server. Modify the IP address to
192.168.70.xx, for example, 192.168.70.100, and modify the subnet mask to 255.255.255.0.

Open an Internet Explorer window. In the address bar, enter the IP address http://
192.168.70.125. Then, the login web page of the IBM management module is displayed.

Enter the default user name USERID and initial password PASSWORD, and click Log In.

A CAUTION

When you enter the initial password, note that the character after letter "W" is a number "0", but
not a letter "O".

Click Exit Wizard in the Advanced Management Module Configuration Wizard dialog box,
and the click OK and the management page is displayed.

6 Choose MM Control > Network Interfaces. The configuration page is displayed.

1. Select Hide all IPv6 configuration fields when IPv6 is disabled.

2. After you set the parameters, click Save to save the settings.
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External Network Interface (eth0) @

Interface: Enabled

™ IPu6 Enabled

]

[ I Hide all IPvé configuration fields when IPv6 is disabled. mers .

ﬂl

7 Set the parameters by referring to Table 4-1. After you set the parameters, click Save to save
the settings.

Primary Management Module @

< This management module is in Bay 1 of the chassis

Hostname |MME41F134BD132

Domain name [
Register this interface with DNS [~

Advanced Ethernet Setup

DHCP |D|5ab|ed - Use static IP configuration j

*** Currently the static IP configuration is active for this interface. *** This static configuration is shown below.

IPv4 Static IP Configuration

1P address 129.9.1.30
Subnet mask 255.255.255.0
Gateway address 129.9.1.254

Save |

Advanced Failover

Normally, when a primary management module fails, the standby medule assumes control automatically, takes the IP address of the primary medule, and causes no downtime.
In some situations, however, control might not fail over to the standby management medule when it in fact should. This includes, for example, situations in which the primary
module is running but not reliably responding. To protect against these situations, you can configure additional network settings for failovers that will allow you to manually access

the standby module when automatic failover does not happen. Specifically, this means you will assign a distinct IP address to the standby module, instead of just specifying a
single IP address to be used for both.

Indicate below whether or not you wish to use advanced failover.

™ lise Advanced Failmeer

Table 4-1 Parameter settings

Item Parameter Description

External Network Interface | DHCP Sets this parameter to

(eth0) Disabled - Use static IP
configuration.

Primary Management IP address Enters the planned IP address

Module of the management module,

such as 7129.9.1.30.
Enters the subnet mask of the
management module.

Subnet mask Enters the planned subnet
mask of the management
module, such as
255.255.255.0.
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Item

Parameter

Description

Gateway address

Enters the planned route
address of the management
module, such as 129.9.1.254.

8 Choose MM Control > Restart MM. Then, click Restart.

9 Click OK in the confirmation dialog box. Then, the management module restarts.

10 Remove the network cable from the control network port of the management module of the IBM
blade server, and insert the network cable that is connected to an external network.

—--End

4.2 Configuring the Remote Management Console of an
ATAE Blade Server

You can configure the IP address of the network port on the SMM board on an ATAE blade
server through a serial port. This facilitates the access to the ATAE blade server management
software through the Internet Explorer, thus to manage the ATAE blade server.

Prerequisite

A Windows-based management terminal must be available.

Procedure

1 Set up the physical connection between the PC and the server.

1. Connect the serial port of the local console and the network port on the SMM board (COM)
with a serial port cable (DB9-RJ45) to set up the physical connection between the PC and

the server.

As shown in the following figure, the RJ-45 connector of the serial port cable is plugged
into the network port on the SMM board (COM) the DB-9 connector of the cable is plugged

into the serial port (COM1 or COM2) of the PC.

2. Connect the network interface (Net Mgt port) of the system controller and the switch with
a network cable to set up the physical connection between the system controller and the

network.
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Figure 4-1 Diagram of the connection between the SMM board and the controller
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2 Set up the logical connection between the PC and the server.
1. Start the PC to enter the Windows OS.
2. Choose Start > Programs (P) > Accessories > Communications > HyperTerminal.
3. Inthe Connection Description dialog box, enter the name of the newly created connection,
such as NMS. Then, click OK.
4. Inthe dialog box that is displayed, select the serial port of the PC that is used to connect to
the server, such as COM1. Then, click OK.
5. Inthe dialog box that is displayed, set the parameters as follows: Bit/Second: 11520, Data
Bit: 8, Parity Check: null, Stop Bit: 1, and Data Flow Control: null. Click OK.
(0 noTE
Set the parameters according to the preceding values. Otherwise, the communication may fail.
6. Click OK.
Enter the user name root and the password huaweiosta, and press Enter.
(0 noTE
If you change the initial password, enter the new password in this step.
To configure the IP address of the network port on the SMM board, run the following command:
# smmset -1 smm -t eth0 -d staticip -v 129.9.1.102 255.255.255.0 129.9.1.254
A CAUTION
It is recommended that you use the public network IP address as the IP address of the network
port on the SMM board. Hence, you can manage the blade server remotely in an easy manner.
Restrict the access to the IP address of the management unit (such as SMM) based on the actual
situation for security purpose. For example, use the firewall to restrict the access.
-—-End
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4.3 Configuring the SC IP Address of the OceanStor 52600
Disk Array

This topic describes how to configure the SC IP address of OceanStor S2600 disk array.

Prerequisite
® The controller IP addresses are obtained.

® The power cable of the disk array is connected.

Context

Each OceanStor S2600 disk array has two controllers that need to be configured with
management interfaces separately.

Procedure
1 Connect the computer and controller A of the disk array physically.
Use a serial port cable (DB9-RJ45) to connect the serial port of the local controller to the serial
port of the disk array (SERIAL MGT).
Use an RJ-45 connector at one end of the serial port cable to connect to the serial port of the
disk array (SERIAL MGT) and a DB-9 connector at the other end of the cable to connect to the
serial port of the computer (COM1 or COM2).
L Controllar & Controller B
Switch SERIAL MGNT
£ i,
Console Locale Console
2 Set up a logical connection between the computer and controller A.

1. Start the computer and enter Windows OS.
2. Choose start > Programs (P) > Accessories > Communications > HyperTerminal.
3. Inthe Connection Description dialog box, enter the name of the new connection, such as

NMS, and click OK.
4. In the dialog box that is displayed, select the serial port of the computer that is used to

connect to the disk array, such as COM1, and click OK.
5. Inthe dialog box that is displayed, set the attributes of the serial port as follows:

® Bits per second: 115200 bps

® Data bits: 8 bit
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® Parity: None

@® Stop bits: 1 bit

® Flow control: None
6. Click OK.

The following message will be displayed on the Windows management terminal if the

connection was established:
Login:

7.  Enter the user name and password to log in.
(O noTe

The default user name and password of the system administrator are admin and 123456.

=l

OceanStor login: admin
Password:

Last login: Fri Jul 28 11:50:16 from 129.16.18

start osm login

OceanStor: admin> _ _J

-
< | | 5

After login authentication, the system will display the CLI.

3 Inthe CLI, run the chgetrlip command to configure the IP address for the network interface of
controller A. See Table 4-2.

Table 4-2 Command format and parameter description of the chgetrlip command

Command Format Parameter Description
chgcetrlip -c controller ID { -a IP ® -c controller ID: Indicates the controller ID.
address | -s subnet mask | -g gateway } The value of this parameter is a or b, where,

a represents controller A and b represents
controller B.

® -a /P address: Indicates the IP address of the
management network interface of the
controller.

® -s subnet mask: Indicates the subnet mask.

® -g gateway: Indicates the gateway.

The following is an example:

Configure the IP address for the management network interface of controller A. Specifically,
the IP address is 7/29.9.1.10, the subnet mask is 255.255.255.0, and the gateway IP address is
129.9.1.254. Run the following command:
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OceanStor: admin> chgctrlip -c a -a 129.9.1.10 -s 255.255.255.0 -g 129.9.1.254

4 Disconnect the serial port from controller A.

1. Inthe CLL run the logout command.

2. On the computer, exit the HyperTerminal software.

3. Remove the serial port cable on the disk array.

5 Repeat Step 1 to Step 4 to configure the network interface of controller B.

1. Connect the computer and controller B physically.

2. Establish a logical connection between the computer and controller B.

3. Configure the IP address of the network interface of controller B on the local console.

©= TIP

Run the showetrlip command to query the IP address of the management network interface of a controller
after the chgctrlip command. Table 4-3 provides the format and parameter description of the

showctrlip command.

Table 4-3 Command format and parameter description of the showcetrlip command

Command Format

Parameter Description

showctrlip [ -¢ controller ID ]

® -c controller ID: Indicates the controller ID. The
value of this parameter is a or b, where, a
represents controller A and b represents controller
B.

Precautions for running the showetrlip command are as follows:

® Run the showctrlip command to query the IP addresses of the management network interfaces of all

controllers.

® Run the showctrlip -c controller ID command to query the IP address of the management network

interface of a specified controller.

The following is an example for querying the IP addresses of the management network interfaces of all

controllers:

OceanStor: admin> showctrlip
Controller IP Address
A 129.9.1.10
00:12:34:56:70:46
B 129.9.1.11
00:12:34:56:79:92

6 Disconnect the serial port from controller B.

1. Inthe CLI, run the logout command.

Subnet Mask Gateway MAC Address
255.255.255.0

o
o
o
o

255.255.255.0 0.0.0.0

2. On the computer, exit the HyperTerminal software.

3. Remove the serial port cable on the disk array.

——-End
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5 Powering On a Server

Powering On a Server

This topic describes how to power on a blade server and disk array when the power supply is
normal. Perform associated operations according to the server type and disk array type.

Blade Server

1 noTE

The following example describes how to power on an ATAE blade server.

1.
2.

Power on the cabinet if available.
Switch on the DC PDU in the ATAE blade server chassis.

After the chassis is powered on, all fans work at constant speed rather than at full speed.
The fans do not generate abnormal noise during rotation and blow strong air through the
ventilation hole on the rear side of the chassis. The HEALTHY indicator on the fan frame
is green and constantly on.

Raise the ejector lever of the SMM and power on the SMM.
If the following conditions are met, the SMM is powered on properly:
® The HEALTHY indicator on the active SMM is green and constantly on.

® The HEALTHY indicator on the standby SMM is green and flashes with the frequency
of 0.5 Hz.

Raise the ejector lever of the front panel of the switching network card and power on the
switching network card.

If the following conditions are met, the switching network card is powered on properly:

® The HEALTHY indicators on the two switching network cards are green and constantly
on.

® The HOTSWAP indicator is off.

® The OSS indicator is off.

Raise the ejector lever of the server card and power on the server card.

If the following conditions are met, the server card is powered on properly:

® The HEALTHY indicators on all server cards are green and constantly on.
® The HOTSWAP indicator is off.

® The OSS indicator is off.
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Disk Arrays

A CAUTION

Ensure that main power switch of the rack and the power switch of the UPS module are off
before powering on the system.

® Do not pull out or plug in disk modules, controllers, fibers, network cables, or serial cables
when powering-on the disk to avoid loss of data.

® Do not disconnect or connect to the power supply while the disk is saving data. This is to
prevent the disk from being damaged losing data. Wait for at least 1 minute before
reconnecting the power supply once it has been disconnected.

1. Connect the power supply to the disk array.
2. Switch the two power buttons on the back to the ON position.
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Installing the SUSE Linux OS and Its Patches
by Using the Quick Installation CD-ROM

This topic describes how to install the SUSE Linux OS and the patches by using the quick
installation CD-ROM.

Prerequisite
® The MAC addresses of NICs through which blade servers are connected to the public
network must be collected.

- An ATAE blade server is connected to the public network through the base plane. For
details about how to view the MAC address of the base plane of an ATAE blade server,
see F.5 How to View the MAC Address of the Base Plane of an ATAE Blade
Server.

- An IBM blade server is connected to the public network through I/O module 1 and I/O
module 2. The system IP address of the IBM blade server must be set on the external
communication NIC. For details about how to view the MAC address of the external
communication NIC of an IBM blade server, see F.3 How to View the MAC Address
of the External Communication NIC of an IBM Blade Server.

® The installation CD-ROM must be available.
® Forthe ATAE server, if the USB drive is connected to the ATAE server card, the indicator
of the USB drive is green and flashes.

Context
You can use the quick installation CD-ROM to install the OS and its patches, and partition disks.
(1 noTE
If the quick installation CD-ROM is not available on the site, manually install the SUSE Linux OS by using the
attached SUSE Linux installation CD-ROM. For details, refer to E Manually Installing the SUSE Linux OS
and Its Patches.

Procedure

1 Optional: In the case of the ATAE blade server, in BIOS, set the order for starting the OS so
that the OS boots from the CD-ROM.

(1 noTE

This step is applicable only to the ATAE blade server. In the case of other servers, skip this step.
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1. Insert the installation disk to the USB drive.
2.  Logging In to the Management Console of an ATAE Blade Server.

3. Inthe Blade > KVM panel, select the required board from Select Blade, and
click Cold Reset to restart the blade server.

On the toolbar of the Blade > KVM panel, click the icon of the card to be operated
to display the related tab page.
© Blade == KVM

‘Select Blade “F‘Iease select... j‘ Cold Reset H Refresh Blade H
i%l}_‘—mEEl@EJEJE?'EJEEJEDEZ'EJEJEJEM“

| 2 El 4 B 10 I 12 13

blade9 |

-
1

== TIP

® To enter the full screen mode, click on the toolbar.

® To restore from the full screen mode to window, move the mouse to upper middle of the screen,

press Ctrl+Shift+Alt and click “ in the upper portion of the screen.

4. In the process of restarting the blade server, when the American Megatrends window is
displayed, press Delete to display the BIOS SETUP UTILITY window.

American
Megatrends

W WL T GO

Amer ican
] 1] 5
CPU : Tntel 8 @ 2.136Hz

S pEE d : 2

5. Inc.
111-011909-BLAKFORD-UBSAUOSS -Y 2KC

5. Inthe BIOS SETUP UTILITY window, use the left arrow and right arrow keys to choose
Boot from the main menu.

On the Boot Settings tab page, use the up arrow and down arrow keys to select Boot Device
Priority. Then, press Enter.
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BIOS SETUP UTILITY

» Boot Device Priority

6. In the Boot Device Priority pane, set the order for starting the OS of the blade server so
that the OS boots from the USB disk drive.

a. Select 1st Boot Device, and then press Enter. The Options dialog box is displayed.

b.  Use the up arrow and down arrow keys to select USB:HUAWEI VM CDROM. Then,
press Enter.

BIOS SETUP UTILITY

1st Boot Device [USB :HUAWET UM CDRO]

USB:HUAWEL UM CDROM

7. Press F10 after the previous settings, the confirm dialog box is displayed.
8. Click OK, and then press Enter to save the settings and exit.

2 Optional: In the case of the IBM HS22 blade server, in BIOS, set the order for starting the OS
so that the OS boots from the CD-ROM.
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m NOTE

This step is applicable only to the IBM HS22 blade server. In the case of other servers, skip this step.
1.  Mount the virtual media of the IBM blade server.

ﬂ;ﬂ NOTE

® The purpose of mounting the virtual media of the IBM blade server is to mount the CD/DVD
drive or ISO file of the PC where the Web console is installed to a blade server, thus implementing
remote installation of the OS of the blade server. Alternatively, the default CD/DVD drive of the
IBM BladeCenter E can be used to install the OS of the blade server.

® To use the default CD/DVD drive of the IBM BladeCenter E to install an OS on a blade server,
you need to insert the OS installation DVD into the default CD/DVD drive of the IBM
BladeCenter E and then press MT at the middle of the blade server, If the MT indicator is on, it
indicates that the blade server is connected to the default CD/DVD drive.

. . Hone v .
2. Inthe remote console window, click . Then, select the required

card.
3. Inthe Power Control area, select Restart to restart the blade server.

4. Inthe process of restarting the blade server, when the System x window is displayed, press
F1 and the System Configuration and Boot Management window is displayed.

IBM System x.

Server Firmware

Licensed Materials - Property of |BM Caorp. Firmware contains licensed third party modules.
Systemn x Server Firmware & Copyright IBM Corporation 200% ALL RIGHTS RESERVED.
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5.

6.

System Configuration and Boot Management

System Information
System Settings
Date and Time

Start Options

Sustem Event Logs
User Security

Save Settings

Restore Settings

Load Default Settings
Exit Setup

tl=Move Highlight <Enter>=3elect Entry

This selection will
allow you to change
boot parameters and
boot from file.

<ESC>=Exit Setup

Press an arrow key to choose Boot Manager from the main menu. Press Enter.

Boot Mamager

Primary Boot Sequence
Add Boot Option
Delete Boot Option

Secondary (WOL) Boot Sequence
Add WOL Boot Optiom

Delete WOL Boot Option

Change WOL Boot Order

Boot From File
Select Mext One-Time Boot

Reset Systen

tl=Hove Highlight <Enter>=Select Entru

Will be valid on next
hoot .

Press an arrow key to choose Change Boot Order from the Boot Manager. Press

Enter.
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Change Boot Order

Change the order Change the order

Commit Changes

T1=Move Highlight <Enter>=Select Entry Esc=Exit

7.  Press an arrow key to choose CD/DVD Rom from the Change Boot Order. Press
Enter.

8. Choose Save Settings from the main menu. Press Enter twice to save the settings.
9. Choose Exit Setup and press Enter twice to exit BIOS setting.
3 Optional: In the case of the IBM HS21 blade server, in BIOS, set the order for starting the OS
so that the OS boots from the CD-ROM.
(1] noTE

This step is applicable only to the IBM HS21 blade server. In the case of other servers, skip this step.
1.  Mount the virtual media of the IBM blade server.
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1 noTE

® The purpose of mounting the virtual media of the IBM blade server is to mount the CD/DVD
drive or ISO file of the PC where the Web console is installed to a blade server, thus implementing
remote installation of the OS of the blade server. Alternatively, the default CD/DVD drive of the
IBM BladeCenter E can be used to install the OS of the blade server.

® To use the default CD/DVD drive of the IBM BladeCenter E to install an OS on a blade server,
you need to insert the OS installation DVD into the default CD/DVD drive of the IBM
BladeCenter E and then press CD at the top of the blade server, as shown in the following figure.
If the CD indicator is on, it indicates that the blade server is connected to the default CD/DVD
drive.

. . Hone v .
In the remote console window, click . Then, select the required

card.
In the Power Control arca, select Restart to restart the blade server.

In the process of restarting the blade server, when the System x window is displayed, press
F1 and the Configuration/Setup Utility window is displayed.
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IBH BIDS - (c) Copyright IBM Corporation 2869
Synmetric Hultiprocessing System

Intel(R) Xeon(R) CPU L5428 @ 2.58GHz

2 Processor Packages Installed

16384 MB Installed Hemory

Press Fl1 for ConfigurationsSetup
Press F2 for Diagnostics
Press F12 for Boot Device Selection Henu

>> BIOS Version 1.16 <<

Configuration/Setup Utility

= Systen Summary

= Systen Information

= Devices and 10 Ports
= Date and Tine

= Systen Security

= Start Options

= Advanced Setup

Save Settings
Restore Settings
Load Default Settings

Exit Setup

<F1> Help {13<1> Move
{Esc> Exit {Enter} Select

5. Press an arrow key to choose Start Options > Startup Sequence Options from the main
menu. Press Enter.

6. In the Startup Sequence Options window, do as follows:
® Set First Startup Device to CD ROM.
® Set Second Startup Device to Diskette Drive 0.
® Sect Third Startup Device to Hard Disk 0.
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Start Options
Startup Sequence Options

Primary Startup Seque

First Startup De [ ]
Plan ) o [ Diskette Drive B 1
Run ) [ Hard Disk 8 ]
Run Fourth Startup D o [ Hetwork 1

Hake On LAN

Hake on Lan Startup Sequence:

[ Network 1
[ Diskette Drive 8 1

; [ CD ROM 1
USh Fourth Startup D e [ Hard Disk B ]
Boot

<{F1> Help {13¢4> Hove ¢+> Next Value ({F9» Restore
<{Esc» Exit {+>» Pravious Value <F18> Default S

After you complete the settings, press Esc twice to return to the main menu.
7. Choose Save Settings from the main menu. Press Enter twice to save the settings.
8. Choose Exit Setup and press Enter twice to exit BIOS setting.
4 Wait about five minutes. The system restarts and the SUSE Linux Enterprise Server window
is displayed.
(O noTE

If the SUSE Linux Enterprise Server window is not displayed but the system enters the server OS, do as
follows to restart the management module:

1. Choose MM Control > Restart MM. Then, click Restart. in the Web management widow.

2. Click OK in the confirmation dialog box. Then, the management module restarts.
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N SUSE Linux Enterprise Server

Boot from Hard Disk
Installation--ACPI Disabled
Installation--Local APIC Disabled
Installation--Safe Settings
Rescue System

Hemory Test

Boot Options

Help Language 800 x 600 DVD Driver

5 Use the up or down arrow key to select Installation and press Enter to begin to load the Linux
core. The system starts the automatic installation of the OS.

(1) noTE

The installation process and remaining time are displayed in the installation window. The entire OS installation
process lasts approximately 40 minutes.

6 Do as follows to remove the DVD:

1. Login to the OS as root user.

To log in to the OS, do as follows:

® C(lick Session in the lower right corner of the login dialog box. In the Choose a
Session dialog box, select GNOME, and then set the session process to GNOME.

® The default user name and password for logging in to the OS are both root.

(1 noTE

® By default, the system enables the root user to perform remote login and use the FTP tool.

® [fyou can log in to the SUSE Linux OS as the root user, it indicates that the SUSE Linux OS is
successfully installed. Otherwise, install the OS again.

2. Onthe GNOME desktop, right-click, and choose Open Terminal from the shortcut menu
to open the CLI. Then, run the eject command to eject the disk.

(1 noTE

If the IBM blade server is installed by using the drive of the virtual media device, run the eject
Name_of the virtual_media_device command to remove the DVD.

Run the following command to check the name of the virtual media equipment:

# df -hk

If /dev/srl 132136 132136 0 100% /media/05_04_2009 is displayed, it indicates that the name of
the virtual media equipment is /dev/sr1. The equipment name varies according to the actual situation.
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7 Set the network of the system.

1.

9.

Run the following command to log in to the YaST2 Control Center:
# yast2

In the YaST2 Control Center dialog box, choose Network Devices > Network Card.

In the Network Setup Method dialog box, select Traditional Method with ifup and click
Next.

Inthe Network Card Configuration Overview dialog box, select the NIC to be configured
and click Edit.

1 noTE

® The NIC corresponding to the system IP address must be the NIC through which the blade server
is connected to the public network.

® An ATAE blade server is connected to the public network through the base plane. For details
about how to view the MAC address of the base plane of an ATAE blade server, see F.5 How
to View the MAC Address of the Base Plane of an ATAE Blade Server.

® AnIBM blade server is connected to the public network through I/O module 1 and I/O module
2. The system IP address of the IBM blade server must be set on the external communication
NIC. For details about how to view the MAC address of the external communication NIC of
an IBM blade server, see F.3 How to View the MAC Address of the External
Communication NIC of an IBM Blade Server.

® You can view the MAC address of an NIC on the Address tab page of the Network Address
Setup dialog box.

In the Network Address Setup dialog box, select Static Address Setup and set IP
Address and Subnet Mask.

Set default gateway IP address.

a. Click Routing.

b. In the Routing Configuration dialog box, enter the default gateway IP address, and
then click OK.

In the Network Address Setup dialog box, click Next return to the Network Card
Configuration Overview dialog box.

In the Network Card Configuration Overview dialog box, click Finish to complete the
setting of the IP address.

Exit YaST2 Control Center.

8 Run the following command to restart the OS:

# sync;sync;sync;sync
# shutdown -r now

9 After the OS is restarted, exit the management console of the blade server.

—End

Follow-up Procedure

To log in to the SUSE Linux OS by using the remote graphical software in the future, enable
the remote login right of the software. For details, see A.1.6 How to Log In to the OS
Through the Remote Login Tools?.

After the OS installation is completed by using the quick installation CD-ROM, the default
time zone is Asia > Shanghai. The local time and time zone can be changed as required.
For details, see A.1.10 How to Change the Time and Time Zone of the SUSE Linux
0S?.
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Installing U2000 Software

About This Chapter

This topic describes how to install U2000 software. Before starting the U2000 installation
program, you must preconfigure the systems of the master server and the slave server.

7.1 Uploading and Decompressing Software Packages

This topic describes how to upload and decompress software packages. Software packages must
be uploaded to the server and then decompressed if the software packages are used to install the
U2000. If the U2000 is installed by using DVD-ROMs, skip this operation.

7.2 Preconfiguring the OS of the Master Server

This topic describes how to preconfigure the OS of the Master Server. Before starting the
U2000 installation program, you must configure the OS of the master server. Then, you can use
the HWICMR to modify system parameters and network settings and configure disk arrays and
disk mirroring.

7.3 Preconfiguring the OS of the Slave Server

This topic describes how to preconfigure the OS of the Slave Server. You need to pre-configure
the OS of the slave server before installing the U2000. Specifically, you need to pre-configure
the OS through the DVD or software package. Then, modify the system parameters, modify the
network settings of the system, and configure disk mirroring through HWICMR.

7.4 Starting the U2000 Installation Program

This topic describes how to start the U2000 installation program. Install the U2000 software
through the GUI (recommended) or CLI. If the GUI cannot be logged in to, install the U2000
software through the CLI.
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7.1 Uploading and Decompressing Software Packages

This topic describes how to upload and decompress software packages. Software packages must
be uploaded to the server and then decompressed if the software packages are used to install the
U2000. If the U2000 is installed by using DVD-ROMs, skip this operation.

Context
A CAUTION
"U2000Version_server db_sles x64.partl.rar" and
"U2000Version_server db_sles x64.part2.rar" cannot be uploaded to the server directly.
You must use the WinRAR to decompress the
U2000Version_server db_sles x64.partl.rar and
U2000Version_server_db_sles x64.part2.rar software packages, and then upload the
decompressed U2000version_server db_sles x64.tar to the master server.
® All software packages must be uploaded to the master server/opt/install path.
® Only the Basic components and Core components software packages need to be uploaded
to the slave server/opt/install path.
Procedure
Do as follows to upload software packages to the /opt/install path on the server. For details
about software packages to be uploaded, see 3.5 Checking Required Software.
1. Login to the Linux OS as user root.
2. Run the following command to create the /opt/install directory:
# mkdir /opt/install
3. Perform the following operations to FTP the software packages in binary mode to the /opt/
install directory on the server:
a. Log in to the computer where the software packages are stored.
b.  On the computer, choose start > Run. Enter ftp the_system_IP_address_of server
and click OK. The FTP connection is set up and the CLI is displayed.
c. Inthe CLI that is displayed, enter root as the user name of the server:
User (IP Address: (none)) :root
d.  Enter the password of user root:
Password:
e. Setthe FTP transfer mode to bin:
ftp> bin
f.  Go to the directory where the software packages are stored on the computer:
ftp> lcd the path of computer
g.  Go to the /opt/install directory:
ftp> ed /opt/install
h.  Run the put command to upload all of the required software packages to the server:
ftp> put Name of software package
For example, put U2000version_server_nmscore_sles x64.tar.
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Wait for a moment. When the software packages are uploaded, the system will prompt
Transfer complete.

A CAUTION

Upload all of the required software packages to the server.

i.  Run the following command to exit the FTP program:
ftp> quit

2 Run the following commands to switch to the directory where the software packages are stored,
and run the tar command to decompress all the uploaded software packages on the server. There
is no requirement on the sequence for decompressing the software packages.

# cd /opt/install
# tar xvf Name of software package

For example, tar xvf U2000version_server_nmscore_sles x64.tar.

3 Run the following command to delete the software packages and free up disk space:

# rm Name of software package
For example, rm U2000version_server_nmscore_sles_x64.tar.

—-End

7.2 Preconfiguring the OS of the Master Server

This topic describes how to preconfigure the OS of the Master Server. Before starting the
U2000 installation program, you must configure the OS of the master server. Then, you can use
the HWICMR to modify system parameters and network settings and configure disk arrays and
disk mirroring.

Prerequisite
® Installation software is on-hand. For details, see 7.1 Uploading and Decompressing
Software Packages.
®  The hardware is properly connected. For more information, see 3.6 Checking Hardware
Connections.
® [nstallation engineers are familiar with the IP address planning scheme of the U2000. For
more information, see 3.4 Collecting Installation Information.
® The primary and secondary power supplies of the disk array must be available. For details,
see 5 Powering On a Server.
® [P addresses must have been assigned to disk array controllers. For details, see 4.3
Configuring the SC IP Address of the OceanStor S2600 Disk Array.
Context
The following operations are involved:
® [nstall HWNMSJRE, HWENGR, and HWICMR.
®  Automatically configure disk arrays.
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®  Automatically configure disk mirroring.

®  Set network parameters for the server, such as host name, IP address, and automatic bond
configuration.

e TIP

® Do not use the integrated numberpad keyboards. This is because Num Lock may fail to work when a
SUSE Linux OS is installed on certain machines.

® When performing operations described in this topic, do not adjust the size of the command line interface
(CLI) to ensure that information can be normally displayed.

A CAUTION

By default, the installation program configures bindings for public and private networks in a
U2000 distributed system. These bindings maintain proper communication in the private
network (between the master server and slave server), as well as that in the public network
(between the master server or slave server, and NEs and clients) even when the NIC is faulty.
A binding configuration requires two network ports. Therefore, in a U2000 distributed system,
each blade server needs to be configured with at least four network ports. Otherwise, the
U2000 distributed system will malfunction.

Procedure
Log in to the OS as user root.
Ensure that the language environment variable of the system is en_US.
To check the language environment variable, run the following command:
# echo $LANG
If the displayed information is not en_US, change the description about the language
environment variable to RC_LANG="en_US" in the /etc/sysconfig/language file, and then
restart the system. Perform the following operations:
1. Run the following command to log in to the YaST2 Control Center:
# yast2
2. Choose System >/etc/sysconfig Editor. The /etc/sysconfig Editor dialog box is displayed.
Choose System > Environment > Language > RC_LANG. Enter en_US for Setting of:
RC_LANG.
4. Choose System > Environment > Language > ROOT_USES_LANG. Set
ROOT _USES _LANG to yes.
Click Finish.
6. Run the following commands to restart the OS:
# sync;sync;sync;sync
# shutdown -r now
7. Login to the OS as the root user after the OS is restarted.
Start copying software.
® Mode 1: Installation using a software package.
1. Run the following commands to switch to the directory where the pre_install.sh file is
stored and run the pre_install.sh file to start copying software:
# cd /opt/install/engineering/HWICMR
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# ./pre_install.sh

It takes approximately five minutes to complete system pre-configuration. The pre-
configuration includes copying the HWICMR, Network Management System
Maintenance Suite, and Java environment.

- Path for the Java environment variable: /opt/ HWNMSJRE
- Path for the NMS maintenance suite: /opt/ HWENGR
- HWICMR path: /opt/HWICMR

A message similar to the following will be displayed:

System pre-configuration

If install High Availability NMS System (Veritas Hot Standby), input "1" to
start copy Veritas installation software.
If no need, input "2" to skip

2. Enter 2 to skip copying of the Veritas software.

A message similar to the following will be displayed:

Skip copy Veritas software...

* NMS Engineering Directory: /opt/HWENGR
* NMS Software Lib Directory: /opt/install/
* NMS Java Runtime Environment: /opt/HWNMSJRE/jre linux

Finish...

® Mode 2: Installation using a DVD.
1. Insert the installation DVD of the U2000 server software into the server DVD-ROM.

2. Run the following commands to switch to the directory where the pre_install.sh file is
stored and run the pre_install.sh file to start copying software:

# cd /media/nms/engineering/HWICMR
# . ./pre_install.sh

(1 noTE
There must be a space between the dot (.) and the command ./pre_install.sh.

It takes approximately five minutes to complete system pre-configuration. The pre-
configuration includes copying the HWICMR, Network Management System
Maintenance Suite, and Java environment.

- Path for the Java environment variable: /opt/HWNMSJRE
- Path for the NMS maintenance suite: /opt/ HWENGR
- HWICMR path: /opt/HWICMR

A message similar to the following will be displayed:

System pre-configuration

Cannot find database installation package.
Please insert the installation CD #3, or extract database compress package
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to /opt/install, or input another path that contains a database installation
package, then press Enter key to continue

The DVD-ROM will eject the installation DVD for the U2000 server software after
configuration is complete. Insert the installation DVD for the database software into the
server DVD-ROM.

The system will automatically copy the database installation software to the server.
A message similar to the following will be displayed:

Deal with Database installation file to /opt/install...

> Finish

If install High Availability NMS System (Veritas Hot Standby), input "1" to

start deal with Veritas installation software.
If no need, input "2" to skip

Enter 2 to skip copying of the Veritas software.

A message similar to the following will be displayed:

Skip deal with Veritas software...

* NMS Engineering Directory: /opt/HWENGR
* NMS Software Lib Directory: /opt/install/
* NMS Java Runtime Environment: /opt/HWNMSJRE/jre linux

Configure OS successful...
Finish...

Run the following commands to eject the DVD.
# cd /
# eject

(1 noTE

If an IBM blade server is installed by means of the drive of the virtual media device, run the eject
Name_of the_virtual_media_device command to eject the DVD.

Run the following command to check the name of the virtual media device:

# df -hk

If /dev/srl 132136 132136 0 100% /media/05_04_2009 is displayed, the name of the virtual
media device is /dev/srl. The device name varies according to the conditions at your site.

4 Do as follows to configure disk arrays:

(1 noTE

The OceanStor S2600 disk array (6 x 300 GB) supports automatic configuration by means of the
HWICMR. To use disk arrays that do not support automatic configuration, contact Huawei engineers.

To configure the OceanStor S2600 disk array by using an automatic configuration script, perform
the following operations:

1.

Run the following commands to switch to the directory where the script for configuring
the OceanStor S2600 disk array is stored, and run the AutoSetupS2600.sh script to start

configuring the OceanStor S2600 disk array:
# cd /opt/HWICMR/bin/array
# ./AutoSetupS2600.sh

A message similar to the following will be displayed:

Please enter the username of the array.

Enter the user name of the disk array and press Enter. The default user name is admin.
A message similar to the following will be displayed:

Please enter the password of the disk array.

Enter the user password of the disk array and press Enter. The default password is
123456.
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A message similar to the following will be displayed:

Please enter the IP address of array controller A.

4.  Enter the IP address of the primary controller of the disk array, such as /129.9.1.10 and press
Enter.

A message similar to the following will be displayed:

Are you sure to continue? [y/n]

5. Entery and press Enter. The script clears the configurations of the disk array.
Configured the disk array successfully.

(1 noTE

Wait about five minutes. The configuration result will be displayed. If the configuration fails, run
the AutoSetupS2600.sh script again. If the configuration fails again, use the ISM to configure the
OceanStor S2600 disk array. For more information, see G Configuring the OceanStor S2600 Disk
Array by Using the ISM.

6. Run the following commands to restart the OS:
# sync;sync;sync;sync
# shutdown -r now

5 Run the following commands to switch to the directory where the HWICMR resides. Then, run
the install.sh file to start the HWICMR for system preconfiguration.

# cd /opt/HWICMR/bin
# ./install.sh -r

A message similar to the following will be displayed:

======= Installation Type =======

Select the installation type. The installation wizard will guide
you through the rest of the installation process according

to the installation type you selected.

1. Single-Server System (SUSE Linux-Distributed)
2. High Availability System (SUSE Linux-Distributed)
Select[1]:

6 Enter 1 to select Single-Server System (SUSE Linux-Distributed), and then press Enter.
o= TIP
If incorrect characters are entered, press Ctrl+Backspace to delete them.
A message similar to the following will be displayed:
======= Server Type =======
The server type defines the role of the server in the distributed system.
1. Master Server

2. Slave Server
Select[1l]:

7 Enter 1 to configure the master server. Then, press Enter.

A message similar to the following will be displayed:

Please input the database path, which is a directory used to install
the database software.

Please input path or press the Enter key that used the
default directory[/opt/oracle]:

8 Press Enter.
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11

A CAUTION

The database installation path may vary according to disk partitions. By default, the database is
installed in the /opt/oracle path. Do not change the database installation path.

A message similar to the following will be displayed:
======= The path of NMS =======

Please input the NMS path which is a directory used to install the
NMS software.

Please input path or press Enter key that used the default
directory [/opt/U2000]:

Press Enter.

A CAUTION

The NMS installation path may vary according to disk partitions. By default, the NMS is installed
in the /opt/U2000 path. Do not change the NMS installation path.

A message similar to the following will be displayed:

======= Host Name =======
Host name is the only ID of the host. It is the name used to indicate the
host in the network. Host name for each host is unique in the network.
Press Enter to use the current host name, or enter a new host name. The new host
name will take into effect after the host reboots.
The host name can contain numerals, letters. It must begin with a letter.
Enter[Masterserver]:

Enter the planned host name of the master server. Then, press Enter.

A message similar to the following will be displayed:

======= IP Address of the Master NIC of bond =======
Enter an IP address for the master NIC.
You need to configure the IP address for the NIC before the server can communicate
with other devices in the network.
The IP address must be unique and not be occupied by any other equipment in the
network. Otherwise, the IP address conflict may cause abnormal communication.
Press Enter to use the default value (The default is the current IP address. If no
default is displayed, you need to enter a valid IP address.)

Enter[129.9.1.2]:
Enter the planned system IP address of the master server and press Enter.

A message similar to the following will be displayed:
======= Subnet Mask of the Master NIC =======

Enter a subnet mask for the master NIC.

The subnet mask is a 32-digit value. It defines the network ID and the host
ID. A network can be divided into several subnets by subnet mask.

The subnet masks of different hosts in one subnet are consistent.

Press Enter to use the default value. (The default is the subnet mask
configured for the current system. If no default is displayed, you need to enter a
valid subnet mask.)
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12

13

14

15
16
17

Enter [255.255.255.0] :
Enter the planned subnet mask for the system IP address of the master server and press Enter.

A message similar to the following will be displayed:
======= Configure Private Network =======
Enter an IP address as the distribute server installation, such as 192.168.100.0.

Enter [192.168.100.0]:

Enter the planned private network segment and press Enter.
(O noTE

® If only one distributed NMS is installed in a shelf, you do not need to modify the private network
segment. Instead, press Enter.

® [f multiple distributed NMSs are installed in a shelf, you must modify the private network segment to
prevent installation failure of multiple distributed NMSs.

A message similar to the following will be displayed:

Please confirm the following configurations...
ER R R R S S SR SRR S SRS S SRS SRR R SRR R R SRR RS SRR EEEEEEEE R R R R R RS R

Ip 129.9.1.2

HOSTNAME Masterserver

NETMASK 255.255.255.0

MASTERNIC bond0

PRINETWORK 192.168.100.0x**x*kxkkxksk
Enter 'y' to apply these values and proceed to the next step, or 'n' to return to
make any changes (y/n):
>

Enter y after you confirm that the information is correct and press Enter.

A message similar to the following will be displayed:

Modifying system network configuration..................
Modifying system parameters. ... ..ot innnnennenn.

é;éss Enter to restart the computer.
Press Enter to restart the OS.
After the OS restarts, log in to the OS as user root.

Run the following commands to switch to the directory where the HWICMR is stored. Then,
run the installsh file to check the HWICMR for system preconfiguration.

# cd /opt/HWICMR/bin
# ./install.sh

A message similar to the following will be displayed:

Modifying system network configuration...................
Modifying the system parameters.............c.ciiiiiinn..
Mounting disK @rray. et ii ittt ittt ettt eeaeeaeenennnn

All operations defined in the task flow have been completed.

All operation logs are saved in:
/var/ICMR/ICMR 20090915024631.1log
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(1 noTE

If All operations defined in the task flow have been completed is displayed, it indicates that the system
is successfully configured. If the system configuration fails, send the operation log to Huawei engineers
for fault locating.

—End

Follow-up Procedure

If the OS must be reconfigured because of incorrect parameter settings (such as incorrect IP
addresses), perform the following operations:

Press Ctrl+C to stop the program from configuring the OS.

Run the following commands to reconfigure the OS:
# cd /opt/HWICMR/bin
# ./install.sh -r

For more information, refer to the procedures described above.

7.3 Preconfiguring the OS of the Slave Server

Prerequisite

Context

This topic describes how to preconfigure the OS of the Slave Server. You need to pre-configure
the OS of the slave server before installing the U2000. Specifically, you need to pre-configure
the OS through the DVD or software package. Then, modify the system parameters, modify the
network settings of the system, and configure disk mirroring through HWICMR.

Installation software is on-hand. For details, see 7.1 Uploading and Decompressing
Software Packages.

The hardware is properly connected. For more information, see 3.6 Checking Hardware
Connections.

Installation engineers are familiar with the IP address planning scheme of the U2000. For
more information, see 3.4 Collecting Installation Information.

A CAUTION

® If the blade server has only one blade, skip the operation on the slave server.

By default, the installation program configures bindings for public and private networks in
a U2000 distributed system. These bindings maintain proper communication in the private
network (between the master server and slave server), as well as that in the public network
(between the master server or slave server, and NEs and clients) even when the NIC is faulty.
A binding configuration requires two network ports. Therefore, in a U2000 distributed
system, each blade server needs to be configured with at least four network ports. Otherwise,
the U2000 distributed system will malfunction.

The following operations are involved:

Installing the HWNMSJRE, HWENGR, and HWICMR.
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®  Automatically configure disk mirroring.
®  Setting server network parameters: host name, IP address, and automatic bond
configuration.
&= TIP
® Do not use the integrated numberpad keyboards. This is because Num Lock may fail to work when a
SUSE Linux OS is installed on certain machines.
® When performing operations described in this topic, do not adjust the size of the command line interface
(CLI) to ensure that information can be normally displayed.
Procedure

1 Log in to the OS as user root.

2 Ensure that the language environment variable of the system is en_US.

To check the language environment variable, run the following command:
# echo $LANG

If the displayed information is not en_US, change the description about the language
environment variable to RC_LANG="en_US" in the /etc/sysconfig/language file, and then
restart the system. Perform the following operations:

1.

7.

Run the following command to log in to the YaST2 Control Center:
# yast2

Choose System > /etc/sysconfig Editor. The /etc/sysconfig Editor dialog box is displayed.

Choose System > Environment > Language > RC_LANG. Enter en_US for Setting of:
RC_LANG.

Choose System > Environment > Language > ROOT_USES_LANG. Set
ROOT _USES_LANG to yes.

Click Finish.

Run the following commands to restart the OS:

# sync;sync;sync;sync
# shutdown -r now

Log in to the OS as the root user after the OS is restarted.

3 Start copying software.

® Mode 1: Installation using a software package.

1.

Run the following commands to switch to the directory where the pre_install.sh file is
stored and run the pre_install.sh file to start copying software:

# cd /opt/install/engineering/HWICMR
# ./pre_install.sh

It takes approximately five minutes to complete system pre-configuration. The pre-
configuration includes copying the HWICMR, Network Management System
Maintenance Suite, and Java environment.

- Path for the Java environment variable: /opt/HWNMSJRE
- Path for the NMS maintenance suite: /opt/ HWENGR
- HWICMR path: /opt/HWICMR

A message similar to the following will be displayed:

System pre-configuration
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If install High Availability NMS System (Veritas Hot Standby), input "1" to
start copy Veritas installation software.
If no need, input "2" to skip

Enter 2 to skip copying of the Veritas software.

A message similar to the following will be displayed:

Skip copy Veritas software...

* NMS Engineering Directory: /opt/HWENGR
* NMS Software Lib Directory: /opt/install/
* NMS Java Runtime Environment: /opt/HWNMSJRE/jre linux

Finish...

® Mode 2: Installation using a DVD.

Insert the installation DVD of the U2000 server software into the server DVD-ROM.

Run the following commands to switch to the directory where the pre_install.sh file is
stored and run the pre_install.sh file to start copying software:

# cd /media/nms/engineering/HWICMR
# . ./pre_install.sh

(1 noTE
There must be a space between the dot (.) and the command ./pre_install.sh.

It takes approximately five minutes to complete system pre-configuration. The pre-
configuration includes copying the HWICMR, Network Management System
Maintenance Suite, and Java environment.

- Path for the Java environment variable: /opt/HWNMSJRE
- Path for the NMS maintenance suite: /opt/ HWENGR
- HWICMR path: /opt/HWICMR

A message similar to the following will be displayed:

System pre-configuration

Cannot find database installation package.
Please insert the installation CD #3, or extract database compress package
to /opt/install, or input another path that contains a database installation
package, then press Enter key to continue

The DVD-ROM will eject the installation DVD for the U2000 server software after
configuration is complete. Insert the installation DVD for the database software into the
server DVD-ROM.

The system will automatically copy the database installation software to the server.
A message similar to the following will be displayed:
Deal with Database installation file to /opt/install...

> Finish
If install High Availability NMS System (Veritas Hot Standby), input "1" to
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start deal with Veritas installation software.
If no need, input "2" to skip

4. Enter 2 to skip copying of the Veritas software.

A message similar to the following will be displayed:

Skip deal with Veritas software...

* NMS Engineering Directory: /opt/HWENGR
* NMS Software Lib Directory: /opt/install/
* NMS Java Runtime Environment: /opt/HWNMSJRE/jre linux

Configure OS successful...
Finish...

5. Run the following commands to eject the DVD.
# cd /
# eject

(1 noTE

If an IBM blade server is installed by means of the drive of the virtual media device, run the eject
Name_of the_virtual_media_device command to eject the DVD.

Run the following command to check the name of the virtual media device:

# df -hk

If /dev/sr1 132136 132136 0 100% /media/05_04 2009 is displayed, the name of the virtual
media device is /dev/sr1. The device name varies according to the conditions at your site.

4 Run the following commands to switch to the directory where the HWICMR resides. Then, run
the install.sh file to start the HWICMR for system preconfiguration.

# cd /opt/HWICMR/bin
# ./install.sh -r

A message similar to the following will be displayed:

======= Installation Type =======

Select the installation type. The installation wizard will guide
you through the rest of the installation process according

to the installation type you selected.

1. Single-Server System (SUSE Linux-Distributed)
2. High Availability System (SUSE Linux-Distributed)
Select[1]:

5 Enter 1 to select Single-Server System (SUSE Linux-Distributed), and then press Enter.
o= TIP

If incorrect characters are entered, press Ctrl+Backspace to delete them.

A message similar to the following will be displayed:

======= Server Type =======
The server type defines the role of the server in the distributed system.
1. Master Server
2. Slave Server
Select[1]:

6 Enter 2 to select the slave server, and then press Enter.

A message similar to the following will be displayed:

======= Host Name =======
Host name is the only ID of the host. It is the name used to indicate the
host in the network. Host name for each host is unique in the network.
Press Enter to use the current host name, or enter a new host name. The new host
name will take into effect after the host reboots.
The host name can contain numerals, letters. It must begin with a letter.
Enter[Slaveserver]:
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10

11
12
13

Enter the planned host name of the slave server, and press Enter.

======= IP Address of the Master NIC of bond =======
Enter an IP address for the master NIC.
You need to configure the IP address for the NIC before the server can communicate
with other devices in the network.
The IP address must be unique and not be occupied by any other equipment in the
network. Otherwise, the IP address conflict may cause abnormal communication.
Press Enter to use the default value (The default is the current IP address. If no
default is displayed, you need to enter a valid IP address.)

Enter[129.9.1.2]:

Enter the planned system IP address of the slave server, and press Enter.
======= Subnet Mask of the Master NIC =======

Enter a subnet mask for the master NIC.

The subnet mask is a 32-digit value. It defines the network ID and the host
ID. A network can be divided into several subnets by subnet mask.

The subnet masks of different hosts in one subnet are consistent.

Press Enter to use the default value. (The default is the subnet mask
configured for the current system. If no default is displayed, you need to enter a
valid subnet mask.)

Enter[255.255.255.0]:

Enter the planned subnet mask of the system IP address of the slave server, and then press
Enter.

Please confirm the following configurations...
khkkhkhkhkhkkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkkxkx

IPp 129.9.1.2
HOSTNAME Slaveserver
NETMASK 255.255.255.0
MASTERNIC bond0

khkkhkhkhkhkhkhkkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkkhkkkxkx

Enter 'y' to apply these values and proceed to the next step, or 'n' to return to
make any changes (y/n):

>

Enter y after you confirm that the information is correct and press Enter.

A message similar to the following will be displayed:

Modifying system network configuration..................
Modifying system parameters............uiiiiiiuinnnennnnn

éééss Enter to restart the computer.
Press Enter to restart the OS.
After the OS restarts, log in to the OS as user root.

Run the following commands to switch to the directory where the HWICMR is stored. Then,
run the installsh file to check the HWICMR for system preconfiguration.

# cd /opt/HWICMR/bin
# ./install.sh

A message similar to the following will be displayed:

Modifying system network configuration...................
Modifying the system parameters.............cciiiiiinon..
MoUNting AisK @Lray. e tn ittt ittt ettt eeeeeeeeaeennn

All operations defined in the task flow have been completed.
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14

All operation logs are saved in:
/var/ICMR/ICMR 20090915024631.1log

(1 noTE

If All operations defined in the task flow have been completed is displayed, it indicates that the system
is successfully configured. If the system configuration fails, send the operation log to Huawei engineers
for fault locating.

Run the following commands to start the Network Management System Maintenance Suite
process:

# cd /opt/HWENGR/engineering
# ./startserver.sh

—End

Follow-up Procedure

If the OS must be reconfigured because of incorrect parameter settings (such as incorrect IP
addresses), perform the following operations:

1. Press Ctrl+C to stop the program from configuring the OS.

2. Run the following commands to reconfigure the OS:
# cd /opt/HWICMR/bin
# ./install.sh -r

For more information, refer to the procedures described above.

7.4 Starting the U2000 Installation Program

This topic describes how to start the U2000 installation program. Install the U2000 software
through the GUI (recommended) or CLI. If the GUI cannot be logged in to, install the U2000
software through the CLI.

7.4.1 Installing the U2000 Through the GUI

This topic describes how to install the U2000 software through the GUI. It is recommended that
you install the U2000 through the GUI if you are not familiar with the common commands of
the SUSE Linux OS.

7.4.2 Installing the U2000 Through the CLI
This topic describes how to install the U2000 software on the master server through the CLI.
This method is recommended if you cannot log in to the GUI of the OS.

7.4.1 Installing the U2000 Through the GUI

Prerequisite

This topic describes how to install the U2000 software through the GUI. It is recommended that
you install the U2000 through the GUI if you are not familiar with the common commands of
the SUSE Linux OS.

® [n the scenario where the OSs of the master server and slave server have already been
preconfigured, see the 7.2 Preconfiguring the OS of the Master Server and 7.3
Preconfiguring the OS of the Slave Server. In the scenario where the OSs of the master
server and slave server have not yet been preconfigured, the single-server system (SUSE
Linux-distributed) fails to be installed.
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® The database software is installed along with the U2000. If the database has already been
installed on the master server, you must make sure that the database is started. For details,
see A.2.4 How Can I Start the Oracle Database (Single-Server System)?.

® The size of the installation directory of the master server and slave server must meet
requirements. For example, the free space of the installation directory must be larger than
30 GB for the installation of all components.

&= TIP
Run the df -hk /opt command to view the remaining space of the /opt directory.
® The remote desktop control software is ready.

® The Network Management System Maintenance Suite server of the slave servers is started.
(0 noTE

If the Network Management System Maintenance Suite process of the slave server server on the is
not started, run the following commands to start it:

# cd /opt/HWENGR/engineering
# ./startserver.sh

Context
A CAUTION
You must install the U2000 software on the master server.
Do not use the integrated numberpad keyboards. This is because the Num Lock may not appear
to work when a SUSE Linux OS is installed on certain machines.
o= TIP
To log in to the GNOME, perform the following operations: Click Session in the lower left corner of the
login dialog box of the remote desktop control software. In the Choose a Session dialog box, select
GNOME, and then set the session to GNOME.
Procedure
Log in to the GNOME session process of the master server OS as the root user.
On the desktop, right-click and choose Open Terminal from the shortcut menu to display a
CLL
Run the following commands to go to the path where the install.sh file is stored and run the
install.sh file:
# cd /opt/HWENGR
# ./install.sh
Wait about one minute. The Copyright dialog box will be displayed.
[ noTE
If the U2000 is not pre-configured, the /opt/HWENGR directory and the install.sh will not be generated
and the U2000 cannot be installed.
Read the terms of the software license agreement carefully.
Click Accept these terms, and click Next to continue. The Select Language dialog box will be
displayed.
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If a dialog box is displayed prompting you to select the directory of the installation package, enter the
directory where the installation files were uploaded to the server. For example, /opt/install.

5 Selecta language as required, such as English. Then, click Next. The Select Component dialog
box is displayed.

° M Uzooo

¢ MIE Common Compaonent
[W#IBase Component

T rDescription Information

[wiFerformance Management | 4
[JAuto Provisioning
WClient Auto Upgrade
¢ [JE& ME Management

[JAccess Metwark, Element Management

[Router Metwork, Element Management
[v&E Eouter ME Management

[5wiitch Metwaork, Element Management

[ b

| < Prewious || Mext = | | Cancel

6 Select the components according to the type of the equipment to be managed. Then, click
Next. The Configure Server dialog box is displayed.
o= TIP

Select components according to preinstallation component planning. If component planning is not

performed before installation, see Deployment Planning of NMS Components in the iManager U2000
Planning Guide to perform component planning.

SeMver Mame IP Address Semver Thwie
Masterserver 1I0.71.211.124 Master server
Addl || Modify || Delete |
Installation Fath | Browser |
< Prewious || Mext = | | Cancel |

7 Do as follows to configure the server:

1. Click Add. The Add Server dialog box is displayed.
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Server Type Slave server |

IF Address | . |

Password of BMS
Maintenance suite

ok || cancel

Set the related parameters. The following table shows the parameter description.

Parameter Description

Server Type Specifies the type of a slave server. The default value is Slave
Server. You do not need to set this parameter.

IP Address Specifies the IP address of the slave server for external
communication.

Password of Specifies the password for the admin user on the slave server.

Network The default value is admin. You do not need to set this

Management System | parameter.
Maintenance Suite

2. Click OK. The system returns to the Configure Server dialog box.

® To add multiple slave servers, click Add. Set the server type to Slave Server to add
more slave servers.

® To modify the server, select the server and click Modify. Then, modify the server
parameters in the dialog box that is displayed.

3. Click Next. The Deployment Parameters dialog box is displayed.

(L noTE
If the /opt/U2000 path does not exist, the Confirm dialog box will be displayed. Click Yes to create
the /opt/U2000 path.
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linux-7Finw | liunx-slavel
Camponent Deplovment Packa..| Instance Count Description
S0OH Service Mana... |30DH Service Mana... O Frovides the end-.. [ *]
IF Serdce Manage. .. |IP Service Manage. .. OF—Provides the end-...
Composite seric... [Composite Servic. .. OF—{Provides the man. ..
Security Metwark, .. |Security Metwiark, ... O Security Metwork .
WHE FEouter ME Ma. . |Fouter %8 manang... OF=Router ¥8 manag... |=
FHon-Default Trap. .. [Mon-0efault Trap. .. 1=—Mon-Default Trap... ||
Arcess Metwork E.. |Access Device Log —lAccess Device Log.
Default TrapFecei... |Default TrapREecei. .. = Default TrapEecei...
Baze Component Phesical Imventond.. —5upport the akiliti. .. -
Display all deplowment packages
< Prewious || Blext = | | Zancel
8 Set the number of installed instances for the master server and slave server.
(1] noTE
If the /opt/U2000 path does not exist, the Confirm dialog box will be displayed. Click Yes to create the /
opt/U2000 path.

Select the master server and slave server to view the selected components and the instance
numbers related to the components respectively.

® You can modify the number of instances only for components with single-server multi-
instance.

® Limited by the port quantity, a maximum number of 25 instances can be deployed for the
transport domain in the single-server multi-instance deployment mode.

® To use the CORBA northbound interface (NBI), XML NBI, SNMP NBI, and text NBI,
instances must be added by using the Network Management System Maintenance Suite after
installing the desired NBIs.

® The non-default TrapReceiver service component is deployed together with the deployment
packages that are applicable to SNMP. Common deployment packages applicable to SNMP
include Access Network Single Element Management Service, Switch Network Element
Management, RouterMgr/SgMgr Component, and Security Network Element
Management. For example, if the Access Network Single Element Management
Service deployment package is deployed on a slave server, you also need to deploy the Non-
Default TrapReceiver Service component deployment package on this server.

® DeskTop Service Component can be deployed only on the master server and only one
instance can be deployed.

® NMS Log Zip Management needs to be deployed on each server and one instance needs to
be deployed on each server.

9 Click Next. The Version Style dialog box will be displayed.
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(1 noTE

The following is an example of the differences between the two styles:

® For the default style, alarms are displayed in the following descending order of severity: Critical,
Major, Minor and Warning.

® For the North America style, alarms are displayed in the following five levels in descending order of
severity: Critical, Major, Minor, Not Alarmed and Not Reported.

10 Select the style according to the conditions at your site, such as Default style. Click Next. The
Installation Parameters dialog box will be displayed.

1 NoTE

If the components include SDH Network Element Management or SDH Service Management, the
Version Timeslot Mode dialog box will be displayed. Select the slot mode according to the conditions at
your site, such as Sequence mode. Click Next.

The Sequence mode is the international standard mode and is recommended.

Database Installation Path

[Cata File Path |fupt;nrac|efdata | | Browse (B) |

Database SUperuser Password | |

Feenter Database Superuser Password | |

Database User Password |'l'llnlnlrl- |

Feenter Database User Password |uuu- |

The following table shows the basic settings of the database server and NMS database user.

Parameter Description

Database Installation Path Specifies the installation directory of the Oracle database.
The default value is /opt/oracle. This parameter does not
need to be set.

Data File Path Specifies the path of the data file. The default value is /opt/
oracle/data. This parameter does not need to be set.

Database Superuser Password | Specifies the superuser password of the database. This
password cannot be left blank and must be at least six
characters long and consist of letters or digits. Special
characters are not allowed. For example, it can be
changeme.

NOTE

If the database is installed, enter the password of the database
superuser (this password was set when the database was installed).

Reenter Database Superuser Confirms the password of the database superuser.
Password NOTE

If the database is installed, you do not need to enter the password
of the database superuser.
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Parameter Description
Database User Password Specifies the password of the database user. This parameter
contains a minimum of six characters. The default value is
NMSuser.
Reenter Database User Confirms the password of the database user.
Password

11 Set the installation parameters and click Next. The installation information will be displayed.
(O noTE

® [fthe system prompts you to use the original database software, a database has been installed on the server.
If you reuse the database, the installation program will skip database installation. If you do not reuse the
database, the installation program will uninstall the existing database and reinstall the database. It is
recommended that installation engineers not to reuse the database.

® [fthe message "Select Installation Package Patch" is displayed, no database installation package is stored
in the /opt/install directory. In this case, upload database software
U2000version_server _db_solaris SPARC.tar to the /opt/install directory on the server and decompress it.
Set the directory of the installation package to /opt/install.

12 Verify that the installation information is correct and click Next. A progress bar will be displayed.
The time required for the installation depends on the number of components to be installed and
the server configuration. The entire process takes about 120 minutes. Wait patiently.

1 noTE

® The NMS can automatically expand the capacity of a database according to the growth parameters
defined when the database is created. The disk space for installing the database must be greater than
the maximum size to which the file is permitted to grow. If the disk space is insufficient, the system
will display a prompt message in red. The U2000 can manage up to the maximum of NEs as supported
by the server model.

® [f a message indicating an installation failure or interruption is displayed during installation, perform
the following operations on each server (including the master server and all slave servers) to clear the
installation environment, and then install the U2000.

1. Run the following commands to use the environment clean-up tool to clear the installation
environment:
# cd /opt/HWENGR/engineering/tool
# ./FailedNMSInstallationClear.sh

2. Perform Step 3 to install the U2000.
13 The system will display a prompt indicating that installation was successfully completed.
14 Click Finish to complete the U2000 installation.

15 Run the following commands to restart the OS:

A CAUTION

Run the following commands on both the master server and slave server to restart the OS:

# sync;sync;sync;sync
# shutdown -r now

16 Afterthe OS isrestarted, log in to each slave server and run the following commands to configure
the NFS:
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# cd /opt/HWICMR/bin
# ./AutoMountNFS.sh

A message similar to the following will be displayed:

Getting the current working directory...
Working directory:/opt/HWICMR/bin
The server private ip is 192.168.100.18.

Starting service automounter done
Succeed to enable the autofs.
(1 NnoTE

If Succeed to enable the autofs is displayed, it indicates that the NFS is configured successfully. Run the
following commands to check the /share/ftproot directory on the slave server:

# cd /share/ftproot

# cd /share

# 1s

—--End

Follow-up Procedure

In the NAT networking scenario, you must configure the ipmap.cfg file. For details, see A.3.5
How to Configure the ipmap.cfg Mapping File.

7.4.2 Installing the U2000 Through the CLI

Prerequisite

This topic describes how to install the U2000 software on the master server through the CLI.
This method is recommended if you cannot log in to the GUI of the OS.

® In the scenario where the OSs of the master server and slave server have already been
preconfigured, see the 7.2 Preconfiguring the OS of the Master Server and 7.3
Preconfiguring the OS of the Slave Server. In the scenario where the OSs of the master
server and slave server have not yet been preconfigured, the single-server system (SUSE
Linux-distributed) fails to be installed.

® The database software is installed along with the U2000. If the database has already been
installed on the master server, you must make sure that the database is started. For details,
see A.2.4 How Can I Start the Oracle Database (Single-Server System)?.

® The size of the installation directory of the master server and slave server must meet
requirements. For example, the free space of the installation directory must be larger than
30 GB for the installation of all components.
o= TIP

Run the df -hk /opt command to view the remaining space of the /opt directory.
® The Network Management System Maintenance Suite server of the slave servers is started.

[ noTE

If the Network Management System Maintenance Suite process of the slave server server on the is
not started, run the following commands to start it:

# cd /opt/HWENGR/engineering
# ./startserver.sh
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Context

Procedure

A CAUTION

You must install the U2000 software on the master server.

A large amount of information is displayed in the CLI when installation is performed in CLI
mode. Adjust the CLI parameters before installing the U2000 to have the information neatly and
quickly displayed. Details are as follows:

1. Right-click the title bar of the CLI and choose Properties from the shortcut menu. The
Properties dialog box will be displayed.

2. On the Option tab page, set Buffer Size to 100 in the Command History area.
On the Layout tab page, set Width to 120 in the Screen Buffer Size area.

Log in to the master server OS as the root user.

Run the following commands to switch to the path where the install.sh file is stored and run the
install.sh script:

# cd /opt/HWENGR
# ./install.sh -cmd

1 noTE

After the message Starting NMS Engineering CMD Install Server... isdisplayed, wait
about two minutes.

A message similar to the following will be displayed:

Copyright Notice
Copyright Notice

I accept these terms [y:Yes, n:No, n]:
(1) noTE

If the U2000 is not pre-configured, the /opt/HWENGR directory and the install.sh will not be generated
and the U2000 cannot be installed.

Read the terms of the software license agreement carefully. Enter y if the terms are accepted.

Enter y and press Enter.

(1 noTE

If a dialog box is displayed prompting you to select the directory of the installation package, enter the
directory where the installation files were uploaded to the server. For example, /opt/install.

A message similar to the following will be displayed:

Install [c:Cancel, <p:< Previous, n:Next>, n]:
Enter n and press Enter.

A message similar to the following will be displayed:

Select NMS Language

NMS Version Language [l:Chinese, 2:English, 2]:
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10

11

Enter 2 and then press Enter to select the English version.

A message similar to the following will be displayed:

Install [c:Cancel, <p:< Previous, n:Next>, n]:
Enter n and press Enter.

A message similar to the following will be displayed:

Select Components
[1: Select Component, 2: Finished select, 1]:
Enter 1 to select components.

A message similar to the following will be displayed:

Please select the operation
options[a:Select, b:Deselect, c:Display, d:Reset, e:Select All, f:Finished
configuration, f]:

Select the components according to the type of the equipment to be managed as prompted. Then,
enter f to finish selecting the components.

A message similar to the following will be displayed:

[1:Select Component, 2:Finished select, 1]:

Enter 2 to finish selecting the components.
(O noTE

® Components marked with the asterisk (*) in the component column are mandatory.

® Sclected components are indicated with Y in the Option column.
Enter 1 to reselect the components to be installed if modification is still required.

A message similar to the following will be displayed:

Install [c:Cancel, <p:< Previous, n:Next>, n]:
Enter n to proceed with the next step. Then, press Enter.

A message similar to the following will be displayed:

Deployment Server

fom fom fom e o o
+

|Server Name |IP Address|Server Typel|Administrator Password]|Installation Path]

fom fom fom e o o
+

IMasterserver|10.111.66.203 |Master Server|***x | /opt/U2000

\

fom fom fom e o o
+

[1:Add, 2:Modify, 3:Delete 4:Complete, 4]:

® To modify the master server, enter 2, and then press Enter. The system modifies the master
server parameters as prompted.

® To delete the master server, enter 3, and then press Enter. The system deletes the master
server, and then adds the master server again.

Add the slave server.
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1. Enter 1 to add a server. Then, press Enter.

A message similar to the following will be displayed:
Server Name[]:

2.  Enter the name of the slave server. Then, press Enter. The default value is the host name
of the slave server.

A message similar to the following will be displayed:
Server Typel[l:Slave Server, 1]:

3. Enter 1 to select the slave server. Then, press Enter.
A message similar to the following will be displayed:
IP Address|[]:

4. Enter the IP address of the slave server for external communication. Then, press Enter.

A message similar to the following will be displayed:

Deployment Server

|Server Name |IP Address|Server Type|Administrator Password|Installation Path|

U2000 |

|Slaveserver [10.111.66.206|Slave Server |**** | /opt/
U2000 |

[1:Add, 2:Modify, 3:Delete 4:Complete, 4]:

5. Enter 4 to complete installation. Then, press Enter.

A message similar to the following will be displayed:

Install[c:Cancel, <p:< Previous, n:Next>, n]:

12 Enter n and press Enter.

A message similar to the following will be displayed:

An instance is configured for each deployment package for the
master server.

By default, no instance is configured for a slave server.

Specify the number of instances for deployment packages for each server according
to the installation plan.

[1: Configure instances, 2: Configuration is complete., 1]:

13 Enter 2 to finish the deployment of instances.
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14

15

16

17

(1 noTE

Enter 1 to configure the number of the instances if this parameter needs to be modified.
You can modify the number of instances only for components with single-server multi-instance.

Limited by the port quantity, a maximum number of 25 instances can be deployed for the transport domain
in the single-server multi-instance deployment mode.

® To use the CORBA northbound interface (NBI), XML NBI, SNMP NBI, and text NBI, instances must be
added by using the Network Management System Maintenance Suite after installing the desired NBIs.

® The non-default TrapReceiver service component is deployed together with the deployment packages that
are applicable to SNMP. Common deployment packages applicable to SNMP include Access Network
Single Element Management Service, Switch Network Element Management, RouterMgr/SgMgr
Component, and Security Network Element Management. For example, if the Access Network Single
Element Management Service deployment package is deployed on a slave server, you also need to deploy
the Non-Default TrapReceiver Service component deployment package on this server.

® DeskTop Service Component can be deployed only on the master server and only one instance can be
deployed.

® NMS Log Zip Management needs to be deployed on each server and one instance needs to be deployed
on each server.

A message similar to the following will be displayed:

Install [c: Cancel, <p: < Previous, n:Next>, n]:
Enter n and press Enter.

A message similar to the following will be displayed:

Select Style

Version Style [1l: Default style, 2: North America style, 1]:
(1) noTE

The following is an example of the differences between the two styles:

® For the default style, alarms are displayed in the following descending order of severity: Critical,
Major, Minor and Warning.

® For the North America style, alarms are displayed in the following five levels in descending order of
severity: Critical, Major, Minor, Not Alarmed and Not Reported.

Select the style according to the conditions at your site. For example, enter 1 to select Default
style and press Enter.

A message similar to the following will be displayed:

Install [c: Cancel, <p: < Previous, n:Next>, n]:

Enter n and press Enter.
(] noTE

If the components include SDH Network Element Management or SDH Service Management, the
Select timeslot mode information will be displayed. Select the slot mode according to the conditions at
your site. For example, enter 1 to select Sequence mode and press Enter. Enter n and press Enter to
proceed with the next step.

The Sequence mode is the international standard mode and is recommended.

A message similar to the following will be displayed:

Database Installation Path [/opt/oracle]
Data File Path [/opt/oracle/data]:

Configure the information about the database service as follows:
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Press Enter. Configure the installation path of the database file in this step. The default
value is /opt/oracle/data.

A message similar to the following will be displayed:

DB Super Password [******]:

Enter the password of user DB Super and press Enter.

(1 noTE

® Specifies the superuser password of the database. This password cannot be left blank and must
be at least six characters long and consist of letters or digits. Special characters are not
allowed. For example, it can be changeme.

® [f the database is installed, and you do not need not to perform the next operations (Enter the
password of the DB Super user again).

A message similar to the following will be displayed:
Confirm DB Super Passwordl[]:

Enter the password of user DB Super again and press Enter.

A message similar to the following will be displayed:
DB User Password [*****x*]:

Enter the password of the DB user and press Enter.
(O noTe

This parameter contains a minimum of six characters and specifies the password of the DB user. The
default value is NMSuser.

A message similar to the following will be displayed:
Confirm DB User Password [****x*x]:

Enter the password of the DB user and press Enter.

A message similar to the following will be displayed:
Install [c: Cancel, <p: < Previous, n:Next>, n]:
Enter n and press Enter.

(1 noTE

® [f the system prompts you to use the original database software, a database has been installed on the
server. If you reuse the database, the installation program will skip database installation. If you do not
reuse the database, the installation program will uninstall the existing database and reinstall the
database. It is recommended that installation engineers not to reuse the database.

® [fthe message "Select Installation Package Patch" is displayed, no database installation package is
stored in the /opt/install directory. In this case, upload database software
U2000version_server db_solaris SPARC.tar to the /opt/install directory on the server and
decompress it. Set the directory of the installation package to /opt/install.

A message similar to the following will be displayed:

===============< Please check the following overall information about the
U2000 installation
[Basic Information]

Install[c:Cancel, <p:< Previous, n:Next>, n]:

18 Confirm that the installation information is correct, enter n and press Enter.

A message similar to the following will be displayed:

Progress information
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19

20

21

22

Initializing the data model. Please wait...: 0%
(O noTE

® The NMS can automatically expand the capacity of a database according to the growth parameters
defined when the database is created. The disk space for installing the database must be greater than
the maximum size to which the file is permitted to grow. If the disk space is insufficient, the system
displays a prompt message in red. The management capability of the U2000 after the installation cannot
reach the associated maximum value of this model.

® [f a message indicating installation failure or abnormal interruption is displayed during installation,
perform the following operations on each server (including the master server and all slave servers) to
clean up the installation environment, and then install the U2000.

1. Run the following commands to use the environment clean-up tool to clear the installation

environment:
# cd /opt/HWENGR/engineering/tool
# ./FailedNMSInstallationClear.sh

2. Run Step 3 to install the U2000.
After the installation, the message similar to the following will be displayed:
Install [c: Cancel, p: < Previous, n:Next>, n]:
Enter n and press Enter to complete the installation.

A message similar to the following will be displayed:

Installation Completed

The iManager U2000 is installed successfully.

Run the following commands to restart the OS:

A CAUTION

Run the following commands on both the master server and slave server to restart the OS:

# sync;sync;sync;sync
# shutdown -r now

After the OS is restarted, log in to each slave server and run the following commands to configure
the NFS:

# cd /opt/HWICMR/bin
# ./AutoMountNFS.sh

A message similar to the following will be displayed:

Getting the current working directory...
Working directory:/opt/HWICMR/bin
The server private ip is 192.168.100.18.

Starting service automounter done
Succeed to enable the autofs.
(1 noTE

If Succeed to enable the autofs is displayed, it indicates that the NFS is configured successfully. Run the
following commands to check the /share/ftproot directory on the slave server:

# cd /share/ftproot

# cd /share

# 1ls

——End
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Follow-up Procedure

In the NAT networking scenario, you must configure the ipmap.cfg file. For details, see A.3.5
How to Configure the ipmap.cfg Mapping File.
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Loading a U2000 License

This topic describes how to load a U2000 license. You must install a U2000 license before using
the U2000.

Prerequisite

The U2000 license file must be ready. The file name cannot contain any space. If a space is
included in the file name, delete the space or change it to an underscore ().

Context

Two methods are available for loading a U2000 license.

® Use commands to load the license. In this method, you must upload the license file to the
specified path on the server and then run commands on the U2000 server to load the license.

® [ oad the license in the GUI. In this method, you only need to save the license file to the
computer where the U2000 client is installed and use the U2000 client to load the license.

1 noTE

You can select a method as required. No matter which method is selected, ensure that the U2000 server
process has been started.

Procedure

1 Ensure that the network management system maintenance suite process and daem process on
the slave server is started.

[ note
If there are multiple slave servers, check them respectively.
1. Login to the OS of the slave server as the root user.

2. Do as follows to check whether the network management system maintenance suite process
has been started:

# ps -ef | grep java
root 19913 19907 0 04:04:09 pts/1 0:00 grep java

root 18382 18311 0 03:42:33 pts/2 12:20 /opt/HWNMSJRE/jre linux/bin/java
-server -Dequinox.conf=engineering/conf/installE
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1 noTE

If the displayed information contains /opt/HWNMSJRE/jre_linux/bin/java -server, it indicates
that the network management system maintenance suite process is started.

If the network management system maintenance suite process has not been started, run the

following commands to start it:
# cd /opt/HWENGR/engineering
# ./startserver.sh

Do as follows to check whether the daem process of the slave server has been started:
# ps -ef|grep start

Information similar to the following is displayed:

root 1702 1 0 20:48 pts/0 00:00:00 /bin/bash ./start _daem -type
StandbyNode

root 1770 1702 1 20:48 pts/0 00:00:00 /opt/U2000/server/3rdTools/
python/bin/python /opt/U2000/server/bin/script/start daem.py -type StandbyNode
root 1782 1355 0 20:48 pts/0 00:00:00 grep start

Or a message similar to the following will be displayed:

root 27069 1 0 10:31:39 2 1:39 imapmrb
root 27079 1 0 10:31:39 7 0:00 imapwatchdog -cmd start
root 27075 1 0 10:31:39 2 0:50 imapsysd -cmd start
root 27086 1 0 10:31:39 2 0:09 imapeventmgr
root 23679 1 1 17:57:06 pts/8 0:02 imap sysmonitor -cmd start
root 27116 1 0 10:31:40 7 0:52 ResourceMonitor -cmd start
(1 noTE

If /bin/bash ./start_daem -type StandbyNode, /opt/U2000/server/3rdTools/python/bin/python,
or imapsysd -cmd start is displayed, the daem process of the slave server has been started.

If the daem process has not been started, run the following command to start it:
# /etc/init.d/u2kdaem start

2 Ensure that the network management system maintenance suite process on the master server is
started.

1.
2.

Log in to the OS of the master server as the root user.

Do as follows to check whether the network management system maintenance suite process
has been started:

# ps -ef | grep java

root 19913 19907 0 04:04:09 pts/1 0:00 grep java

root 18382 18311 0 03:42:33 pts/2 12:20 /opt/HWNMSJRE/jre linux/bin/java
-server -Dequinox.conf=engineering/conf/installE

(1 noTE

If the displayed information contains /opt/HWNMSJRE/jre_linux/bin/java -server, it indicates
that the network management system maintenance suite process is started.

If the network management system maintenance suite process has not been started, run the
following commands to start it:

# cd /opt/HWENGR/engineering

# ./startserver.sh

3 Ensure that the database is running.

To check whether the Oracle database is running, run the following command:

> ps -ef | grep ora_

Information similar to the following is displayed:
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oracle 4055 1 0 20:00 2 00:00:00 ora_j000_U2KDB
oracle 4174 4107 0 20:00 pts/1 00:00:00 grep ora
oracle 23333 1 0 Novl5 ? 00:00:20 ora_pmon_ U2KDB
oracle 23335 1 0 Novl5 ? 00:00:00 ora_vktm U2KDB
oracle 23339 1 0 Novl5 ? 00:00:00 ora_diag UZ2KDB
oracle 23341 1 0 Novl5 ? 00:00:00 ora_dbrm U2KDB
oracle 23343 1 0 Novl5 ? 00:00:01 ora_pspO_U2KDB
oracle 23347 1 0 Novl5 ? 00:03:35 ora_dia0O_U2KDB
oracle 23349 1 0 Novl5 ? 00:00:00 ora_mman_ U2KDB
oracle 23351 1 0 Novl5 ? 00:00:03 ora_dbw0O_U2KDB
oracle 23353 1 0 Novl5 ? 00:00:13 ora_lgwr_ U2KDB
oracle 23355 1 0 Novl5 ? 00:00:15 ora_ckpt U2KDB
oracle 23357 1 0 Novl5 ? 00:00:06 ora_smon_ U2KDB

(1 noTE

If the displayed information contains the following processes, the database service is started successfully:
® ora_pmon_U2KDB

ora_dbw0 U2KDB

ora_lgwr U2KDB

ora_ckpt U2KDB

ora_smon_U2KDB

To check whether the listener is started, run the following commands:

> su - oracle
password: password of oracle user
> lsnrctl status

> exit

Information similar to the following is displayed:

STATUS of the LISTENER

Alias LISTENER

Version TNSLSNR for Linux: Version 11.1.0.7.0 - Production
Start Date 17-DEC-2009 20:35:58

Uptime 0 days 0 hr. 5 min. 2 sec

Trace Level off

Security ON: Local OS Authentication

SNMP OFF

(1] NnoTE

If the displayed information contains Alias LISTENER, the listener is started successfully:

To start the Oracle database, run the following commands:

> su - oracle
password:password of oracle user
> sqlplus / as sysdba

SQL> startup

ORACLE instance started.

Total System Global Area 1610612736 bytes

Fixed Size 2046264 bytes
Variable Size 385877704 bytes
Database Buffers 1207959552 bytes
Redo Buffers 14729216 bytes

Database mounted.
Database opened.

To exit the SQL Server database, run the following command:
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SQL> exit

To start the listener, run the following command:

> lsnrctl start

To log out as the Oracle user, run the following command:

> exit

4 On the master server, start U2000 server processes.

1. To check whether U2000 server processes have been started, run the following commands:

# cd /opt/U2000/server
# . svc_profile.sh
# daem ps

1 noTE

Leave a space between the dot . and the command svc_profile.sh.

Information similar to the following is displayed:

root 27069 1 0 10:31:39 2 1:39 imapmrb
root 27079 1 0 10:31:39 2 0:00 imapwatchdog -cmd start
root 27075 1 0 10:31:39 2 0:50 imapsysd -cmd start
root 27086 1 0 10:31:39 2 0:09 imapeventmgr
root 23679 1 1 17:57:06 pts/8 0:02 imap_ sysmonitor -cmd start
root 27116 1 0 10:31:40 2 0:52 ResourceMonitor -cmd start
(1 noTE

The U2000 is running if the displayed information contains imap_sysmonitor -cmd start.

2. Ifthe U2000 processes are not started, run the following command to start U2000 processes:

# ed /opt/U2000/server/bin
# ./startnms.sh

5 Run the following commands to check whether a license file exists. If a license file exists, back

itup .

# cd /opt/U2000/server/etc/conf/license
# 1s

If the folder contains any other license file, run the following commands to back up the any other
license file to the /opt/U2000/server/etc/conf/license_backup path.

# mkdir -p /opt/U2000/server/etc/conf/license_backup

# cd /opt/U2000/server/etc/conf/license

# cp license file name /opt/U2000/server/etc/conf/license_backup

Do as follows to load the U2000 license.
Method one: Use commands to load the U2000 license.

1. Send the license file in ASCII codes by FTP to the U2000 installation path /export/home/
nmsuser as the root user. Details are as follows:

a. Login to a PC where the license file is stored.

b. Choose Start > Run. Then, enter ftp system IP address of the server and click OK.
An FTP connection is established and a CLI is displayed.

c. Enter root as the name for the OS user.
User (IP_address: (none)) :root

d.  Enter the password for the root user.
Password:

e.  Set the format of the file to be transferred by FTP to ASCII.

ftp> ascii
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f.  Access the path where the license file is stored.
ftp> led PC directory
g. Navigate to the /export/home/nmsuser path.
ftp> ed /export/home/nmsuser
h.  Run the put command to upload the license file to the server.
ftp> put "License file name"
i.  Exit the FTP program.
ftp> quit

2. Onthe server, open a CLI and run the following commands to make the license take effect:
# ed /opt/U2000/server
# . svc_profile.sh
# cd /export/home/nmsuser
# updateLicense -file License file name
(1 noTe

Leave a space between the dot (.) and the command sve_profile.sh.
Information similar to the following is displayed:
state product feature item name old
value new value
no change: U2000 COMMON LSW1CAPAO1l Client
500 500
no change: U2000 COMMON LSW1CAPAO1l Client 1
1
no change: U2000 COMMON LSW1FMCLTO1 Alarm Export
1 1
no change: U2000 COMMON LSWIRENOTIO1 Client
1 1
Are you sure to update the license? (Y/N)

3. Enter Y, and then press Enter.

Method two: Load the U2000 license in the GUI.

1. Login to the OS of the computer where the U2000 client is installed.
® [fthe U2000 client is installed in Windows, log in to the OS as the administrator user.
® [fthe U2000 client is installed in Solaris, log in to the OS as the nmsuser user.

2. Copy and paste the U2000 license file to the computer where the U2000 client is installed.
On the desktop, double-click U2000 Client. The Login dialog box is displayed.

4. In the Server drop-down list, select the server (server on the primary site) to be logged in
to. Then, set User Name and Password to the valid values, and click Login. If you have
logged in to the System Monitor before, enter the password for logging in to the System
Monitor. If you have never logged in to the System Monitor before and this is the first time
that you log in to the U2000 client, the password is empty and you must change the
password.

(0 noTE

® [fa message indicating that no license is available is displayed when you log in to the U2000 client,
select the license to be updated as prompted.

® [fan access domain component is selected during installation, choose Help > License Management
> License Information from the main menu of the U2000 client. In the License Information dialog
box, click Update License. In the Open dialog box, select the new license file and click Open.

----End

Issue 05 (2010-11-19) Huawei Proprietary and Confidential 8-5

Copyright © Huawei Technologies Co., Ltd.



iManager U2000 Unified Network Management System
Single-Server System Software Installation Guide (SUSE

8 Loading a U2000 License Linux)

Result
After the preceding operations are performed, the license file is automatically loaded to the /opt/
U2000/server/etc/conf/license path.
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Verifying Installation of a Single-Server

System (SUSE Linux-Distributed)

This topic describes how to verify installation of a Single-Server System (SUSE Linux-
Distributed). Before using a single-server system (SUSE Linux-distributed) to manage the
network, you must make sure that the single-server system (SUSE Linux-distributed) is properly
installed.

Procedure

1 Check whether the Network Management System Maintenance Suite process and the daem
process of the slave server have been started.

(1 noTE

If there are multiple slave servers, check them respectively.
Log in to the OS of the slave server as the root user.

Do as follows to check whether the network management system maintenance suite process
has been started:

# ps -ef | grep java

root 19913 19907 0 04:04:09 pts/1 0:00 grep java

root 18382 18311 0 03:42:33 pts/2 12:20 /opt/HWNMSJRE/jre linux/bin/java
-server -Dequinox.conf=engineering/conf/installE

(1 noTe

If the displayed information contains /opt/HWNMSJRE/jre_linux/bin/java -server, it indicates
that the network management system maintenance suite process is started.

If the network management system maintenance suite process has not been started, run the
following commands to start it:

# cd /opt/HWENGR/engineering

# ./startserver.sh

Do as follows to check whether the daem process of the slave server has been started:
# ps -ef|grep start

Information similar to the following is displayed:

root 1702 1 0 20:48 pts/0 00:00:00 /bin/bash ./start_daem -type
StandbyNode

root 1770 1702 1 20:48 pts/0 00:00:00 /opt/U2000/server/3rdTools/
python/bin/python /opt/U2000/server/bin/script/start daem.py -type StandbyNode
root 1782 1355 0 20:48 pts/0 00:00:00 grep start
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Or a message similar to the following will be displayed:

root 27069 1 0 10:31:39 2 1:39 imapmrb
root 27079 1 0 10:31:39 2 0:00 imapwatchdog -cmd start
root 27075 1 0 10:31:39 2 0:50 imapsysd -cmd start
root 27086 1 0 10:31:39 2 0:09 imapeventmgr
root 23679 1 1 17:57:06 pts/8 0:02 imap sysmonitor -cmd start
root 27116 1 0 10:31:40 2 0:52 ResourceMonitor -cmd start
(1 noTE

If /bin/bash ./start_daem -type StandbyNode, /opt/U2000/server/3rdTools/python/bin/python,
or imapsysd -cmd start is displayed, the daem process of the slave server has been started.

If the daem process has not been started, run the following command to start it:
# /etc/init.d/u2kdaem start

2 Check whether the Network Management System Maintenance Suite process of the master
server has been started.

1.
2.

Log in to the OS of the master server as the root user.

Do as follows to check whether the network management system maintenance suite process
has been started:

# ps -ef | grep java

root 19913 19907 0 04:04:09 pts/1 0:00 grep java

root 18382 18311 0 03:42:33 pts/2 12:20 /opt/HWNMSJRE/jre linux/bin/java
-server -Dequinox.conf=engineering/conf/installE

(L noTE

If the displayed information contains /opt/HWNMSJRE/jre_linux/bin/java -server, it indicates
that the network management system maintenance suite process is started.

If the network management system maintenance suite process has not been started, run the

following commands to start it:
# cd /opt/HWENGR/engineering
# ./startserver.sh

3 On the master server, do as follows to ensure that the Oracle process and the database listening
process have been started:

1.

To check whether the Oracle process has been started, run the following command:

# su - oracle
> ps -ef | grep ora_

Information similar to the following is displayed:

oracle 4055 1 0 20:00 2 00:00:00 ora_j000_UZ2KDB
oracle 4174 4107 0 20:00 pts/1 00:00:00 grep ora_

oracle 23333 1 0 Novl5 2 00:00:20 ora_pmon_ U2KDB
oracle 23335 1 0 Novl5 2 00:00:00 ora_vktm U2KDB
oracle 23339 1 0 Novl5 ? 00:00:00 ora_diag U2KDB
oracle 23341 1 0 Novl5 2 00:00:00 ora_dbrm U2KDB
oracle 23343 1 0 Novl5 ? 00:00:01 ora pspO_UZ2KDB
oracle 23347 1 0 Novl5 2 00:03:35 ora_dia0_U2KDB
oracle 23349 1 0 Novl5 2 00:00:00 ora mman U2KDB
oracle 23351 1 0 Novl5 2 00:00:03 ora_dbw0O_UZ2KDB
oracle 23353 1 0 Novls ? 00:00:13 ora_lgwr_ U2KDB
oracle 23355 1 0 Novls5 ? 00:00:15 ora_ckpt U2KDB
oracle 23357 1 0 Novl5 2 00:00:06 ora_smon_ U2KDB
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1 noTE

® [fthe displayed information contains the following five processes, it indicates that the database
service is started normally.

ora_pmon_U2KDB
ora_dbw0 U2KDB
ora_lgwr U2KDB
ora_ckpt U2KDB
® ora smon U2KDB

® [f the database process is not started, run the following commands to start the Oracle database
process.
> sqlplus / as sysdba
SQL> startup
ORACLE instance started.

Total System Global Area 1610612736 bytes

Fixed Size 2046264 bytes
Variable Size 385877704 bytes
Database Buffers 1207959552 bytes
Redo Buffers 14729216 bytes

Database mounted.
Database opened.

Run the following command to exit the SQL Server database.
SQL> exit

Run the following command to check whether the listener is started.

> lsnrctl status

Information similar to the following is displayed:

STATUS of the LISTENER

Alias LISTENER
Version TNSLSNR for Linux: Version 11.1.0.7.0 - Production
Start Date 17-DEC-2009 20:35:58
Uptime 0 days 0 hr. 5 min. 2 sec
Trace Level off
Security ON: Local OS Authentication
SNMP OFF
(1 noTE
® [f the displayed information contains Alias LISTENER, it indicates that the listener is started
normally.

® [f the listen has not been started, run the following command to start it:
> lsnrctl start

Run the following command to log out the Oracle user:

> exit

4 On the master server, start U2000 server processes.

1.

To check whether U2000 server processes have been started, run the following commands:

# cd /opt/U2000/server
# . svc_profile.sh
# daem ps

1 noTE

Leave a space between the dot . and the command svc_profile.sh.

Information similar to the following is displayed:
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root 27069 1 0 10:31:39 2 1:39 imapmrb

root 27079 1 0 10:31:39 2 0:00 imapwatchdog -cmd start

root 27075 1 0 10:31:39 2 0:50 imapsysd -cmd start

root 27086 1 0 10:31:39 2 0:09 imapeventmgr

root 23679 1 1 17:57:06 pts/8 0:02 imap sysmonitor -cmd start

root 27116 1 0 10:31:40 2 0:52 ResourceMonitor -cmd start
(1 noTe

The U2000 is running if the displayed information contains imap_sysmonitor -cmd start.

2. Ifthe U2000 processes are not started, run the following command to start U2000 processes:

# cd /opt/U2000/server/bin
# ./startnms.sh

5 On the master server, run the following commands to check running status of each U2000

process:

# c¢d /opt/U2000/server
# . svc_profile.sh
# svc_adm -cmd status -all

(1 noTE

Leave a space between the dot . and the command sve_profile.sh.

Information similar to the following is displayed:

Service Agent: trapdispatcher [l service(s)] pid: 13711
trapdispatcher [running ]

Service Agent: trapr agent [1 service(s)] pid: 9927
TrapReceiver [running ]

[All Services: 64 ] [Running: 64 ] [Not Running: 0 ]
(1 noTE

If the value of Not Running is 0, it indicates that the U2000 has been installed successfully. If U2000
processes are abnormal, contact Huawei engineers.

—End
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1 O Handling the Failure to Install U2000
Software

This topic describes how to handle the failure to install U2000 software.

Procedure
1 Log in to the OS of the master server as the root user.
2 Ensure that the Oracle process is stopped.

To check whether the Oracle database is running, run the following command:
> ps -ef | grep ora_
Information similar to the following is displayed:
oracle 4055 1 0 20:00 2 00:00:00 ora_ 3000 _U2KDB
oracle 4174 4107 0 20:00 pts/1 00:00:00 grep ora_
oracle 23333 1 0 Novl5 2 00:00:20 ora_pmon_ UZ2KDB
oracle 23335 1 0 Novl5 2 00:00:00 ora_vktm UZ2KDB
oracle 23339 1 0 Novl5 2 00:00:00 ora_diag U2KDB
oracle 23341 1 0 Novl5 2 00:00:00 ora_dbrm U2KDB
oracle 23343 1 0 Novl5 2 00:00:01 ora_pspO_U2KDB
oracle 23347 1 0 Novl5 2 00:03:35 ora_dia0_ U2KDB
oracle 23349 1 0 Novls 2 00:00:00 ora mman_ U2KDB
oracle 23351 1 0 Novl5 2 00:00:03 ora_dbw0O_U2KDB
oracle 23353 1 0 Novl5 2 00:00:13 ora_lgwr U2KDB
oracle 23355 1 0 Novl5 2 00:00:15 ora_ckpt U2KDB
oracle 23357 1 0 Novl5 2 00:00:06 ora_smon_ UZ2KDB
(I note

If the displayed information contains the following processes, the database service is started successfully:

® ora pmon U2KDB

ora_dbw0 U2KDB

® ora lgwr U2KDB

® ora ckpt U2KDB

® ora smon U2KDB
To check whether the listener is started, run the following commands:
> su - oracle
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password:password of oracle user
> lsnrctl status
> exit

Information similar to the following is displayed:

STATUS of the LISTENER

Alias LISTENER

Version TNSLSNR for Linux: Version 11.1.0.7.0 - Production
Start Date 17-DEC-2009 20:35:58

Uptime 0 days 0 hr. 5 min. 2 sec

Trace Level off

Security ON: Local OS Authentication

SNMP OFF

(1 noTE

If the displayed information contains Alias LISTENER, the listener is started successfully:

If the Oracle process is started, run the following commands to stop the Oracle process:

> su - oracle
password:oracle user password
> sqlplus / as sysdba

SQL> shutdown immediate

SQL> exit

> exit

Ensure that the Network Management System Maintenance Suite is not running.
Run the following command to check whether the network management system maintenance

suite process is started:
# ps -ef | grep java

root 19913 19907 0 04:04:09 pts/1 0:00 grep java

root 18382 18311 0 03:42:33 pts/2 12:20 /opt/HWNMSJRE/jre sol/bin/java -
server -Dlanguage=en -Xverify:none -Xmx128m -Xm

(0 noTE

If the displayed information contains /opt/HWNMSJRE/jre_sol/bin/java -server, it indicates that the
network management system maintenance suite process is started.

Run the following commands to stop the Network Management System Maintenance Suite if it
is running;:

# cd /opt/HWENGR/engineering

# ./stopserver.sh

Run the following commands to delete the installation paths /opt/U2000 and /opt/oracle:

# rm -rf /opt/U2000
# rm -rf /opt/oracle

Run the following commands to delete users nmsuser and oracle:

# userdel nmsuser
# userdel -rf oracle

Run the following command to delete user groups nmsgroup and oracle:

# groupdel nmsgroup
# groupdel oracle

Run the following command to delete user directory /export/home/nmsuser:

# rm -rf /export/home/nmsuser
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Run the following commands to delete the temporary file directory of the oracle database:

# rm -rf /tmp/*oracle
# rm -rf /tmp/oracle*

Log in to the OS of the slave server as the root user.
(0 noTE

If there are multiple slave servers, log in to other servers and then do as follows:
Ensure that the Network Management System Maintenance Suite is not running.

Run the following command to check whether the network management system maintenance

suite process is started:
# ps -ef | grep java
root 19913 19907 0 04:04:09 pts/1 0:00 grep java

root 18382 18311 0 03:42:33 pts/2 12:20 /opt/HWNMSJRE/jre sol/bin/java -
server -Dlanguage=en -Xverify:none -Xmx128m -Xm

1 NoTE

If the displayed information contains /opt/HWNMSJRE/jre_sol/bin/java -server, it indicates that the
network management system maintenance suite process is started.

Run the following commands to stop the Network Management System Maintenance Suite if it
is running:

# cd /opt/HWENGR/engineering

# ./stopserver.sh

Run the following command to delete the installation directory, that is, the /opt/U2000 directory:
# rm -rf /opt/U2000

Run the following command to delete the nmsuser user:

# userdel nmsuser

Run the following command to delete the nmsgroup user group:

# groupdel nmsgroup

Run the following command to delete user directory /export/home/nmsuser:

# rm -rf /export/home/nmsuser

Reinstall the U2000 software. For details, see 7.4 Starting the U2000 Installation Program.

—End
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This topic provides answers to the most frequent questions concerning the installation.
A.1 SUSE Linux OS
This topic provides the FAQs occurred in the SUSE Linux OS.

A.2 Oracle Database
This topic describes the FAQs about the Oracle database.

A.3 U2000 System
This topic covers FAQs about the U2000 system.
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A.1 SUSE Linux OS

This topic provides the FAQs occurred in the SUSE Linux OS.

A.1.1 How to Start/Stop the FTP, TFTP, SFTP, and Telnet Services

A.1.2 How to Enable and Disable the FTP/Telnet Authority of the root User in the SUSE Linux
0S?

A.1.3 How to Check Disk Partitions

A.1.4 How to Check the Remaining Space of a Disk

A.1.5 How to Monitor System Processes and Application Ports?

A.1.6 How to Log In to the OS Through the Remote Login Tools?

A.1.7 How to Query the Process Status

A.1.8 How to Forcibly End a Process

A.1.9 How to Use the vi Editor

A.1.10 How to Change the Time and Time Zone of the SUSE Linux OS?

A.1.1 How to Start/Stop the FTP, TFTP, SFTP, and Telnet Services

Question
How to start/stop the FTP, TFTP, SFTP, and Telnet services in the SUSE Linux OS?
Answer
® Perform the following operations for the FTP, TFTP and Telnet services:
1. Run the following command in the YaST2 Control Center window as user root to
enter the Network Service Configuration window:
# yast2 inetd
2. Inthe Currently Available Services list, select the FTP, TFTP, and Telnet services
respectively, the following dialog box is displayed.
A-2 Huawei Proprietary and Confidential Issue 05 (2010-11-19)
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Figure A-1 Starting the FTP, TFTP, and Telnet services
{ﬁ* Network Service Configuration (xinetd)

) Disable
(® Enable

Currently Available Services

|Ch | Status | Service |Type | Protocol |Wait | User Server | Sewf!a
NI admind stream tcp No roct Jusr/shin/fadmind
Nl amanda dgram udp  Yes amanda.disk Jusrlibfamanda/amandad
NI amandaidx stream tep No amanda.disk Jusrlibvamanda/amindexd
NI amidxtape stream tcp No amanda.disk lusr/liblamanda/amidxtaped
NI bootps dgram udp  Yes rootroot fusr/sbin/bootpd -C /tf
— chargen stream tcp No root
— chargen  dgram udp  Yes root
NI cvspserver stream tep No roct Jusribinfcvs -f —all
— daytime  stream tcp No root

— daytime  dgram udp  Yes root
Nl dvbcat stream tcp No dvbdaemon Jusr/bin/dvbecat-network pl

— echo stream tcp No root
— echo dgram udp Yes root
Nl exec stream tcp No root.root lusr/shin/tcpd fusr/st
— fam/2 stream tcp  Yes  rootroot fusr/sbin/famd
NI finger stream tcp No nobody Jusr/shin/in fingerd -W =
stream root Jusr/shin/pure-ftpd o
(] | 1D
[ Add ] [ Edit l [ Delete [ Toggle Status (Cn or Off) l

[ Status for All Services ]

3. Click Toggle Status (On or Off) to configure the FTP, TFTP, and Telnet services
respectively.

(1) noTE

@ [f Status is On, it indicates that the FTP service is started; if Status is -, it indicates that
the FTP service is configured but not started; if Status is NI, it indicates that the FTP service
is not configured.

® When starting the FTP service, insert the OS disk and then click OK if the system prompts
you to insert the OS disk.

4.  Click Finish.
® Perform the following operations for the SFTP service:
- Run the following command to start the SFTP service:
# service sshd start
- Run the following command to stop the SFTP service:

# service sshd stop

—End
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A.1.2 How to Enable and Disable the FTP/Telnet Authority of the
root User in the SUSE Linux OS?

Question
How to Enable and Disable the FTP/Telnet Authority of the root User in the Solaris OS?
Answer

The method of enable the FTP authority of the root user is as follow:

1. Login to the SUSE Linux OS as the root user.

2. Use the text editor to open the ftpusers file in the /etc directory. Add the comment
tag (#) to the beginning of the following line in the ftpusers file to comment out this
line:
root

3. Run the command wq! to save and close the ftpusers file.

The method of disable the FTP authority of the root user is as follow:

1. Log in to the SUSE Linux OS as the root user.

2. Use the text editor to open the ftpusers file in the /etc directory. delete the comment
tag (#) to the beginning of the following line in the ftpusers file:
root

3. Run the command wq! to save and close the ftpusers file.

The method of enable the Telnet authority of the root user is as follow:

1. Login to the SUSE Linux OS as the root user.

2.  Edit the /etc/securettyfile, run the following command:

# vi /etc/securetty

3. Add the following character string to the end of the file:
pts/0
pts/1
pts/2
pts/3
pts/4
pts/5
pts/6
pts/7

4. Run the command wq! to save and close the securetty file.

The method of disable the Telnet authority of the root user is as follow:

1. Login to the SUSE Linux OS as the root user.

2.  Edit the /etc/securettyfile, run the following command:

# vi /etc/securetty

3. delete the following character string to the end of the file:

pts/0
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pts/1
pts/2
pts/3
pts/4
pts/5
pts/6

pts/7

4. Run the command wq! to save and close the securetty file.

—End

A.1.3 How to Check Disk Partitions

Question

Answer

ga = W DN

How do I check disk partitions?

Run the following command in the terminal window to open the YaST2 Control Center
window.

# yast2
(1 noTE

If the GUI is unavilable, run the yast command to start the YaST Control Center.
Select System on the left.
Select Partitioner on the right.
Carefully read the information in the Warning dialog box, and then click Yes.

In the Expert Partitioner window, view the disk partition information and check whether the
partitions meet the requirements of the U2000 system software.

—End

A.1.4 How to Check the Remaining Space of a Disk

Question

How do I check the remaining space of a disk?
Answer

Run the df -hk command to check the remaining space of a disk.

For example, run the df -hk /opt command to check the remaining space of the /opt partition.
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A.1.5 How to Monitor System Processes and Application Ports?

Question

How to monitor system processes and application ports after the SUSE Linux OS is installed?

Answer

Click the Computer > More Applications > System > GNOME System Monitor to manage
processes or run the ps -ef | grep processe name command to view processes. You can run the
vmstat or top command to view the usage of the CPU, memory, and 1/O bus.

A.1.6 How to Log In to the OS Through the Remote Login Tools?

Question

What should I do when I fail to log in to the SUSE Linux OS through the remote login tools?

Answer
1 Login to the OS as user root.
2 Run the following command in the terminal window:
# yast remote allow set=yes
# rexdm restart
3 Use the remote login tools to log in to the U2000 server again.

——-End

A.1.7 How to Query the Process Status

Question

How do I query the process status?

Answer

Run the ps -ef | grep process name command to query the process status.

For example, run the ps -ef | grep sysmonitor command to query the status of the

sysmonitor process.The following message will be displayed:
nmsuser 17156 17032 0 22:13:59 pts/3 0:00 grep sysmonitor nmsuser 11972
1 0 04:38:10 pts/2 13:00 imap sysmonitor -cmd start

® imap_sysmonitor indicates information about the process, where 17156 is the process ID.
(0 noTE
Process information will be displayed if the process is running.

® grep sysmonitor indicates the query operation performed by the user and can be ignored.
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A.1.8 How to Forcibly End a Process

Question

How do I forcibly end a process?

Answer

Run the kill -9 process ID command to forcibly end a process.

A.1.9 How to Use the vi Editor

Question
How do I use the vi editor?
Answer
Run the following command to open the vi editor:
vi file name
® [fa file with the same filename exists, run the vi command to open and edit the file.
® [fa file with the same filename does not exist, run the vi command to create and edit a file.
The edit commands are as follows:
® The command for opening the vi editor is as follows:
vi file name
® The command for entering the command mode is as follows.
Command Function
ESC Press ESC to exit the text input mode and enter the command
mode.
® The commands for inserting text are as follows (must be run in command mode).
Command Function
a Appends text at the cursor (append).
A Appends text at the end of the line where the cursor locates.
i Adds text in front of the cursor (insert).
| Adds text to the front of the first non-null character in the
line where the cursor locates.
0 Adds text at the beginning of the next line where the cursor
locates (open).
(0) Adds text at the beginning of the previous line where the
cursor locates.
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® The commands for moving the cursor are as follows (must be run in command mode).

Command Function

h Moves the cursor to the left.

j Moves the cursor downwards.
k Moves the cursor upwards.

1

Moves the cursor to the right.

Line number G

Moves the cursor to a specified line. For example, 1G moves
the cursor to the first line.

G

Moves the cursor to the end of the file.

® The commands for deleting texts are as follows (must be run in command mode).

Command Function
X Deletes the character where the cursor is located.
dd Deletes the line where the cursor is located.

® The commands for quitting the vi editor are as follows and must be run in command mode.
You are recommended to press ESC before running any command listed in Table A-1.

Table A-1 Commands for quitting the vi editor

Command Function

‘wq Saves changes and quits the vi editor.

q Quits the vi editor without saving changes.

q! Forcibly quits the vi editor without saving changes.
W Saves changes without quitting the vi editor.

A.1.10 How to Change the Time and Time Zone of the SUSE Linux

OS?

Question
How to change the time and time zone of a SUSE Linux OS where the U2000 is nt installed yet?
Answer
1 Log in to the graphical desktop system of the SUSE Linux OS as the root user.
2 Open the CLI and run the following command to start the YaST2 control center.
# yast2
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3 Choose System > Date and Time.

m Software Management
Groups

Hardware

Miscellaneous

Virtualization

4 In the dialog box that is displayed, set the area and time zone.

& Clock and Time Zone

Region Time Zone
Europs |srael B
LSsA Jakaria
Canada Japan
Cenfral and South America Kamchalka
Russia Kaimandu
Korea
Australia Krasnoyarsk
Africa
Parific Kuwait I
Global Macao
Ei Magadan
Manila

Mideast Riyadh&?
Mideast Riyadh22
Mideast Riyadh2a
Mawvosibirsk
Cmsk

Phnom Penh
Qatar

Rangoon

Saigon
Sakhalin
Samarkand

Seoul -

Hardware Clock Set To ) (=
]

’UTC I 16:14:45 - 20100826 ‘
Cancel Accept
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5 To change the time, click Change. In the dialog box that is displayed, set the date and time, and
then click Apply.

6 Click Accept.
7 To restart the OS ,run the following commands:

# sync;sync;sync;sync
# shutdown -r now

—End

A.2 Oracle Database

This topic describes the FAQs about the Oracle database.

A.2.1 How to Check Whether the Oracle Database Has Been Installed
A.2.2 How to Check the Version of the Oracle Database

A.2.3 How to Check the Name of the Oracle Database

A.2.4 How Can I Start the Oracle Database (Single-Server System)?
A.2.5 How Can I Stop the Oracle Database (Single-Server System)?
A.2.6 How Can I Check Whether the Oracle Database Is Started?
A.2.7 How Can I Check Whether the Oracle Listener Is Started?

A.2.1 How to Check Whether the Oracle Database Has Been
Installed

Question

How to check whether the Oracle database has been installed?

Answer
(1 noTE

® [fthe Oracle database has not been installed, when you install the U2000, the Oracle database is
automatically installed along with the U2000.

® [fthe Oracle database has been installed, when you install the U2000, a dialog box is displayed asking
you whether to reuse the Oracle database. If you choose to reuse it, you do not need to re-install the
Oracle database and thus can save time; if you choose not to reuse it, you need to re-install the Oracle
database. Generally, it is recommended that the Oracle database not be reused.

® Consult the PC administrator to learn whether the Oracle database has been installed.

®  Check whether the installation directory and file of the Oracle database exist. A sample
directory is /opt/oracle.

®  Check whether the Oracle database has been started and whether the version of the Oracle
database is correct. For details, see A.2.6 How Can I Check Whether the Oracle
Database Is Started?. For details about how to start the Oracle database, see A.2.4 How
Can I Start the Oracle Database (Single-Server System)?.

—End
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A.2.2 How to Check the Version of the Oracle Database

Question

How to check the version of the Oracle database?

Answer

See A.2.6 How Can I Check Whether the Oracle Database Is Started?.

A.2.3 How to Check the Name of the Oracle Database

Question

How to check the name of the Oracle database?

Answer

1 Login to the SUSE Linux OS as the oracle user.
(0 noTE

The oracle user is the user that manages the Oracle database.

2 Run the following command to connect to the Oracle database:
$ sqlplus / as sysdba

3 Run the following command to check the name of the Oracle database:
SQL> select name from v$database;

Information similar to the following is displayed:
NAME —-------- U2KDB

(1 noTE

Alternatively, you can run the following command to check db_name:
SQL> show parameter db

—End

A.2.4 How Can I Start the Oracle Database (Single-Server
System)?

Question
How Can I Start the Oracle Database?
Answer
1 Loginto SUSE Linux as oracle.
(O noTE
oracle is a user who manages the Oracle database.
2 Inthe command prompt window, run the following command to connect to the Oracle database:
$ sqlplus / as sysdba
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3 Run the startup command to start the Oracle database.
> startup

The following is a display sample:

ORACLE instance started.

Total System Global Area 1610612736 bytes

Fixed Size 2046264 bytes
Variable Size 385877704 bytes
Database Buffers 1207959552 bytes
Redo Buffers 14729216 bytes

Database mounted.
Database opened.

ORACLE instance started, Database mounted, and Database opened indicate that the Oracle
DB is started properly.

——-End

A.2.5 How Can I Stop the Oracle Database (Single-Server
System)?

Question

How Can I Shut Down the Oracle Database?

Answer

1 Login to SUSE Linux as oracle.
(0 noTE

oracle is a user who manages the Oracle database.
2 In the command prompt window, run the following command to connect to the Oracle database:
$ sqlplus / as sysdba
3 Run the shutdown command to shut down the Oracle database.
> shutdown immediate

The following is a display sample:

Database closed.
Database dismounted.
ORACLE instance shut down.

Database closed indicates that the Oracle database is closed successfully. Database
dismounted indicates that the database is dismounted successfully. ORACLE instance shut
down indicates that the database instances are closed successfully.

—End

A.2.6 How Can I Check Whether the Oracle Database Is Started?

Question

How Can I Check Whether the Oracle Listener Is Started?
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Answer

1 Loginto SUSE Linux as oracle.

(1 noTE

oracle is a user who manages the Oracle database.
In the command prompt window, run the following command to connect to the Oracle database:
$ sqlplus / as sysdba

On the CLI, run the following command to check whether the Oracle database is installed
successfully by viewing the version information:

> select * from vS$version;

The following is a display sample:
BANNER

Oracle Database 1lg Enterprise Edition Release 11.1.0.7.0 - 64bit Production
PL/SQL Release 11.1.0.7.0 - Production

CORE 11.1.0.7.0 Production

TNS for Linux: Version 11.1.0.7.0 - Production

NLSRTL Version 11.1.0.7.0 - Production

The information indicates that the Oracle database is connected and started successfully. You
can query data normally.

Otherwise, for single system, see A.2.4 How Can I Start the Oracle Database (Single-Server
System)? to start the Oracle database.

—End

A.2.7 How Can I Check Whether the Oracle Listener Is Started?

Question

Answer

How Can I Check Whether the Oracle Listener Is Started?

Log in to SUSE Linux as oracle.
(1) noTE

oracle is a user who manages the Oracle database.
On the CLI, run the following command to view the state of the Oracle listener:
$ Isnrctl status

The following is a display sample:

STATUS of the LISTENER

Alias LISTENER
Version TNSLSNR for Linux IA64: Version 10.2.0.3.0 - Production
Start Date 23-MAR-2009 10:16:36

Here,STATUS of the LISTENERindicates that the Oracle listener is already started. If the
listener is not restarted, run the following command on the CLI to start the listener:
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S Isnrctl start

—End

A.3 U2000 System

This topic covers FAQs about the U2000 system.

A.3.1 How to Verify That the U2000 Is Installed

A.3.2 How to Verify That the Processes of the U2000 Single-Server System (SUSE Linux-
Distributed) Are Running

A.3.3 How to Start the Processes of the U2000 Single-Server System (SUSE Linux-Distributed)
A.3.4 How to End the Processes of the U2000 Single-Server System (SUSE Linux-Distributed)
A.3.5 How to Configure the ipmap.cfg Mapping File

A.3.6 How to Determine Which Types of Software Are Preinstalled

A.3.7 Which Installation Packages Are Required for U2000 Installation

A.3.8 How to Handle Messages Indicating That the Port Is Occupied During Installation or
Uninstall

A.3.9 How to Check Whether the daem Process Is Started

A.3.10 How to Start the daem Process

A.3.11 How to End the daem Process

A.3.12 How to Check Downloaded Software Packages by Using MDS5 Software

A.3.13 How to Configure the Communication Mode for a Linux-based U2000 Server?

A.3.1 How to Verify That the U2000 Is Installed

Question
How do I verify that the U2000 is installed?
Answer
Log in to the OS as user root.
2. Run the following commands to view the /opt/U2000 directory: If this directory exists and
is not empty, it indicates that the U2000 is installed.
# cd /opt/U2000
#1s
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A.3.2 How to Verify That the Processes of the U2000 Single-Server
System (SUSE Linux-Distributed) Are Running

Question

How do I verify that processes of the U2000 single-server system (SUSE Linux-distributed) are
running?

Answer

1 Log in to the master server as user nmsuser.
2 Check the U2000 processes.

To check whether U2000 processes are started, run the following commands:

# ed /opt/U2000/server
# . svc_profile.sh
# daem ps

(1 noTE

Leave a space between the dot (.) and the command sve_profile.sh.

Information similar to the following is displayed:

root 11800 1 0 15:09 2 00:00:02 /opt/U2000/server/bin/imapmrb
root 11909 1 0 15:09 2 00:00:00 imapwatchdog -cmd start

root 11902 1 1 15:09 2 00:00:10 imapsysd -cmd start

root 11906 1 0 15:09 2 00:00:00 imapeventmgr

root 12479 11909 2 15:09 2 00:00:11 /opt/U2000/server/bin/

imap sysmonitor -cmd start >/dev/null 2>&l

root 11948 1 0 15:09 2 00:00:02 ResourceMonitor -cmd start
(O noTE

The U2000 is running if the displayed information contains imap_sysmonitor -cmd start.

——-End

A.3.3 How to Start the Processes of the U2000 Single-Server System
(SUSE Linux-Distributed)

Question
How do I start the processes of the U2000 single-server system (SUSE Linux-distributed)?
Answer
1 Log in to the master server as user root.
2 On the master server, start U2000 server processes.
1. To check whether U2000 server processes have been started, run the following commands:
# cd /opt/U2000/server
# . svc_profile.sh
# daem ps
(0 noTE
Leave a space between the dot . and the command sve_profile.sh.
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Information similar to the following is displayed:

root 27069 1 0 10:31:39 2 1:39 imapmrb
root 27079 1 0 10:31:39 2 0:00 imapwatchdog -cmd start
root 27075 1 0 10:31:39 7 0:50 imapsysd -cmd start
root 27086 1 0 10:31:39 2 0:09 imapeventmgr
root 23679 1 1 17:57:06 pts/8 0:02 imap sysmonitor -cmd start
root 27116 1 0 10:31:40 7 0:52 ResourceMonitor -cmd start
(1 noTE

The U2000 is running if the displayed information contains imap_sysmonitor -cmd start.

2. Ifthe U2000 processes are not started, run the following command to start U2000 processes:

# cd /opt/U2000/server/bin
# ./startnms.sh

—End

A.3.4 How to End the Processes of the U2000 Single-Server System
(SUSE Linux-Distributed)

Question

How do I end the processes of the U2000 single-server system (SUSE Linux-distributed)?

Answer

1 Log in to the master server as user root.

2 Run the following commands to stop the U2000:

# cd /opt/U2000/server/bin
# ./stopnms.sh

—End

A.3.5 How to Configure the ipmap.cfg Mapping File

Question
If NAT networking is applied in a distributed system, after the U2000 software is installed or
the server IP address is changed, the ipmap.cfg mapping file need to be manually configured
on the master server. How do I configure the ipmap.cfg mapping file?
Answer
1 Obtain and record the following IP addresses.
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® You can obtain system [P addresses of servers in the distributed system from the NMS administrator.
Alternatively, run the ifconfig -a command on the servers. The IP addresses indicated by bond0 are
system [P addresses of the servers.

® To obtain private IP addresses of servers in the distributed system, run the ifconfig -a command on the

servers. The IP addresses indicated by bond1 are private IP addresses of the servers.

® You can obtain the public IP address of the NAT server from the NMS administrator.

Table A-2 Mapping relationship between U2000 IP addresses and NAT server IP addresses

System IP Addresses of All
Servers in the Distributed
System

Private IP Addresses of All
Servers in the Distributed
System

Public IP Addresses of the
NAT Server

System IP address of the master
server. For example,
129.9.1.30.

Private IP address of the master
server. For example,
192.168.100.20.

Public IP address 1 on the NAT
server. For example, 10.1.1.10.

System IP address of slave
server 1. For example,
129.9.1.31.

Private IP address of slave server
1. For example,
192.168.100.21.

Public IP address 2 of the NAT
server. For example, 10.1.1.11.

System IP address of slave
server 2. For example,
129.9.1.32.

Private IP address of slave server
2. For example,
192.168.100.22.

Public IP address 3 of the NAT
server. For example, 10.1.1.12.

System IP address of slave
server N:

Private IP address of slave server
N.

Public IP address N of the NAT
server.

2 Log in to the master server as user root.

3 Open a terminal window. Run the associated commands to access the server/etc/conf directory
in the U2000 installation path. For example, if the default installation path of the U2000 is /opt/
U2000, run the following command:
cd /opt/U2000/server/etc/conf

4 Run the vi command to modify the ipmap.cfg file.

1. If the ipmap.cfg file exists in the installation path, run the following command to delete
the file. If the ipmap.cfg file does not exist in the installation path, directly go to 4.2.
rm -f ipmap.cfg

2. Create and modify the ipmap.cfg file.
vi ipmap.cfg

3. Run the vi command to modify the ipmap.cfg file. The following uses the IP address

collected in Step 1 as an example.
internal=129.9.1.30,client=10.1.1.10,server=192.168.100.20
internal=129.9.1.31,client=10.1.1.11,server=192.168.100.21
internal=129.9.1.32,client=10.1.1.12,server=192.168.100.22

[ noTE

The statement format is as follows: internal = System IP address of the server, client = Public IP

Addresses of the NAT Server
4.  After the ipmap.cfg file is modified, save the file and exit.

——End

Issue 05 (2010-11-19) Huawei Proprietary and Confidential

Copyright © Huawei Technologies Co., Ltd.



iManager U2000 Unified Network Management System
Single-Server System Software Installation Guide (SUSE
A FAQs Linux)

A.3.6 How to Determine Which Types of Software Are Preinstalled

Question
Servers come preinstalled with software from Huawei. The U2000 servers come preinstalled to
different extents according to the scheme and software purchased. How do I determine which
types of software are preinstalled?

Answer

In the single-server system: The U2000 is installed based on the bill of material (BOM).

® [fthe U2000 license BOM is available, the U2000 needs to be installed according to the
license BOM. Technical support engineers should change the IP address, install the license
on the U2000, and then use the U2000.

® [fthe U2000 license BOM is unavailable, only the OS needs to be installed.

A.3.7 Which Installation Packages Are Required for U2000
Installation

Question

Which installation packages are required for U2000 installation?

Answer

Prepare installation packages according to the U2000 installation scheme.

Table A-3 Software required for installation (blade server)

Software Medium Description

SUSE Linux OS You can install the SUSE Linux OS by using the quick installation
DVD or the common installation DVD.

® Quick installation DVD:
U2000version_server _os_sles x64 dvdl

® Common installation DVD: SUSE Linux 10 Enterprise Server
10 SP3

Database Installation DVD or installation package
® [nstallation DVD: U2000version_server_db_sles x64 dvd3

® [Installation package: U2000version_server db_sles x64.tar
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Software

Medium Description

U2000 server software | Installation DVD or installation package
® Installation DVD: U2000version_server nms_sles x64 dvd4

® [nstallation package:

NOTE

- Basic component:

Prepare software packages required by the components to be installed.

U2000version_server nmsbase sles x64.tar
It must be available. It is used to install the U2000.

Core component:
U2000version_server nmscore_sles x64.tar
It must be available. It is used to install the U2000.

Transport domain component:

U2000version_server nmstrans_sles x64.tar

It is required only if the U2000 needs to manage Huawei
transport equipment. Huawei transport equipment
includes:

- MSTP equipment

- WDM equipment

- NA WDM equipment
- Submarine equipment
- RTN equipment

- PTN equipment

IP domain component:

U2000version_server nmsip_sles x64.tar

It is required only if the U2000 needs to manage Huawei
IP equipment. Huawei IP equipment includes:

- Routers

- Switches

- Metro service equipment

- Broadband access equipment
- VoIP gateways

- Firewalls

- Service inspection gateway
- SVN equipment

Access domain component:

U2000version_server nmsaccess_sles x64.tar

It is required only if the U2000 needs to manage Huawei
access equipment. Huawei access equipment includes:

- FTTx equipment
- MSAN equipment
- DSLAM equipment
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A.3.8 How to Handle Messages Indicating That the Port Is Occupied
During Installation or Uninstall

Question

Answer

How do I handle messages indicating that the port is occupied during use of the MSuite,
installation, or uninstall?

In the SUSE Linux OS, the message is as follows:

The communication port (12212,12213,12214,12215) of the installation framework is
used. Run the "/bin/netstat -ant" command to query the usage status of the port, or
try later.

®  Wait about one minute and try again after the port is released automatically.

® [n the Solaris or SUSE Linux OS, run the following command to view process IDs:

# ps —ef | grep java root 19913 19907 0 04:04:09 pts/1 0:00 grep java ...
root 18382 18311 0 03:42:33 pts/2 12:20 /opt/HWNMSJRE/jre sol/bin/java
-server -Dequinox.conf=engineering/conf/installE ...

Locate the process that contains the command output: /opt/HWNMSJRE/jre_sol/bin/java
-server and end the process by running the kill command. The following is a sample kill

command:
# kill -9 18382

—End

A.3.9 How to Check Whether the daem Process Is Started

Question
The NMS server processes can be started only after the daem process of the slave server is started.
In normal cases, the daem process is started along with the SUSE Linux OS. How do I check
whether the daem process is started?
Answer
Log in to the OS of the server as user root.
Open a terminal window and run the following command:
# ps -ef|grep start
Information similar to the following is displayed:
root 1702 1 0 20:48 pts/0 00:00:00 /bin/bash ./start_daem -type
StandbyNode
root 1770 1702 1 20:48 pts/0 00:00:00 /opt/U2000/server/3rdTools/python/
bin/python /opt/U2000/server/bin/script/start daem.py -type StandbyNode
root 1782 1355 0 20:48 pts/0 00:00:00 grep start
Or a message similar to the following will be displayed:
root 27069 1 0 10:31:39 2 1:39 imapmrb
root 27079 1 0 10:31:39 2 0:00 imapwatchdog -cmd start
root 27075 1 0 10:31:39 2 0:50 imapsysd -cmd start
root 27086 1 0 10:31:39 2 0:09 imapeventmgr
root 23679 1 1 17:57:06 pts/8 0:02 imap sysmonitor -cmd start
root 27116 1 0 10:31:40 2 0:52 ResourceMonitor -cmd start
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If /bin/bash ./start_daem -type StandbyNode, /opt/U2000/server/3rdTools/python/bin/python, or
imapsysd -cmd start is displayed, the daem process of the slave server has been started.

—-End

A.3.10 How to Start the daem Process

Question

In normal cases, the daem process is started along with the SUSE Linux OS. If the daem process
is not started, how do I start it?

Answer

1 Log in to the OS of the server as user root.

2 Open a terminal window and run the following command:
# /etc/init.d/u2kdaem start

—End

A.3.11 How to End the daem Process

Question

How do I end the daem process in the SUSE Linux OS?

Answer

1 Login to the OS of the server as user root.

2 Open a terminal window and run the following command:
# /etc/init.d/u2kdaem stop

—End

A.3.12 How to Check Downloaded Software Packages by Using
MD5 Software

Question
How do I check downloaded software packages by using MD5 software?
Answer
1 Download the MD5_Code_ English file from http://support.huawei.com. The
MDS_Code_English file contains MDS5 code information after all software and document
packages are decompressed.
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Perform the following operations to obtain the MDS_Code_English file:
1. Access http://support.huawei.com.

2. Choose Software Center > Version Software > Network OSS&Service > iManager U2000 > iManager
U2000 > iManager U2000 > iManager U2000 V100R002 > iManager U2000 V100R002C01SPC002.

3. Download the MD5_Code_English file in the Release Document column.
2 Navigate to http://www.winmd5.com and download the WinMDS5.
3 Double-click WinMDS 1.2.exe to run the WinMD?5.

4 Drag the downloaded software package to the window for running the WinMD5. The WinMD5
automatically generates MD35 code information about the downloaded software package and
then compares the information with the counterpart in the MDS_Code_English file.

® The downloaded software package is correct if the information about the software package
is consistent with the counterpart in the MD5_Code_English file.

® The software package must be re-downloaded if the information about the software package
is inconsistent with the counterpart in the MD5_Code_English file.

—End

A.3.13 How to Configure the Communication Mode for a Linux-
based U2000 Server?

Question

A Linux-based U2000 server has two communication modes: the normal mode and the security
socket layer (SSL) mode. How to configure these two modes?

Answer

1 Log in to the master server as user root and run the following commands to query the current
communication mode.

# cd /opt/U2000/server
# . svc_profile.sh
# ssl_adm -cmd query

(1 noTE

In the . sve_profile.sh command, there is a space between . and sve_profile.sh.

2 Run the following commands to stop the U2000:

# cd /opt/U2000/server/bin
# ./stopnms.sh

3 Run the following command to configure the master server communication mode.

# ssl_adm -cmd setmode mode parameter

A-22 Huawei Proprietary and Confidential Issue 05 (2010-11-19)
Copyright © Huawei Technologies Co., Ltd.


http://support.huawei.com
http://www.winmd5.com

iManager U2000 Unified Network Management System
Single-Server System Software Installation Guide (SUSE

Linux) A FAQs
(O noTe
In the preceding command, mode parameter can be normal, ssl, or both. The description of each value is
as follows:

® normal: Indicates that the U2000 server communicates with clients only in normal mode without
security assurance.

® ssl: Indicates that the U2000 server communicates with clients only in security mode. This mode ensures
the communication security.

® both: Indicates that both the normal and SSL modes are applicable to the U2000 server to communicate
with clients.

4 Run the following command to configure the slave server communication mode.

(1] noTE

® If there is no slave server, skip this step.
® [f there are multiple slave servers, perform this step on each slave server.

1. Log in to the slave server as user root and run the following commands to stop the daem
process.

# /etc/init.d/u2kdaem stop

2. Run the following command to configure the slave server communication mode.

# ssl_adm -cmd setmode mode parameter

1 noTE

In the preceding command, mode parameter can be normal, ssl, or both. The description of each
value is as follows:

® normal: Indicates that the U2000 server communicates with clients only in normal mode without
security assurance.

® ssl: Indicates that the U2000 server communicates with clients only in security mode. This mode
ensures the communication security.

® both: Indicates that both the normal and SSL modes are applicable to the U2000 server to
communicate with clients.

5 Restart the daem process.

(O noTe
® Ifthere is no slave server, skip this step.
® [fthere are multiple slave servers, perform this step on each slave server.

# /etc/init.d/u2kdaem start

6 Run the following command on the master server to start the U2000 process as user root.

# cd /opt/U2000/server/bin
# ./startnms.sh

——-End
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Uninstalling the U2000 Software

This topic describes how to uninstall the U2000 software. Uninstall the U2000 software prior
to reinstallation.

B.1 Uninstall Preparations
This topic describes the preparations for uninstalling the U2000 software.

B.2 Uninstalling the U2000
This topic describes how to uninstall the U2000 software.

B.3 Verifying the Uninstall Status of the Server Software
This topic describes how to verify that the U2000 server software is uninstalled.
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B.1 Uninstall Preparations

This topic describes the preparations for uninstalling the U2000 software.

Prerequisite
The Network Management System Maintenance Suite of the master server and slave server are
running.
(0 noTE
Run the following commands to start the Network Management System Maintenance Suite as user root.
# cd /opt/HWENGR/engineering
# ./startserver.sh
Procedure
1 Log out of all running U2000 clients.
2 Log in to the OS of the master server as user root.
3 Run the following commands to stop the U2000:
# cd /opt/U2000/server/bin
# ./stopnms.sh
4 Run the following commands to stop the Network Management System Maintenance Suite:
# cd /opt/HWENGR/engineering
# ./stopserver.sh
Run the following command to verify that the Network Management System Maintenance
Suite is not running;:
# ps -ef | grep java
root 19913 19907 0 04:04:09 pts/1 0:00 grep java
root 18382 18311 0 03:42:33 pts/2 12:20 /opt/HWNMSJRE/jre linux/bin/java -server -
Dequinox.conf=engineering/conf/installE
(0 noTE
Ifthe displayed information does not contain /opt/ HWNMSJRE/jre_linux/bin/java -server, the Network
Management System Maintenance Suite is stopped successfully.
5 Ensure that the database is running.
To check whether the Oracle database is running, run the following command:
> ps -ef | grep ora_
Information similar to the following is displayed:
oracle 4055 1 0 20:00 7 00:00:00 ora_j000_U2KDB
oracle 4174 4107 0 20:00 pts/1 00:00:00 grep ora_
oracle 23333 1 0 Novls 2 00:00:20 ora_pmon_ U2KDB
oracle 23335 1 0 Novls 2 00:00:00 ora_vktm U2KDB
oracle 23339 1 0 Novls 2 00:00:00 ora_diag U2KDB
oracle 23341 1 0 Novls 2 00:00:00 ora_dbrm U2KDB
oracle 23343 1 0 Novls 2 00:00:01 ora_pspO_U2KDB
oracle 23347 1 0 Novls 2 00:03:35 ora_dia0O_U2KDB
oracle 23349 1 0 Novls ? 00:00:00 ora mman_ U2KDB
oracle 23351 1 0 Novls 2 00:00:03 ora_dbwO_U2KDB
oracle 23353 1 0 Novls 2 00:00:13 ora_lgwr U2KDB
oracle 23355 1 0 Novls 2 00:00:15 ora_ckpt U2KDB
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oracle 23357 1 0 Novl5 ? 00:00:06 ora_smon_ U2KDB
(0 noTE
If the displayed information contains the following processes, the database service is started successfully:
® ora pmon U2KDB
® ora_dbw0 U2KDB
® ora lgwr U2KDB
® ora ckpt U2KDB
® ora smon U2KDB
To check whether the listener is started, run the following commands:
> su - oracle
password: password of oracle user
> lsnrctl status
> exit
Information similar to the following is displayed:
STATUS of the LISTENER
Alias LISTENER
Version TNSLSNR for Linux: Version 11.1.0.7.0 - Production
Start Date 17-DEC-2009 20:35:58
Uptime 0 days 0 hr. 5 min. 2 sec
Trace Level off
Security ON: Local OS Authentication
SNMP OFF
(0 noTE
If the displayed information contains Alias LISTENER, the listener is started successfully:
To start the Oracle database, run the following commands:
> su - oracle
password:password of oracle user
> sqlplus / as sysdba
SQL> startup
ORACLE instance started.
Total System Global Area 1610612736 bytes
Fixed Size 2046264 bytes
Variable Size 385877704 bytes
Database Buffers 1207959552 bytes
Redo Buffers 14729216 bytes
Database mounted.
Database opened.
To exit the SQL Server database, run the following command:
SQL> exit
To start the listener, run the following command:
> lsnrctl start
To log out as the Oracle user, run the following command:
> exit
Log in to the slave server as user root. Open a terminal window and run the following command
to stop the daem processes:
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# /etc/init.d/u2kdaem stop
(1] noTE

Perform this step on each slave server.

——-End

B.2 Uninstalling the U2000

Prerequisite

Context

Procedure

This topic describes how to uninstall the U2000 software.

Uninstall preparations have been completed.

In the single-server system (SUSE Linux-distributed), ensure that the following requirements
are met. Otherwise, the single-server system (SUSE Linux-distributed) cannot be uninstalled
successfully.

® The public network and the private network of the master server and slave server are
connected.

® The Network Management System Maintenance Suite of the master server is stopped.

The Network Management System Maintenance Suite of the slave server is started.

® The daem process of the slave server is ended.

® This operation uninstalls only the U2000. The Oracle database will not be uninstalled.

® Two modes are available to uninstall the U2000. One is the GUI mode and the other is the
CLI mode. The procedure for uninstalling the U2000 in GUI mode is described in the
following sections. Installation engineers are recommended to uninstall the U2000 through
the CLI if they cannot log in to the GUI of the OS.

Run the ./uninstall.sh -cmd command to uninstall the U2000 in the /opt/HWENGR path
through the CLI.

Log in to the GNOME session process of the master server OS as the root user.

Run the following command to go to the path where the uninstall.sh script is stored and run the
script:
# cd /opt/HWENGR

# ./uninstall.sh
The Confirm Uninstallation dialog box will be displayed.
Click Next. The Confirm dialog box is displayed.

Click Yes. A dialog box showing the progress of the uninstall will be displayed.
(I noTe

The duration of the uninstall depends on the quantity of installed components. Wait patiently.

After the uninstall is complete, the Uninstallation Complete dialog box is displayed.
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6 Click Finish.

7 Run the following command to delete the HWENGR directory:
# rm -rf /opt/HWENGR

—End

B.3 Verifying the Uninstall Status of the Server Software

This topic describes how to verify that the U2000 server software is uninstalled.

Procedure

1 Log in to the OS of the master server as user root.

2 Confirm that the installation path is correct during the uninstall.

® If the server is not mounted with disk arrays, the NMS installation path /opt/U2000 will be
deleted.

® Ifthe serveris mounted with disk arrays, the NMS installation path /opt/U2000 will be empty.
The installation paths /opt/HWENGR, /opt/HWICMR and /opt/ HWNMSJRE, are deleted.

3 Confirm the nmsuser user that must be deleted during the uninstall.

Run the following command to switch to user nmsuser:
# su - nmsuser

A message similar to the following will be displayed:

su: user nmsuser does not exist

—End
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Powering Off the Single-Server System
(SUSE Linux-Distributed)

This topic describes how to shut down the U2000 Single-Server System (SUSE Linux-
Distributed).

Context

® Always follow site-specific procedures for powering off the server to ensure that it is safely
shut down.

® The system may fail to recover if the halt command is used to shut down the server or if
the server is directly powered off.

Procedure

1 Exit all running U2000 clients.
2 Login to the OS of the master server as the root user.

3 Run the following commands to stop the U2000:

# cd /opt/U2000/server/bin
# ./stopnms.sh

4 Run the following commands to stop the Oracle process.

> su - oracle

> sqlplus / as sysdba
SQL> shutdown immediate
SQL> exit

> exit

5 Run the following commands to shut down the master server OS.

# sync;sync;sync;sync
# shutdown -h now

6 Run the following commands to shut down the slave server OS.

# sync;sync;sync;sync
# shutdown -h now

—--End
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D Getting Started

This topic describes certain common operations that can be performed on the SUSE Linux
workstation. After learning this topic, you can improve the efficiency of the operations in the

SUSE Linux OS.

Syntax Structure of Command Lines

The syntax structure of command lines is as follows:

command option parameter

The SUSE Linux commands are case-sensitive. That is, the OS considers an uppercase letter
and its corresponding lowercase letter two different letters. For example, when you want to use
the command for displaying the files in the certain directory, the OS can correctly run the Is
command, but it cannot run the Ls command because the Ls command is considered as an invalid
system command. The options in the SUSE Linux commands are used to change the command
execution method. Generally, the options start with the en-dash (-).

For example, run the following command to display the files and the related details in the /opt

directory:
1ls -al /opt

Directory Browsing and Control Commands

Command/Usage Example Description
cd directory cd /opt Switches to another directory.
Is option file directory Is -al /opt Displays the directory

contents or file information.

mkdir directory

mkdir install

Creates a directory.

pwd pwd Displays the current directory
of the user.
rm file name rm file.tar Deletes a file.
rmdir directory rmdir femp Deletes an empty directory.
fdisk option fdisk -/ Views the quantity of disks.
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Command/Usage

Example

Description

q

Exits the man query.

Logging In to the SUSE Linux OS Through Remote Login Software

There are many remote login software products, such as the PuTTY'. This topic takes the PuTTY
as an example. The PuTTY is used to log in to the server from a remote site through command

lines.

A CAUTION

Make sure that the remote login software is installed.

Double-click the shortcut icon of the PuTTY software on the desktop. The following dialog
box is displayed.

2 PuTTY Configuration x|

Category:
El- Sgssiun | Basic options for your PUTTY session |

— Specify the destination you wart to connect to
Host Mame (or IP address) Port
|22

= Teminal

- Keyboard
- Bell I
- Features Connection type:
= Window " Baw ( Telnet © Rlogin © SSH  Serial
- Appearance

- Behaviour
- Translation
- Selection
-+ Colours Default Settings
- Connection
- Data Save

- Prosy
- Telnet Delete

— Load. save or delete a stored session
Saved Sessions

0

- Rlogin
- 55H
- Serial

Close window on exit:
" Aways  Never * Onlyon clean et

About Cpen Cancel

The following table shows the login configurations.

Parameter Description

Host Name (or IP address) Specifies the IP address of the server to be
logged in to, for example, 10.71.225.89.

D-2

Huawei Proprietary and Confidential Issue 05 (2010-11-19)
Copyright © Huawei Technologies Co., Ltd.



iManager U2000 Unified Network Management System
Single-Server System Software Installation Guide (SUSE
Linux) D Getting Started

Parameter Description

Connection type Specifies the connection type. You need to
select a connection type as required.
Generally, select Telnet or SSH.

Saved Sessions This parameter cannot be set.

Close window on exit This parameter cannot be set. The default
value is Only on clean exit.

2. Set the parameters for logging in to the server. Then, click Open. The login dialog box is
displayed.
Enter the login user name, and then press Enter.

4.  Enter the login password, and then press Enter.

Accessing the CLI of the Windows OS

1. Choose Start > Run on the Windows OS desktop.
2. In the Run dialog box, enter cmd, and then click OK. The CLI is displayed.

Logging In to the SUSE Linux OS Through the Windows OS CLI

1. Inthe CLI, enter telnet IP address of the server to be logged in to, and then press
Enter.
Login:

2.  Enter the name of the user who logs in to the OS of the server, for example, root. Then,
press Enter.
Password:

3. Enter the login password of the user. Press Enter to log in to the OS. Generally, the default
login password of the root user is root.

Restarting the SUSE Linux OS

Run the following commands to restart the OS:
# sync;sync;sync;sync
# shutdown -r

When you restart the OS, the remote login user exits. It takes approximately 3 to 5 minutes to
restart the OS. After the OS is restarted, re-log in to the server by referring to the preceding login
method.
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E Manually Installing the SUSE Linux OS and
Its Patches

This topic describes how to manually install the OS by using the SUSE Linux installation DVD
delivered with the product.

E.1 Installing the SUSE Linux OS
This topic describes how to install the SUSE Linux OS.

E.2 Verifying the Installation and Configuration of the OS
This topic describes how to check the OS version, OS patch, the disk partitioning of the system
and the language environment variable of the system.
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E.1 Installing the SUSE Linux OS

This topic describes how to install the SUSE Linux OS.

Prerequisite

Context

Procedure

The MAC addresses of NICs through which blade servers are connected to the public
network must be collected.

- An ATAE blade server is connected to the public network through the base plane. For
details about how to view the MAC address of the base plane of an ATAE blade server,
see F.5 How to View the MAC Address of the Base Plane of an ATAE Blade
Server.

- An IBM blade server is connected to the public network through I/0 module 1 and I/O
module 2. The system IP address of the IBM blade server must be set on the external
communication NIC. For details about how to view the MAC address of the external
communication NIC of an IBM blade server, see F.3 How to View the MAC Address
of the External Communication NIC of an IBM Blade Server.

The installation CD-ROM must be available.

For the ATAE server, if the USB drive is connected to the ATAE server card, the indicator
of the USB drive is green and flashes.

During the installation, use the keyboard as follows:

® Press Tab to switch between buttons, option buttons, and check boxes.
® Press Enter to select a button.

® Press an arrow key to select a parameter.

®  Press the spacebar to select an option or a button.

(O noTE

The installation DVD-ROM of the OS is described in the following procedure.

Optional: In the case of the ATAE blade server, in BIOS, set the order for starting the OS so
that the OS boots from the CD-ROM.

(1 noTE

This step is applicable only to the ATAE blade server. In the case of other servers, skip this step.

1.
2.

Insert the installation disk to the USB drive.
Logging In to the Management Console of an ATAE Blade Server.

In the Blade > KVM panel, select the required board from Select Blade, and
click Cold Reset to restart the blade server.

On the toolbar of the Blade > KVM panel, click the icon of the card to be operated
to display the related tab page.
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2 Blade === K\M

‘ Select Blade ‘ |F‘Iease select... =] ‘ Cold Reset | ‘ Refresh Blade | ‘

RO BEEEHRRAARNERARES

blade9 |

FY
=

o= TIP

® To enter the full screen mode, click on the toolbar.

® To restore from the full screen mode to window, move the mouse to upper middle of the screen,

press Ctrl+Shift+Alt and click 7 in the upper portion of the screen.

In the process of restarting the blade server, when the American Megatrends window is
displayed, press Delete to display the BIOS SETUP UTILITY window.

American
Megatrends

Wow WA I, COmL

Amer ican

on Remote
. Done.

ds, Inc.

11-011909-BLAKFORD-UBSALOSS-Y 2KC

In the BIOS SETUP UTILITY window, use the left arrow and right arrow keys to choose
Boot from the main menu.

On the Boot Settings tab page, use the up arrow and down arrow keys to select Boot Device
Priority. Then, press Enter.
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BIOS SETUP UTILITY

» Boot Device Priority

6. In the Boot Device Priority pane, set the order for starting the OS of the blade server so
that the OS boots from the USB disk drive.

a. Select 1st Boot Device, and then press Enter. The Options dialog box is displayed.

b.  Use the up arrow and down arrow keys to select USB:HUAWEI VM CDROM. Then,
press Enter.

BIOS SETUP UTILITY

1st Boot Device [USB :HUAWET UM CDRO]

USB:HUAWEL UM CDROM

7. Press F10 after the previous settings, the confirm dialog box is displayed.
8. Click OK, and then press Enter to save the settings and exit.

2 Optional: In the case of the IBM HS22 blade server, in BIOS, set the order for starting the OS
so that the OS boots from the CD-ROM.
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m NOTE

This step is applicable only to the IBM HS22 blade server. In the case of other servers, skip this step.
1.  Mount the virtual media of the IBM blade server.

ﬂ;ﬂ NOTE

® The purpose of mounting the virtual media of the IBM blade server is to mount the CD/DVD
drive or ISO file of the PC where the Web console is installed to a blade server, thus implementing
remote installation of the OS of the blade server. Alternatively, the default CD/DVD drive of the
IBM BladeCenter E can be used to install the OS of the blade server.

® To use the default CD/DVD drive of the IBM BladeCenter E to install an OS on a blade server,
you need to insert the OS installation DVD into the default CD/DVD drive of the IBM
BladeCenter E and then press MT at the middle of the blade server, If the MT indicator is on, it
indicates that the blade server is connected to the default CD/DVD drive.

. . Hone v .
2. Inthe remote console window, click . Then, select the required

card.
3. Inthe Power Control area, select Restart to restart the blade server.

4. Inthe process of restarting the blade server, when the System x window is displayed, press
F1 and the System Configuration and Boot Management window is displayed.

IBM System x.

Server Firmware

Licensed Materials - Property of |BM Caorp. Firmware contains licensed third party modules.
Systemn x Server Firmware & Copyright IBM Corporation 200% ALL RIGHTS RESERVED.
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System Configuration and Boot Management

System Information This selection will

System Settings allow you to change

Date and Tine boot parameters and
boot from file.

Start Options

Sustem Event Logs
User Security

Save Settings

Restore Settings

Load Default Settings
Exit Setup

tl=Move Highlight <Enter>=Select Entry <ESC>=Exit Setup

5. Press an arrow key to choose Boot Manager from the main menu. Press Enter.

Boot Mamager

Primary Boot Sequence Will be valid on next
Add Boot Option hoot .
Delete Boot Option

Secondary (WOL) Boot Sequence
Add WOL Boot Optiom

Delete WOL Boot Option

Change WOL Boot Order

Boot From File
Select Mext One-Time Boot

Reset Systen

tl=Hove Highlight <Enter>=Select Entru

6. Press an arrow key to choose Change Boot Order from the Boot Manager. Press
Enter.
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Change Boot Order

Change the order Change the order

Commit Changes

T1=Move Highlight <Enter>=Select Entry Esc=Exit

7.  Press an arrow key to choose CD/DVD Rom from the Change Boot Order. Press
Enter.

8. Choose Save Settings from the main menu. Press Enter twice to save the settings.
9. Choose Exit Setup and press Enter twice to exit BIOS setting.
3 Optional: In the case of the IBM HS21 blade server, in BIOS, set the order for starting the OS
so that the OS boots from the CD-ROM.
(1] noTE

This step is applicable only to the IBM HS21 blade server. In the case of other servers, skip this step.
1.  Mount the virtual media of the IBM blade server.
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® The purpose of mounting the virtual media of the IBM blade server is to mount the CD/DVD
drive or ISO file of the PC where the Web console is installed to a blade server, thus implementing
remote installation of the OS of the blade server. Alternatively, the default CD/DVD drive of the
IBM BladeCenter E can be used to install the OS of the blade server.

® To use the default CD/DVD drive of the IBM BladeCenter E to install an OS on a blade server,
you need to insert the OS installation DVD into the default CD/DVD drive of the IBM
BladeCenter E and then press CD at the top of the blade server, as shown in the following figure.
If the CD indicator is on, it indicates that the blade server is connected to the default CD/DVD

drive.

. . Hone v .
2. Inthe remote console window, click . Then, select the required

card.
In the Power Control arca, select Restart to restart the blade server.

4. Inthe process of restarting the blade server, when the System x window is displayed, press
F1 and the Configuration/Setup Utility window is displayed.
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IBH BIDS - (c) Copyright IBM Corporation 2869
Synmetric Hultiprocessing System

Intel(R) Xeon(R) CPU L5428 @ 2.58GHz

2 Processor Packages Installed

16384 MB Installed Hemory

Press Fl1 for ConfigurationsSetup
Press F2 for Diagnostics
Press F12 for Boot Device Selection Henu

>> BIOS Version 1.16 <<

Configuration/Setup Utility

= Systen Summary

= Systen Information

= Devices and 10 Ports
= Date and Tine

= Systen Security

= Start Options

= Advanced Setup

Save Settings
Restore Settings
Load Default Settings

Exit Setup

<F1> Help {13<1> Move
{Esc> Exit {Enter} Select

5. Press an arrow key to choose Start Options > Startup Sequence Options from the main
menu. Press Enter.

6. In the Startup Sequence Options window, do as follows:
® Set First Startup Device to CD ROM.
® Set Second Startup Device to Diskette Drive 0.
® Sect Third Startup Device to Hard Disk 0.
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Start Options
Startup Sequence Options

Primary Startup Seque

First Startup De [ ]
Plan ) o [ Diskette Drive B 1
Run ) [ Hard Disk 8 ]
Run Fourth Startup D o [ Hetwork 1

Hake On LAN

Hake on Lan Startup Sequence:

[ Network 1
[ Diskette Drive 8 1

; [ CD ROM 1
USh Fourth Startup D e [ Hard Disk B ]
Boot

<{F1> Help {13¢4> Hove ¢+> Next Value ({F9» Restore
<{Esc» Exit {+>» Pravious Value <F18> Default S

After you complete the settings, press Esc twice to return to the main menu.
7. Choose Save Settings from the main menu. Press Enter twice to save the settings.

8. Choose Exit Setup and press Enter twice to exit BIOS setting.
4 The system restarts automatically.
5 Select an installation mode.

In the SUSE Linux Enterprise Server window, press the arrow key to select Installation. Then,
press Enter to load the SUSE Linux kernel.

(1 noTE

It takes approximately five minutes to complete the loading of the SUSE Linux kernel.

6 Select the setup language, time zone, and installation mode.

1. Inthe Language dialog box, select English (US) and click Next.
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2.

Preparation

= Language

® license Agreement
® System Analysis

* Time Zone

Installation
* Installation Surnmary
® Perform Installation

Configuration

Help

BES5 Language

* Root Password
* Hostname
* Network
* Customer Center
# Online Update
® Service —
* Users Eesti =
® Clean Up English (UK)
* Release Notes
#® Hardware Configuration Espafiol
Frangais
ERAnuLKd
el
Tt
Hrvatski
Italianc
Ay )
BsE =

Abort

Next

In the License Agreement dialog box, select Yes, I Agree to the License Agreement and

click Next.

Preparation

+ Language

= License Agreement
® System Analysis

® Time Zone

License Agreement

Installation
® [nstallation Summary Language
® Perform Installation English -

Configuration
Root Password
Hostname
Network
Customer Center
Cnline Update

Release Notes
Hardware Configuration

Help

SUSE(r) LINUX Enterprise Server (SLES) 10 Novell(r) Software
License Agreement

PLEASE READ THIS AGREEMENT CAREFULLY. BY INSTALLING OR OTHERWISE
USING THE SOFTWARE (INCLUDING ITS COMPONENTS], YOU AGREE TO THE
TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE WITH THESE TERMS,

Service DO NOT DOWNLOAD, INSTALL OR USE THE SOFTWARE AND, IF APPLICABLE,
Users RETURN THE ENTIRE UNUSED PACKAGE TO THE RESELLER WITH YOUR
Clean Up RECEIPT FOR A REFUND. THE SOFTWARE MAY NOT BE SOLD, TRANSFERRED,

OR FURTHER DISTRIBUTED WITHOUT PRIOR WRITTEN AUTHORIZATION FROM
NOVELL

RIGHTS AND LICENSES

This Novell Software License Agreement ("Agreement"} is a legal
agreement between You (an entity or a person) and Novell,
Inc. ("Nowvell") with respect to the software product identified

in the title of this Agreement, media (if any} and accompanying
documentation (collectively the "Software")

The Software is a collective work of Novell. You may make and
use unlimited copies of the Software for Your distribution and
use within Your Organization. The term "Organization" means a
legal entity, excluding subsidiaries and affiliates with a

separate existence for tax purposes or for legal personality
purposes. An example of an Organization in the private secter

® Yes, | Agree to the License Agreement
No. | Do Not Agree

Back Abort

3. In the Installation Mode dialog box, select New Installation and click N
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4.

Preparation

¥ Language

¥ License Agreement
= System Analysis

* Time Zone

Installation
® [nstallation Summary
* Perform Installation

Configuration
® Root Password
* Hostname

* letwork

* Customer Center

® Online Update

* Service

& Users

® Clean Up

® Release Notes

* Hardware Configuration

Help

a Installation Mode

Select Mode
® New |nstallation

Include Add-On Products frem Separate Media

Back Abort CHext

In the Clock and Time Zone dialog box, set parameters by referring to the following table
and click Next.

(1 noTE

The proceeding settings are provided for reference only. During the on-site installation process, set
the parameters based on the actual situation.

Parameter Setting
Region Asia
Time Zone China

Hardware Clock Set | Local Time

to

Time and Date Set this parameter to the correct current time.
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R P e Eian 3 Clock and Time Zone
¥ Language
¥ License Agreement
¥ System Analysis Region Time Zone
o> e 2o Europe Afghanistan (=]
Installation UsA Anadyr
® [nstallation Summary Canada Baghdad
® Perform Installation Central and South America Bahrain
Configuration BArEST Bl ke
R e
® Hostname Australia Blshkgk
® Network Africa Brunei
® Customer Center Pacific Calcutta
“ Crine Upe Gicbal
® Service Etc Colombo
® Users Damascus
® Clean Up Dhaka
® Release Notes Dubai
® Hardware Configuration Gaza
Hongkeng
Irkutsk
Israel
Jakarta =
Japan
Kamchatka
Katmandu
Korea
Krasnoyarsk
Kuala Lumpur
Kuwai
Macao
Magadan
Manila
Mideast Riyadha?
Mideast Riyadhas E
Hardware Clock Set To Uit 1) i
[igeal Time _\v] [l 21:56:37 - 2009-03-11 Change ]
— [t )

7 Perform the installation settings.

1. Set the type of keyboard layout.

a. In the Installation Settings dialog box, select Keyboard Configuration, and press
Enter.

(1 noTE

If the installed server is not configured with a mouse, you can use the keyboard to perform the
installation as follows:

® Press Tab to switch between buttons, option buttons, and check boxes.
® Press Enter to select a button.

® Press an arrow key to select a parameter.

® Press the spacebar to select an option or a button.

b.  Select English (US) and press Enter.
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Keyboard
Configuration

Choose the Keyboard
Layout to use for
installation and in the
installed system. Test the
layout in Test. For
advanced options, such as
repeat rate and delay,
select Expert Settings

If unsure, use the default
values already selected

Keyboard Configuration

Keyboard Layout

Dvorak

English (UK)

Estonian

Finnish

French

French (Canada)
French (Switzerland)
German

German (Switzerland)
German (with deadkeys)
Greek

Hungarian

Icelandic

Italian

Japanese

Khmer

Lithuanian

MNorwegian

Paolish

Portuguese
Portuguese (Brazil)
Paortuguese (Brazil -- US accents)
Russian

Serbian

Slovak

Slovak (qwerty)
Slovene

Test

Expert Settings.

Cancel

2. Set the size of a partition.

a. In the Installation Settings dialog box, select Partitioning and press Enter.

Suggested Partitioning dialog box is displayed.

Preparation

v Language

¥ License Agreement
¥ System Analysis

¥ Time Zone

Installation
= Installation Summary
® Perform Installation

Configuration

® Root Password
Hostname
Hetwork
Custemer Center
Cnline Update
Service

Users

Clean Up
Release Notes
Hardware Configuration

Show Release Motes

Help

Accept

The

a Installation Settings

Click any headline to make changes or use the "Change..." menu below

Overview | Expert

Keyboard Layout
= English (US)
Partitioning
* Create swap partition /dev/sdbl (2.0 GB)
* Create root partition /dev/sdb2 (134.7 GB) with reiserfs

* Set mount point of /dev/sdal to /windows/C
* Set mount point of /dev/sda3 to /windows/D

Software

* SUSE Linux Enterprise Server 10 5P1

* + Server Base System

* + GNOME Desktop Environment for Server
* + Novell AppArmor

* + Print Server

* + 32Bit Runtime Environment

* + X Window System

* Size of Packages to Install: 1.6 GB

Language

* Primary Language: English (US})

Change... =

Back Abort

Accept

b. In the Suggested Partitioning dialog box , select the Create Custom Partition
Setup option button and press Enter.
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Your hard disks have been Suggested Partitioning
checked. The partition
setup displayed is
preposed for your hard

* Create swap partition /dew/sdbl (2.0 GB}

drive. * Create root partition /dev/sdb2 (134.7 GB) with reiserfs
To accept these * Set mount point of /dew/sdal to fwindows/C
suggestions and continue. * Set mount point of /dew/sda5 to fwindows/D

select Accept Proposal.

If you want to do only small
adjustments to the
propesed setup (like e.g.
changing filesystem types)
choose Base Partition
Setup on This Proposal
and do these modification
in expert partioner dialog.

If the suggestion does not
fit your needs, create your
own partition setup starting
with the partitions as
currently present on the
disks. For this, select Partitioning
Create Custom Partition Accept Proposal
Setup. This is also the -
option to choose for Bagse Partition Setup on This Proposal
etz appiiois i RAD ® Create Custom Partition Setup
and encryption

Create LVM Based Proposal
To create a LVM based
propoesal choose the
corresponding button.

Back Abort et

c. Inthe Preparing Hard Disk: Step1 dialog box , select the Custom Partitioning (for
experts) option button and press Enter.

All hard disks automatically Preparing Hard Disk: Step 1
detected on your system
are shown here. Select the
hard disk on which to install
SUSE_SLES_SP1

You may select later which
part of the disk is used for
SUSE_SLES_SPL

The Custom Partitioning
option for experts allows
full control over partitioning
the hard disks and
assigning partitions to
mount points when
installing SUSE_SLES_SP1.

Hard Disk

1. 1.5CSl, 136.7 GB, /dev/sda, SEAGATE-ST914680255
@ Custom Partitioning (for experts)

Back Abort i Hext |

d. Inthe Expert Partitioner dialog box, select the /dev/sdal equipment and click
Delete. Then, delete the /dev/sda2 equipment in the same manner.
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Partition your hard 2 Expert Partitioner

disks.

This is intended for

experts. If you are not Device Size F | Type Mount | Mount By | Start |End | Used By | Label |Device ID
familiar with the i/dev/sda 1359 GB LSILOGIC-Logical Volume 0 17749 5CsI-3600508
caoncepts of hard disk Jdev/sdal 20GB  F Linux swap swap | o 261 sCsi-3600508
partitions and how to /dev/sda2  133.9GB  F Linux native (Reiser)  / | 262 17749 sCsi-3600508

use them, you might
want to go back and
select automatic
partitioning.

Please note that
nothing will be
written to your hard
disk until you confirm
the entire installation in
the last installation
dialeg. Until that point,
you can safely abort the
installation

For LVM setup, using a
non-LvM root device and
anon-LvM swap device
is recommended. Other
than the root and swap
devices, you should
have partitions managed
by LWM

The table to the right
shows the current
partitions on all your
hard disks

Hard disks are
designated like this

fdev/hda 1st EIDE 1 4
disk /dev/hdb 2nd EIDE - -
disk /dev/hdc 3rd EIDE Create Edit Delete Resize
disk
= Lvm EVMS. RAID.. = Crypt File... = Expert. =
atr d
Back Abort Finish

e. Inthe Expert Partitioner dialog box, click Create.

Partition your hard B Expert Partitioner
isks...
This is intended for -
experts. If you are not Device Size F | Type Mount | Mount By | Start |End | Used By | Label |Device ID
familiar with the dev/sda 135.9 GB LSILOGIC-Logical Volume 0 17749 5C51-3600508

concepts of hard disk
partitions and how to
use them, you might
want to go back and
select automatic
partitioning.

Flease note that
nothing will be
written to your hard
disk until you confirm
the entire installation in
the last installation
dialog. Until that point,
you can safely abort the
installation

For LVM setup, using a
non-LvM root device and
a non-LvM swap device
is recommended. Other
than the root and swap
devices. you should
have partitions managed
by LVM.

The table to the right
shows the current
partitions on all your
hard disks.

Hard disks are
designated like this

fdev/hda 1st EIDE Bl ar
disk sdev/hdb 2nd EIDE
disk /dev/hdc 3rd EIDE Create Edit Delete Resize
disk
- LM EWMS RAID... ~ Crypt File = Expert. ~
atr hd
Back Abort Einish

f.  In the Partition Type dialog box, select the Primary Partition option button and
click OK.
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Partition Type

® Primary Partition
Extended Partition

Cancel

In the Create a Primary Partition on /dev/sda dialog box, set the following
parameters. The parameters are described as follows:

1) Select the Format option button.
2) Set File system to Ext3.
3) In the text box below End:(9 or +9M or +3.2GB), enter 30 GB or +30 GB to
set the size of a partition.
4) Set Mount Point to /.
5) Press Enter or click OK.
Parameter Description

Do not format

This parameter indicates that the hard
disk is not to be formatted. Do not select
this value at the first installation.

Format

This parameter indicates that the hard
disk is to be formatted. Select this value
at the first installation.

File system

This parameter indicates the format of
the file system. For details of settings,
refer to the "Partition Type" column in
H Planning Disk Partitions.

start cylinder

This parameter indicates the start
volume address of the current partition.
When this parameter is created, it
automatically uses the end volume
address of the last partition. In this case,
you need not set this parameter.

End:(9 or +9M or +3.2GB)

This parameter indicates the end volume
address of the current partition. Set this
parameter according to the partition size
in H Planning Disk Partitions.
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First, choose the type |« Edit Partition /dev/sdal
of the partition and
whether this partition Format Size

should be formatted. Cylinder size: 7.84 M

Then, enter the mount Do not format _

point Start cylinder:

[ /. /boot, fusr, fvar, 0

etc )

Now, enter the ® Format End: (9 or +9M or +3.2GB)
Ioca_tilon of the new File system |+3IZIGEI |
partition on your hard

disk. Ext3 -

Please enter the Options Fstab Options

starting cylinder

number of the Encrypt file system Mount Point
partition. :

After that, either

specify an ending -

cylinder number or an |« QK Cancel

(1 noTE

If the information about the partitions exception the /dev/sda partition is not required, select
Delete to delete the information, or press Alt+D to delete the old partition information.

Refer to 7.2.e to 7.2.g to create the swap, /usr, /var, and /opt partitions.

The follow dialog box shows after the previous settings. In the Expert Partitioner
dialog box, click Finish to continue.

Partition your hard = Expert Partitioner
disks

This is intended for
experts. IF you are not Device Size F | Type Mount | Mount By | Start |End |Used By | Label | Device ID
familiar with the Jdevsda 1367 GB SEAGATE-ST9146B0255 017848 5c5i-35000¢5000eb3]
concepts of hard disk Jdev/sdal 30.0GB  F Linux native (Ext3) ! | 0 3263 5csi-35000¢5000ebz
partitions and how to /dewisda2 160 GB  F Linux swap swap | 3264 5352 sCsi-35000c5000ebZ
I3 L, 3710 6 /devfsda3 957 GB Extended 5353 17848 5csi-35000¢5000eb3
Wa‘““t" b bathF”d /dev/sdaS 150 GB  F Linux native (Ext3) Jusr 1 5353 7311 scsi-35000¢5000eb2
partionng (devfsdab  20.0GB  FLinux native (Ext3)  fvar | 7312 9270 scsi-35000¢5000ebz
fdev/sda? 60.0 GB F Linux native (Ext3) Jopt I 9271 15798 5c5i-35000¢5000ebz|
Please note that
nothing will be
written to your hard
disk until you confirm
the entire installation in
the last installation
dialog. Until that point,
you can safely abort the
installation.

For LVM setup, using a
non-LVM root device and
a non-LvM swap device
is recommended. Other
than the root and swap
devices, you should
have partitions managed
by LI

The table to the right
shows the current
partitions on all your
hard disks

Hard disks are
designated like this

/dev/hda 1st EIDE 4 4r
disk /dev/hdb 2Znd EIDE
disk /dev/hdc 3rd EIDE Create Edit Delete Resize
disk

LM EVMS.. RAID... « Crypt File... = Expert. +

atr

Back Abort Finish

3. Set the software to be installed.

a.

In the Installation Settings dialog box, select Software and the Software Selection
and System Tasks dialog box is displayed.

As shown in the following figure, select the Server Base System, Common Code
Base, Novell AppArmor, High Availability, 32 Bit Runtime Environment,

E-18

Huawei Proprietary and Confidential Issue 05 (2010-11-19)
Copyright © Huawei Technologies Co., Ltd.



iManager U2000 Unified Network Management System
Single-Server System Software Installation Guide (SUSE

Linux)

E Manually Installing the SUSE Linux OS and Its Patches

GNOME Desktop Environment for Server, X Window System, File Server, and
Print Server parameters, and then click Details.

This dialog allows you to
define this systerm's tasks
and what software to install
Available tasks and
software for this system
are shown by category in
the left column. To view a
description for an item,
selectitin the list

Change the status of an
item by clicking its status
icon or right-click any icon
for a context menu. With
the context menu, you can
also change the status of
all items.

Details opens the detailed
software package selection
where you can view and
select individual software
packages.

The disk usage display in
the lower right corner
shows the remaining disk
space after all requested
changes will have been
performed. Hard disk
partitions that are full or
nearly full can degrade
system performance and in
SOme cases even cause
serious problems. The
system needs some
available disk space to run
properly.

a Software Selection and System Tasks

- Base Technologies

t4 Server Base System

&4 Commeon Code Base

b Novell AppArmor

v 32Bit Runtime Environment

[] Documentation

= Graphical Environments
1A GMOME Desktop Environment for Server
[] KDE Desktep Environment for Server
oA X Window System

= Primary Functions

&4 File Server

p&A Print Server

[] Mail and News Server

[] web and LAMP Server

[ Internet Gateway

[] DHCP and DNS Server

[] Directory Server (LDAP)

[[] s4P Application Server Base

[] oracle Server Base

[] xen virtual Machine Host Server

[] Web-Based Enterprise Management
- Development

[] C/C++ Compiler and Tools

N
u
!
o
Details. T

High Availability

ame |Disk Usage Used

Free

s 6% 10193 MB 140 GB
0% 137.9MB 249GB
pt  [______10% 292.8MB 49.7 GB

2000 C———J0%

0B 157 GB

Provide tools to ensure a high degree of operational continuity and reduce
the downtimes of your system

Total

150 GB
250 GB
50.0 GB
157 GB

Cancel

Accept

Select Search from the Filter drop-down list, enter sysstat in the Search text box, and
then click Search.

File Package Extras Help

Filter:  Search

Search:

sysstat

Search in

X Name

%/ Summary
Description
RPM "Provides"
RPM "Reguires”

Search Mode:

Contains

Case Sensitive

S Package | Summary
Sar and lostat Commands for Linux 412.9 K 6.0.2-16.19

sysstat

Search

Description

sysstat - Sar and

Name Disk Usage Used Free Total

] 6% L13GB 187GB 20.0GB

boot/efi % 0B 512.7 MB 5127 MB

exporthome [ ]0% OB 180GB 18.0GB

opt [ 0% 3435MB 79.7GB 80.0GB Check Autoch

Technical Data

Dependencies

lostat Commands for Linux

eck

Size

Versions

Version

Source

sar and lostat commands for Linux. The sar command collects and reports system activity
information. The iostat command reports CPU statistics and I/O statistics for TTY devices and
disks. The infoermation collected by sar and iostat can be saved in a binary file for future
inspection. Both commands now support SMP machines when displaying CPU utilization.

Accept

The names of required software packages are displayed in the right-hand pane of the
dialog box. Press Tab and spacebar or use the mouse to select sysstat.

Refer to 7.3.c to 7.3.d to install other software. The following lists the software that
needs to be installed.

1) sysstat
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2)
3)
4)
5)
6)
7)
8)
9)
10)
11)
12)
13)
14)
15)
16)
17)
18)
19)
20)
21)
22)

Click Accept and the YaST2 dialog box is displayed.

iptraf

Itrace

binutils
compat-libstdc++
expect

gce

gee-ct++

glibc

glibc-32bit
glibc-devel
glibc-devel-32bit
libaio
libaio-32bit
libaio-devel
libelf

libgce

libstde++
libstdc++-devel
make
unixODBC
unixODBC-devel
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We recommend that you
reference.

if you are acquiring Font

and conditions.
You hereby agree to the

1. You are bound by

agfa-fonts - Professional TrueType Fonts

AGFA MONOTYPE CORPORATION END USER LICENSE AGREEMENT

This Agfa Monotype Corporation End User Agreement (the "Agreement")
becomes a binding contract between you and Agfa Monotype Corporation
(@) when you click on the area marked "ACCEPT LICENSE AGREEMENT", or, (k)

package in which the font is contained. If you do not wish to be bound by
the Agreement, you cannot access, use or download the Font Software.
Flease read all of the Agreement before you agree to be bound by its terms

(as defined herein) of the Font Software (as defined herein) supplied
to you by AMT is governed by the Agreement.

2. "AMT" as used herein shall mean collectively Agfa Monotype
Corporation, its successors and assigns, its parent and affiliated
corperations, its authorized distributors, and any third party that has

print this End User Agreement for further

Software on a floppy disk, when you open the

following:

the Agreement and you acknowledge that all Use

:

Cancel

.
g. Click Accept and the Change Packages dialog box is displayed.
Changed Packages
Automatic Changes
@ In addition to your manual selections, the following packages have been changed to
resolve dependencies:
| | Fackage Summary E
Mf azZps Converts ASCIl Text inte PostScript
p 2alib An ASCI Art Library
b aalib-32bit An ASCI Art Library
pa audicfile An Audio File Library
b audiofile-32hbit An Audio File Library
pa boost Boost C++ Libraries
ps cifs-mount mount using the Common Internet File System (CIFS)
pa dbus-1-mono Mono Bindings for D-BUS
b+ esound A Sound Daemen for Enlightenment and GNOME
b esound-32bit A Sound Daemon for Enlightenment and GNOME
b flac Free Lossless Audio Codec
pos flac-32bit Free Lossless Audio Codec
b gd A Drawing Library for Programs That Use PNG and |PEG Output
¥a? gnuplot Function Plotting Utility
b/ ipvsadm A Utility for Administering the Linux Virtual Server
b iso-codes IS0 Code Lists and Translations
b libelf An ELF Ohject File Access Library @
(] | D]
)
h.  Click Continue.
4.  Set the setup language of the OS.
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In the Installation Settings dialog box, click Language.

In the Language dialog box, set Primary Language to English (US) and click

Details.

In the Language Details dialog box, set Local Settings for User root to Yes, clear
the Use UTF-8 Encoding check box, and then set Detailed Locale Setting to

en_US.

Here, fine-tune settings for the
language handling. These
settings are written into the

file fetc/sysconfig/language. If
unsure, use the default values
already selected.

Locale Settings for User root
determines how the locale
variables [LC_*) are set for the
root user.

ctype Only: root has the same
LC CTYPE as a normal user. Other
values are unset

Yes: root has the same locale
settings as normal user.

Mo: root has all locale variables
unset.

Use Detailed Locale Setting
to set a locale for the primary
language that is not offered in the
list in the main dialog. Translation

—mnn com he coesfln Mo Booaba

2]

:

Language Details

Locale Settings for User root
[Yes |vl

| | Use UTF-8 Encoding

Detailed Locale Setting
[en_US |v]

Cancel

Click OK to return to the Languages window.

Click OK .

8 Confirm the installation.

In the Installation Settings dialog box, click Accept.

In the Confirm Installation dialog box, click Install.
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Preparation

¥ Language

¥ License Agreement
¥ System Analysis

¥ Time Zone

a Installation Settings

Click any headline to make changes or use the "Change..." menu below.
. Overview Expert

Installation

= Installation Summary
* Perform Installation

Keyboard Lavout

Configuration
Root Password
Hostname
Network
Customer Center Confirm Installation
Online Update
Service

Users All information required for the base installation is now complete
g::gslipr-.lotes If you continue now, partitions on your hard disk will be formatted (erasing any

Hardware Configuration z:(alls;gg data in those partitions} according to the installation settings in the previous

Go back and check the settings if you are unsure.

E
Back
Language
Show Release Notes
Change... =
Help Back Abort

Accept

The OS is being installed formally. The installation progress is displayed on the setup program
window. It takes approximately 50 minutes to complete the installation.

9 Set the password of user root.

In the Password for the System Administrator "root" window, enter and confirm the
password of user root, and click Next.

(1 noTE

® The default password of the super user root of the SUSE Linux OS is roet. You can change the
password. The password is often required in the subsequent installation procedure.

® [famessage is displayed indicating that the password is too simple, click Yes to continue as prompted.
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Z’Bp:a'::::ge &b Password for the System Administrator "root"

' License Agreement
¥ System Analysis
¥ TimeZone

Installation
« Installation Summary
& Perform Installation

Configuraiion

= Root Password
® Hostname

& Network

#® Customer Center

* Online Updale

* Senvice

& LUsers

® Clean Up

#* Release Noles

® Hardware Configuration

Help

Do not forget what you enter here.

Password for root User

Confirm Password

e

Abort Next

10 Set the host name and domain name.

In the Hostname and Domain Name dialog box, do as follows:

® Sect the host name to Masterserver.
® (lear the Change Hostname via DHCP check box.
® Sclect the Write Hostname to /etc/hosts check box.

Click Next.
(1] noTE

Use the default value in the Domain Name field.
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Preparation

4
L
L
v

Language

License Agreement
System Analysis
Time Zone

Installation

'
L

Installation Summary
Perform Installation

Configuration
¥ Root Password

* s 0 000 0 s}

Hosiname

Network

GCustomer Genter
©Cnline Update

Service

Users

Clean Up

Release Notes
Hardware Configuration

Help

B, Hostname and Domain Name

Hostname and Domain Name
Hostname Domain Name
Masterserver site

Change Hostname via DHCP

r\te“}:i.;::s.‘tname 1o fetchosts

Back Abort

11 Configure the network.
L.

2.

Next

Inthe Network Configuration dialog box, select the Use Following Configuration option

button.

Click enabled next to Firewall, and change enabled to disabled.

Preparafion

¥ Language

¥ License Agreement
¥ Syslem Analysis
¥ TimeZone

Installation

¥ Installation Summary

¥ Perform Installation

Configuration

Root Passwerd
Hosina
Network

e

Gustomer Genter
Online Update
Service

Users

GClean Up
Release Notes

CRCRCRCRC RO By

Help

Hardware Configuration

% Network Configuration

Skip Configuration

® Use Following Cenfiguration

Network Mode
# Traditional Method without the NetworkManager Applet (Enable Networkidanager)
Firewall

Firewall is enabied
SS5H port is blocked

IPvé

* Enabled Support for IPvB Protocol (Disable [FvE)

Network Interfaces

* Intel B2571EB Gigabit Ethernst Controller
Gonfigured with DHGP
+ Intel PRO/000 EB Backplane Gonnection with V0 Acceleration
Not configured yet
* Intel PRO¥1000 EB Backplane Gennection with 0 Acceleration
Not configured yet
* Broadcom Netxireme EGMS5715 Gigabit Ethernet
Not configured yet
* Broadcom Netxireme BGM5715 Gigabit Ethernet
Net configured yet
* Broadcom NetXireme EGM5715 Gigabit Ethemet
Net configured yet
* Broadcom Netxtreme EGM5715 Gigabit Ethemet
Net configured yet

DSL Connections

Change.. =

Back Abort

Next
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3. Inthe Network Configuration dialog box, select Network Interface. In the Network
Card Configuration Overview dialog box that is displayed, select the network adapter
that provides the external communication function and click Edit.

(1 noTE

® The NIC corresponding to the system IP address must be the NIC through which the blade server
is connected to the public network.

® An ATAE blade server is connected to the public network through the base plane. For details
about how to view the MAC address of the base plane of an ATAE blade server, see F.5 How
to View the MAC Address of the Base Plane of an ATAE Blade Server.

® AnIBM blade server is connected to the public network through I/O module 1 and I/O module
2. The system IP address of the IBM blade server must be set on the external communication
NIC. For details about how to view the MAC address of the external communication NIC of
an IBM blade server, see F.3 How to View the MAC Address of the External
Communication NIC of an IBM Blade Server.

® You can view the MAC address of an NIC on the Address tab page of the Network Address
Setup dialog box.

4. Inthe Network Address Setup dialog box, select the Static Address Setup option button.
Enter 129.9.1.1 in the IP Address field, and enter 255.255.255.0 in the Subnet Mask field.
Click Routing.

You can select none address 2., Network Address Setup
setup if you don't want any IP
address.

General | Addrsss
You can selzct dynamic

address assignment if you
have a DHCP server running
on your local network,

Also select this if you do not
have a static IP address
assigned by the system
administrater or your cable or

DSL provider. Device Type Configuration Name
Ethernet || |id-001BB2Sacdbe |T

Netwerk addresses arethen : acibe

obtainad automatically from Nong Address Setup

the server. Automatic Address Setup (via DHGP)

Ctherwise, network addresses QY Bl A B

must be assigned manually

1P Address
Enterthe P address (2.9.,

192.168.100.99) for your 128911
computer, the network mask
(usually 255 255.255.0), and,
optionally, thedsfaull gateway 255,255,255 0

IP address. Detailed Seftings

Subnet Mask

Clicking Nex! completes the Hostname and Name Server
configuration —

Routin,
Contact your network S

adminisirater for more
information about the network

Advanced... -

configuration

Back Abort Next

5. Inthe Routing Configuration dialog box, enter 129.9.1.254 in the Default Gateway field
and click OK.
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The routing can be set upin #, Routing Configuration
thisdialeg. The Defaull
Galeway matches svery
possible destination, but
poerly, If any other entry exists
that matches the requirsd
address, itis used instead of
the default route. The idea of
the default route is simply to
enable you to say "and
everything else should go
here"

Default Gateway

Enable IP Forwarding if the 129.9.1.254|
system is a router

Routing Table
Expert Configuration

Enable IP Forwarding

Back Abort oK

6. Inthe Network Address Setup dialog box, click Next.

7. Inthe Network Card Configuration Overview dialog box, click Next.
(O note

If you want to configure multiple network adapters, follow Steps 3 to 6 to configure other network
adapters.

In the Network Configuration dialog box, click Next.

9. In the Test Internet Connection dialog box, select the No, Skip This Test option button
and click Next.

Preparation
¥ Language

% Test Internet Connection

¥ License Agreement
¥ System Analysis
¥ TimeZone

Insiallation
v Installation Summary
+ Perform Installation

Configuration

¥ Root Password
¥ Hostname Tovalidate your Internet access,
¥ Network activate the test procadure
¥ Gustomer Center
= Online Updats . .
- The following steps will be performed:
* Senvice
® Users
& CleanUp - Download latest release notes
0 RelkEepiishs - Check for latest updates
® Hardware Gonfiguration

Select:

Yes, Test Gonnection tothe Intemet
via Broadcom NetXireme BEMS715 ... - network card (129.8.1.1)

Changs Devics

®) No, Skip This Test

Help Back Abort {Next
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12 Configure a service.

In the Installation Settings dialog box, use all the default values, and click Next.

Preparation

¥ Language

¥ License Agreement
¥ System Analysis
¥ TimeZone
Installation

¥ Installation Summary
¥ Perform Installation

Configuration
Root Passw

Hostname

Network

Gustomer Genter
Online Update

Service

Users

Clean Up

Release Notes
Hardware Configuration

DRI SR A

Help

a Installation Settings

Skip Configuration

® Use Following Gonfiguration

CA Management

Greating default CA and cerfificate;
With higher security requirements, you should change the password

* CA Name! YaST_Default_GA

* Gommon Name: YaST Default GA (N2000Server)
+ Server Name: N2000Server site

* Country: US

+ Password: [root password]

* E-Mail: postmaster@site:

OpenLDAP Server

Start LDAP Server: NO

Changs... *

Back Abort Nt

13 Configure a user.

1.

2.

Next.

Preparation
¥ Language

¥ License Agreement
¥ System Analysis

¥ TimeZone

Installation

¥ Installation Summary
¥ Perlorm Installation

Configuration
Roct P
Hostname
Network.

assword

Online Update
Service

Users

Clean Up
Release Notes

DRCRT B ey

Help

Customer Center

Hardware Configuration LDAP

In the User Authentication Method dialog box, select the Local option button and click

& User Authentication Method

Authentication Method

@ Local (‘etc/passwd)

NS

Windows Domain

Back Abort Next

In the New Local User dialog box, leave all fields blank and click Next. A message is
displayed indicating that no user is logged in. Click Yes.
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Preparation
¥ Language
¥ License Agreement
¥ System Analysis
v

& New Local User

Time Zone

Installation
¥ Installation Summary
¥ Perform Installation

Configuration
¥ RootP

¥ Hostname
¥ Network
¥ Customer Center

User's Full Name
¥ Online Updats

¥ Service

= Users Usemame

® Clean Up "
Suggestion

® FRelease Notes

® Hardware Configuration Password

Gonfirm Password

Receive System Mail

Automatic Login

Help Back Abort Next

14 Confirm the release notes.

In the Release Notes dialog box, click Next.

Preparation
¥ Language

[T Release Notes

¥ License Agreement
¥ System Analys
¥ Time Zone SUSE Linux Enterprise Server 10

Installation

R Release Notes for SUSE Linux Enterprise Server 10 SP 1 for
«  Perform Installatien AMD54(TM) & InteI(Fl) EM64T

Configuration

¥ Root Password
v Hostname SP1 and GA Release Notes
¥ Network
¥ Customer Center These release notes cover the following areas:
« Online Update
r— ® General: Information that everybedy should read
v Lo ® Update: Ghanges related 1o updating that are not mentioned in the Administration Guide
® Installation: Additional pertinent information for the installation
< e Ly ® Technical: These sections contains a number of technical changes and enhancements for the experienced user
= Relcase Notes o Fecdback
® Hardware Ganfiguratien
General

Novell AppArmor

This release of SUSE Linux Enterprise Server ships with Novell ADpArmor. The APpAIMOT Intrusion prevention framework builds a firewall
around your applications by limiting the access to files, directories, and POSIX capabilities to the minimum required for normal operation.
AppArmor protection can be enabled via the AppArmor control panel, located in YaST under Novell AppArmor. For detailed information
about using Novell AppArmor, se the documentation in /usr/share/doc/packages/ apparmor -docs.

The AppArmor profiles included with SUSE Linux have been developed with our best efforts to reproduce how most users use their
software. The profiles provided work unmodified for many users, but some users find our profiles too restrictive for thelr environments.

1f you discover that some of your applications do not function as you sxpected, you may need to use the AppArmor Update Profile Wizard
in YaST {or useihe aa-logprof(8) command line utility} to update your AppArmor profiles. Place all your profiles into learning mede with
the following: aa-conplain fete/apparmor.d/+

When a program generates many complaints, the system's performance is degraded. To mitigate this, we recommend pericdically
running the Update Profils Wizard (or aa-logprof(8)) to update your profiles even if you choose to leave them in lsaming made. This
reduces the number of leaming events logged to disk, which improves the performance of the system o

Help Back Next

15 Configure the equipment.

1. Inthe Hardware Configuration dialog box, keep the default value of the Monitor and
Colordepth.

2. Click Test the Configuration to test the configuration of the graphic card.
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If graphics are displayed, it indicates that the graphic card is configured successfully. Click Save to
exit.

3. Click Next.

(iR [ Hardware Configuration
¥ Language
¥ License Agreement
¥ System Analysis
¥ TimeZone Skip Genfiguration
T ®) Use Following Configuration
¥ Installation Summary
¥ Perform Installation Graphics Cards
(Cii g =  Graphics card: VESA Framsbuffer Graphics
¥ PRoot Password ® Monitor: == VESA 1024 X766@60HZ (Aspect Unconfigured) - (1024x768)
¥ Hostname * Colordepth: 16 Bit (85536 Colors)
¥ Network ® Test the Configuration
¥ Customer Center
¥ Online Update Printers
¥ Service
¥ Users ® Listening to CUPS servers to provide access to remote queuss
¥ Clean Up
¥ Felease Notes Sound
= Hardware Gonfiguration ® Noi detected.
Change.. =
Help Back MNext

16 Complete the installation.

In the Installation Completed window, clear the Clone This System for Autoyast check box
and click Finish.

(FIpril=n @ Installation Completed
¥ Language

¥ License Agreement
¥ System Analysis

« TimeZone

Installation
¥ Installation Summary The installation has completed successiully. Your system is ready for use. Click Finish to log in to the system.

¥ Perform Installation
Please visit us at hitp:/www.novell.comvlinux.

Configuration

Root Password
Hostname
Network.
Custoner Center
Cnline Update
Service

Users

Clean Up
Release Notes
Hardware Configuration

B A A S A

Clone This System for Autoyast

Help Back
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17 log in to the OS and eject the disk.

1. Login to the OS as root user.

If you can log in to the SUSE Linux OS as the root user, it indicates that the SUSE Linux
OS is successfully installed. Otherwise, install the OS again.

2. Onthe GNOME desktop, right-click, and choose Open Terminal from the shortcut menu
to open the CLI. Then, run the eject command to eject the disk.

(1 noTE

If the IBM blade server is installed by using the drive of the virtual media device, run the eject
Name_of the virtual media_device command to remove the DVD.

Run the following command to check the name of the virtual media equipment:

# df -hk

If /dev/sr1 132136 132136 0 100% /media/05_04_2009 is displayed, it indicates that the name of
the virtual media equipment is /dev/sr1. The equipment name varies according to the actual situation.

——End

Follow-up Procedure

After the SUSE Linux OS installation is completed, you can enable the service to the remote
login OS according to the requirements, for details, see A.1.6 How to Log In to the OS Through
the Remote Login Tools?.

E.2 Verifying the Installation and Configuration of the OS

Procedure

This topic describes how to check the OS version, OS patch, the disk partitioning of the system
and the language environment variable of the system.

Run the following command to view the OS version:
# cat /etc/SuSE-release

If the following information is displayed, it indicates that the SUSE Linux version is correct:
SUSE Linux Enterprise Server 10 (x86_ 64)

VERSION = 10
PATCHLEVEL = 3

Run the following command to view the OS kernel version:

# uname -rv

The information similar to 2.6.16.60-0.54.5 is displayed. Here, 2.6.16.60-0.54.5 indicates the
kernel version of the OS.

If the kernel version is 2.6.16.60-0.54.5, it indicates that the kernel version is correct.

1 NoTE

If the SUSE Linux version or the kernel version are not correct, obtain the correct installation DVD of OS
and install the OS again.

3 Ensure that the disk partitioning of the system is correctly.

1. Run the following command to log in to the YaST2 Control Center:
# yast2
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In the YaST Control Center dialog box, click System > Partitioner.

View the disk partitioning information in the dialog box of displayed.

According to the displayed disk partitioning information, check whether the current disk
partitioning of the system is consistent with the disk partition planning. If they are
inconsistent, you need to reinstall the OS and then partition disks according to the disk
partition planning. For the disk partitioning planning, see H Planning Disk Partitions.

4 Ensure that the language environment variable of the system is en_US.

Run the following command to check the language environment variable of the system:

# echo S$LANG

If en_US is not displayed, change the language environment variable description in the /etc/
sysconfig/language file to RC_LANG="en_US". Perform the following steps:

1.

Run the following command to log in to the YaST2 Control Center:
# yast2

Choose System > /etc/sysconfig Editor. The /etc/sysconfig Editor dialog box is displayed.

Choose System > Environment > Language > RC_LANG. In Setting of: RC_LANG,
enter en_US.

Choose System > Environment > Language > ROOT_USES LANG. Set
ROOT_USES_LANG to yes.

Click Finish.

Run the following commands to restart the OS:

# sync;sync;sync;sync
# shutdown -r now

——-End
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Common Operations for the Blade Server

This topic describes common operations for the blade server. To learn more details and
operations about the blade server, see the manual delivered with the blade server to access the
official Web site of the blade server vendor.

F.1 Logging In to the Management Console of an IBM Blade Server

You can log in to the management software of the IBM management module to manage a blade
server remotely. This topic describes how to log in to the management software of the IBM
management module.

F.2 Mounting the Virtual Media on the IBM Blade Server

Mounting the virtual media refers to mounting the CD-ROM on the console to a blade server.
In this way, the software can be installed remotely. This topic describes how to mount the virtual
media on the IBM blade server.

F.3 How to View the MAC Address of the External Communication NIC of an IBM Blade Server

F.4 Logging In to the Management Console of an ATAE Blade Server
You can log in to the USM-E management software to manage an ATAE blade server remotely.
This topic describes how to log in to the USM-E management software.

F.5 How to View the MAC Address of the Base Plane of an ATAE Blade Server
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F.1 Logging In to the Management Console of an IBM Blade

Server

Prerequisite

Procedure

You can log in to the management software of the IBM management module to manage a blade
server remotely. This topic describes how to log in to the management software of the IBM
management module.

The JRE 1.4.2 08 or later must be installed on the Windows management terminal.

Log in to the Windows-based management terminal.

Open an Internet Explorer window. In the address bar, enter the IP address of the network port
on the management module of an IBM blade server, and press Enter.

The login dialog box is displayed.

Welcome to the Advanced Management Module

User ID: |

Password: ]

Enter the user name and password of the management module.

By default, the login user of the management module of the IBM blade server is USERID and
the password is PASSWORD. Click Log In.

A CAUTION

When you enter the initial password, note that the character after letter "W" is a number "0", but
not a letter "O".

Click Exit Wizard in the Advanced Management Module Configuration Wizard dialog box,
and the click OK and the management page is displayed.

In the left-hand pane, click Blade Tasks > Remote Control.
The Remote Control Status dialog box is displayed.
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IBM BladeCenter. E Advanced Management Module Welcome USERTD About | Help | Logout

Bay 1: SN#K1790 93NOKY

Monitors
= Blade Tasks Remote Control Status @
Power/Restart
Firmware status: Active
Configuration KVM ovner (since 05/14/2009 18:19:05): |Blade1 - SN#YK115293VIVM 7|
Serial Over LAN
Open Fabric Manager Media tray owner (since 05/14/2009 15:47:05): |Bladel - SN#YK115293V1VM j
/O Module Tasks Console redirect: In progress by the following users:
MM Control \USERID at 10.70.38.224 since 05/14/2009 18:48:08

Service Tools

Refresh

Start Remote Control @

Click "Start Remote Control” to control a blade remotely. A new window will appear that provides access to the Remote Console
and Remote Disk functionality. On this windowy, you will have full keyboard and mouse control of the blade which currently owns the
KWM. You will also be able to change KVM and media tray ownership.

Note: An Internet connection is required to download the Java Runtime Envirenment (JRE) if the Java 1.4.2 Plug-in is not already
installed. For best results, use Sun JRE 1.4.2_08 or higher, but less than 1.6.0 (JRE 6.0).

Start Remote Control

6 Click Start Remote Control.
The Warning-Security dialog box is displayed.

The application’ s digital signature has been
verified. Do you want to run the application?

Hame: com. 1ibm. asm. bladecenter. remotecontrol. ui. RemoteControl
Publisher: International Business Machines Corporation

From: http:ff10.71.210.240

v flways trust content from this publisher .|

Bun Cancel

The digital signature has been walidated by a

More Informaticn. ..
trusted source. -

1] noTE

JRE 1.6.0 is used as an example in this topic. In the case of the JRE of another version, the displayed dialog box
is different. Make selection according to the on-screen instructions.

7 Click Run to log in to the management console.

—-End

F.2 Mounting the Virtual Media on the IBM Blade Server

Mounting the virtual media refers to mounting the CD-ROM on the console to a blade server.
In this way, the software can be installed remotely. This topic describes how to mount the virtual
media on the IBM blade server.
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Prerequisite

The JRE1.5 08 or a later version must be installed on the Windows management terminal.

Procedure

1 Log in to the management console of the IBM blade server.

2 In the remote management console window, click Remote Drive. The Remote Disk dialog box
is displayed.

3 Inthe Media Tray field, select the board to be operated.

4 In the Available Resources pane, select the required installation mode.

The installation by using the virtual CD-ROM drive is implemented in two ways: using the
virtual CD-ROM drive and using image files.

® Ifyou use the virtual CD-ROM drive for the installation, do as follows:

1.  Click CD-ROM (G:) and then click Add.
(1 noTE

The drive letter after CD-ROM varies according to the actual situation.
2. Click Mount AlL
(0 noTE

For information on how to mount a CD-ROM, see the online help of the remote console. Specifically,

click a to display the online help of the remote console.

o= TIP
You can run the df -hk command in the terminal window to query whether the virtual media is
successfully mounted.

Run the df -hk command in the terminal window repeatedly until the terminal displays /dev/sr1
132136 132136 0 100% /media/05_04 2009. This message indicates that the virtual media is
successfully mounted. /dev/sr1 indicates the device name. The device name varies according to
the actual situation.

3. Insert the installation CD-ROM of the SUSE Linux 10 Enterprise Server 10 SP3 to the
CD-ROM drive of the computer where the management console resides.

® Ifyou use the image files for the installation, do as follows:

1. Click Select Image... and then click Add .The Open dialog box is displayed.
2. Select the location of the image files and then click Open.

A CAUTION

Make sure that the name of the directory where the image files are saved is short and
contains no space, punctuation or non-alphabetic characters.

—End

Follow-up Procedure
To eject the CD-ROM, do as follows:
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1. Run the following command to check the name of the virtual media device:
# df -hk

If the terminal displays /dev/sr1 132136 132136 0 100% /media/05_04_2009, it indicates
that the name of the virtual media device is /dev/srl. The device name varies according to
the actual situation.

2. Run the following command to eject the CD-ROM:

# eject Name of the virtual media device

F.3 How to View the MAC Address of the External
Communication NIC of an IBM Blade Server

Question
An IBM blade server is connected to the public network through I/O module 1 and I/O module
2. The system IP address of the IBM blade server must be set on the external communication
NIC. When setting the system IP address, you need to select the NIC based on the MAC address.
Answer
1 Log in to the management console of the IBM blade server.
2 Choose Monitors > Hardware VPD.
3 On the Hardware Topology tab page of the BladeCenter Hardware Information window,
search for the associated card by card number. Then, click SN number.
rModule Name Module Description
Chassis and Chassis Managed Components
Chassis BladeCenter-E
- [1] Media Module Media Tray
Management e I‘_ades
E1 [1-2] SH#YK115292W1HE \ HS21 (Type 5853)
' - [1]Blade Expansion Module PCIe Expansion Unit
“ [1] Expansion Card Ethernet EC
4 In the BladeCenter Inventory window, click the Ports tab to view the MAC address of the
external communication NIC.
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BladeCenter Inventory @

Irrvertory Ports

S X SNFYK115293W1HB MAC Addresses
'oyer [Managernent

irrrware VRD [ MAC Address 1 00:21:5E:63:CO0FO |
MAC Address 2 00:21.5E:63:C0:F2
MAC Address 3 Mot Available

MAC Address 4 Mot Available

B Blade
start

Rernote Contral

——End

F.4 Logging In to the Management Console of an ATAE
Blade Server

You can log in to the USM-E management software to manage an ATAE blade server remotely.
This topic describes how to log in to the USM-E management software.

Prerequisite

The JRE 1.5 08 or later must be installed on the Windows management terminal.

Procedure

1 Log in to the Windows-based management terminal.

2 Open an Internet Explorer window. In the address bar, enter the IP address of the network port
on the management unit of an ATAE blade server, and press Enter.

The login dialog box is displayed.

3 Enter the user name root and the password huaweiosta, and click OK.
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@) USM - Embedded

PIL | Home Apout | Help

ChagsisID:0  Location:

% system
[0 sherr © System >> Health Status (2]
E=)
System Status Minor
[ Blade
@) FanTray
Event Severity Location
% Power Chassis
critical l
Major J
Minor bladed ‘

Refresh

© Local resource

Blade Name

Hot Swap Status

M4

M4

M4

Status Description

w0 FRU Nat Instaled

1 FRU Inactive

2 FRU Activation Request

13 FRU Activation In Process

2] FRU Active

5] FRU Deactivation Request

[ FRU Deactivation In Progress

M7 Commurnication Last

No. Health Status

0 o system
1 @ shelf
2 ® smm
3 ® blade1
4 ® bladez
5 @

4 In the left-hand pane, click Blade > Remote Control.
The Warning-Security dialog box is displayed.
(1 noTE

JRE 1.6.0 is used as an example in this topic. In the case of the JRE of another version, the displayed dialog
box is different. Make selection according to the on-screen instructions.

5 Click Run to log in to the management console.

® Blade >>Virtual Media

© Blade =>> KVM

(7]

Select Blade | IPIease select... | | Cold Reset | |

Refresh Blade | |

a PP P

L7 5 || &

&

num M| caps M| scroll B

6 Inthe Blade = KVM panel, select the required board.

Issue 05 (2010-11-19)

Huawei Proprietary and Confidential

Copyright © Huawei Technologies Co., Ltd.

F-7



iManager U2000 Unified Network Management System
Single-Server System Software Installation Guide (SUSE

F Common Operations for the Blade Server Linux)

A CAUTION

Click the board number on the toolbar to select the required board.

&= TIP

® To enter the full screen mode, click on the toolbar.

® To restore from the full screen mode to window, move the mouse to upper middle of the screen, press
Ctrl+Shift+Alt and click i in the upper portion of the screen.

—End

F.5 How to View the MAC Address of the Base Plane of an
ATAE Blade Server

Question

Answer

An ATAE blade server is connected to the public network through the base plane. The system
IP address of an ATAE blade server must be set on the NIC of the base plane. When setting the
system IP address, you need to select the NIC based on the MAC address.

Log in to the management console of an ATAE blade server.

In the Blade >> KVM panel, select the required board from Select Blade, and click
Cold Reset to restart the blade server.

In the process of restarting the blade server, when the American Megatrends window is
displayed, press Delete to display the BIOS SETUP UTILITY window.

In the BIOS SETUP UTILITY window, press Tab to choose Advanced > PXE Function
Configuration from the main menu.

The PXE Function Configuration window is displayed. Record the MAC addresses of the base
plane.
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BIDS SETUP UTILITY

BaseZ PHE Function [Enablel

e TIP

Record the MAC addresses of the base plane so that you can select the correct NICs for external
communication when you set the network.

Press Esc to return to the main menu.

—End
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Configuring the OceanStor 52600 Disk
Array by Using the ISM

This topic describes how to configure the OceanStor S2600 disk array using the [ISM.

Prerequisite
® The IP addresses for both controllers of the OceanStor S2600 disk array are configured.
® The primary and secondary power supplies of the disk array have been powered on. For
more information, see 5 Powering On a Server.
® The Window management terminal must communicate properly with the disk array
controller.
®  Users are logged in to the ISM from the Windows management terminal by using the
Internet Explorer 6.0, Internet Explorer 7.0, or Internet Explorer 8.0.
Context
(O noTe
The ISM software will lock up if an operation is not performed within 10 minutes after login. Enter the
password again to log in if lock up occurs.
The following table shows the configuration requirements on the OceanStor S2600 disk array.
A CAUTION
The following requirements are for the OceanStor S2600 (6 x 300 GB) disk arrays only. A
OceanStor S2600 disk array (6 x 300 GB) is equipped with six hard disks, each of which is 300
GB in size. If the selected disk arrays are not the OceanStor S2600 disk arrays (6 x 300 GB),
contact Huawei engineers for details about how to configure the disk arrays.
Configure | Settings
Item
Hot-spare The sixth disk is designated as the global hot-spare disk.
disk
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Configure | Settings
Item

Host group | Set the host group name to HostGroup001.

and host Set the host name to Masterserver.

RAID group | ® Setthe RAID group name to RAID001.

® Sect the RAID Level to RAIDS.

® Set the disk type to SAS.

® The first five disks serve as the RAID group.

LUN Configure one LUN as follows:
® LUN information
- Name: LUNO0O1
- Capacity: 1000 GB
- Stripe unit size: 32 KB
- Home controller: controller A
® Cache strategy
- Prefetch strategy: intelligent
- Write strategy: write back (mirroring)

® Mapping mode
Mapping object: host group name HostGroup001

Port ® Set the type to FC.

Set the name associated with the first identifier to portl.

® Set the name associated with the second identifier to port2.

Procedure

1 Log in to the ISM.
1. Open the Internet Explorer on the Windows management terminal.
2. Enter http://XXX.XXX.XXX.XXX in the address bar of the Internet Explorer (where

XXX . XXX .XXX.XXX indicates the [P address of the management network port of the
storage array controller). Such as http://129.9.1.10.

1 noTE

If "The page cannot be displayed" is displayed on the Internet Explorer, the Windows management
terminal and the disk array controller fail to communicate with each other. Check the network
connection.

The system will navigate to the default login window of the ISM, as shown in the following
figure.
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Based on the SMI-§ standard

Version No.:01.02.01.210.T10{2010-04)

.*-_i ? Click Here to Launch OceanStor ISM

FEriendly operation interface
Please Setup JRE for Windows

Please Download Other JRE Reeal-time collection of the information

g &
SEVE -

3. Click Click Here to Launch OceanStor ISM. The system will check whether the ISM is
installed on the Windows management terminal.

A CAUTION

® Before installing the ISM, install the Java runtime environment (JRE). The JRE version
must be 1.5.0 or later (excluding version 1.5.0.16). In the CLI, run the java -version
command to view the JRE version. If the JRE is not installed, click Please Setup
JRE.

® Donotuse JRE 1.5.0.16. Downloading the ISM may fail due to the bugs in JRE 1.5.0.16.

If the ISM is not installed on the Windows management terminal, the system will
automatically download and install the ISM by means of the Java web start (JWS). If the
ISM is installed on the Windows management terminal, the system will automatically check
the software version. If the version of the ISM is not the latest version, the system will
automatically upgrade the software to the latest version.

4. Inthe Warning - Security dialog box, select Always trust content from this publisher
and click Run.

5. Decide whether or not to create an ISM shortcut on the desktop and in the Start menu.
The system will open the login window of the ISM, as shown in the following figure.
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— Login

Language: |Eng|ish -]

User Mame: |

Password: |

Login | Cancel Option ==

6. Select the required language from the Language drop-down list. Then, enter the user name
in User Name and the user password in Password.

(11 noTe
® A disk array can be discovered only when the entered user name and password are the same as
those of the disk array.
® The default user name and password for logging in to the ISM are admin and 123456. After
login, change the password immediately and keep the password confidential.

7.  Click Login to access the Welcome window, as shown in the following figure:

% OceanStor ISM 01.02.01.103.T01

Welcome to use the OceanStor ISM integrated storage management system. Uze

the "Discover array” function to search the storage devices.

Bazed on the SMI-S standard

The OceanStor ISM integrated storage
management system can manage the storage
devices that support the SMI-5 standard.

Friendly operation interface
The user—friendly operation interface
<=l facilitates management and maintenance.

Real-time collection of the information

® fuick Learn OceanStor ISH =F
% - Real-time indications and reports of the

# Visit Huawel website L=

Discover by the following mode:

Q Discover array

storage devices runming status help te obtain
the latest status of the device.

[ Don' ¢ dizplay thiz dialeg again

2 Discover disk arrays.
1. Inthe Welcome window of the ISM, click Discover array.
The Discover array dialog box will be displayed, as shown in the following figure.

G-4 Huawei Proprietary and Confidential Issue 05 (2010-11-19)
Copyright © Huawei Technologies Co., Ltd.



iManager U2000 Unified Network Management System
Single-Server System Software Installation Guide (SUSE G Configuring the OceanStor S2600 Disk Array by Using the

Linux)

ISM

x

Search Modes

¢ Specify IP Address (specify the IP address of the array
management network interface for queny)

IF Address: |

{~ Specify IP Address Range i(specify the [P address range
of the array management netwark interface for query)

Start IF Address: |

End IF Address: |

{= Same Subnet (query arrays which lie in the same subnet as client)

oK Cancel Help

Select a mode for discovering disk arrays according to the conditions at your site. Table
G-1 describes the parameters for discovering disk arrays.

Table G-1 Parameters for discovering disk arrays

Parameter Description

Specify IP Address | Indicates that disk arrays are discovered according to the IP
address of the management network port on the specified disk
array.

When you specify the IP address, the first field on the left ranges

from 1 to 223 (except 127), the last field ranges from 1 to 254,
and the other fields range from 0 to 255.

Specify IP Address | Indicates that disk arrays are discovered according to the IP
Range address segment of the management network port on the specified
disk array. Start IP Address and End IP Address indicate the
start IP address and end IP address of disk arrays to be discovered.
When setting this parameter, pay attention to the following points:

® The discovery range is the IP subnet segment of the ISM client.

® The first field on the left ranges from 1 to 223 (except 127),
the last field ranges from 1 to 254, and the other fields range
from 0 to 255.

® The start IP address must be smaller than or equal to the end
IP address.

Same Subnet Indicates that the discovery range is the [P subnet segment of the
ISM client. This mode is the default discovery mode of the system.

Click OK. After disk arrays are discovered, the Info dialog box will be displayed,
prompting an operation success.
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4. Click OK. The Warning dialog box will be displayed.
waming x|

& Are you sure to initialize arrays?

3 Initialize the configuration.
1. Inthe Warning dialog box, click OK to initialize the disk array.
The Initial Configuration dialog box will be displayed, as shown in the following figure.

Initial Configuration x|

mb The following arrays can be initialized. Click "Initial Comfiguration .."
button and the initial configuration wizard will be shown.

~Array Inforrmation

MHame Serial Mumhber
[ | NMS 21023151270000002653

Initial Configuration... |

Close Help |

2. Select the disk array to be configured and click Initial Configuration. The Initial
Configuration Wizard: Welcome dialog box will be displayed.
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Initial Configuration Wizard: Welcome x|

Welcome to initial configuration wizard
This wizard helps to:

n  Modify array clock and location

m Setarraytime

= Modify user password

m  Setarray ports

Click"Mext" to continue.

Previous | mext| Cancel | Help |

3. Click Next. The Initial Configuration Wizard: Modify Array dialog box will be

displayed.

Initial Configuration Wizard: Modify Array 5[
Infarmation about the selected array. Modification ofthe name and location is
allowed here.

Name: [NmS

Lacation: |F4

Production type: OceanStor 52600
Health state: Marmal

Running state: Qnline

Total capacity (GB): 1,614
Controller A IF address: 10.71.210.221
Controller B IP address: 10.71.210.199
Click "Mext" to continue.

Previous | ﬁext| Cancel | Help |

4.  Enter the name of the disk array in the Name text box and the location information in the
Location text box. Table G-2 describes the parameters for modifying a disk array.
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Table G-2 Parameters for modifying a disk array

Parameter

Description

Name

Specifies the name of the OceanStor S2600 disk array to be
configured. When setting this parameter, note that:

® This parameter contains only the characters and numerals in
DBC case, underscores (_), en-dash symbols (-), and
simplified Chinese characters.

® This parameter consists of 1 to 32 characters. A Chinese
character counts for two DBC characters.

Location

Specifies the location of the OceanStor S2600 disk array to be
configured. When setting this parameter, note that:

® This parameter contains only the characters and numerals in
DBC case, underscores (_), en-dash symbols (-), and
simplified Chinese characters.

® This parameter consists of 1 to 32 characters. A Chinese
character counts for two DBC characters.

Click Next. The Initial Configuration Wizard: Modify Array Clock dialog box will be

displayed.

Initial Configuration Wizard: Modify Array Clock x|

Clock of the selected array. Modification is allowed here.

Date Tirme

APR =] | 2009|Z|‘

SUMN MOM TUS WED THU FRI SAT
1 2 3 4 - -
5 7 a 10 1

16 17 18

El e =5

30

[az]
oo

14

-
kd b =
e B = R R ]
Wwoka R

L

28

16:06:095

Click "Mext" to continue.

Erevious | | Cancel | Help |

Select the required date and time, and then click Next. The Initial Configuration Wizard:
Modify User Password dialog box will be displayed.
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Initial Configuration Wizard: Modify User Password il
Infarmation about current user. The passwaord is allowed to be modified.
:‘ u| W User Type: Administratar
1 \\ User Mame: admin
i b
= Old Passwaord: |

Mew Password: |

Confirm Password: I

Click"Mext" to continue.

Erevious | | Cancel | Help |

7. Change the login password of the user. Table G-3 describes the parameters for changing
the user password.

Table G-3 Parameters for changing the user password

Parameter Description

Old Password Specifies the original password. The default password is 123456.

New Password | Specifies the new password. It ranges from 6 to 16 characters.

Confirm Confirms the new password. When setting this parameter, pay
Password attention to the following points:

® This parameter ranges from 6 to 16 characters.

® This parameter value must be the same as the value of New
Password.

8.  Click Next. The Initial Configuration Wizard: Modify FC Host Port dialog box will be
displayed.

(1 noTE

Click Modify Speed if the port rate needs to be changed. The default rate of an online port is 4 Gbit/
s.
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Initial Configuration Wizard: Modify FC Host Port x|
Click the "Modify Speed..." to modify the selected port's speed.
- FC HostPaort
Contraller ID Faort ID Running State Speed(Ghps)
| A 00 anline 4
r|A 01 Offline 1
| B 0o online 4
r|e 01 Offline 2
Moty Speedl |
. Wizard operation finished. Click "Finish” button to close the wizard.
Erevious | Cancel Help
9.  Click Finish to complete the initial configuration.
10. Click Close to exit.
4 Configure the hot-spare disk.
1. Click the Physical View tab in the navigation tree, and then select the OceanStor S2600
disk array to be configured.
2. Choose Configuration > Hot-Spare Disk Management from the main menu. The Hot-
Spare Disk Management dialog box will be displayed.
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Hot-5Spare Disk Management ll

Hot-Spare Disk:

|_| Laocation | Fhysical Type | Lagical Type | hiodel | Owning RAID Group | Capacity {GB) | Health Status Running Stat

dl¥lalal
Free Disk:
I~ | Location | Physical Type | Logical Type todel Owning RAID Group | Capacity (GB) | Health Status | Runni
[T Free Disk ST330065655 278 | Mormal anline
| ooos | =g Free Disk ST3300B565S 278 | Mormal anline
4| | >
oK Anply cancel | Help |

3. Select disk location (00,05) from the free disk list and click the third button (ﬁl) in the
middle portion of the dialog box to add the selected disk to the hot spare disk list.

Hot-Spare Disk Management

x|
Hot-Spare Disk:
[T Location Physical Type Lagical Type Model Owning RAID Group Capacity (GE) Health Status Running Stat
[~ 0005 SAS Free Disk 5T33.. - 2759 | Mormal Cnline
4] | »
M| ¥|~|A]
Free Disk:
[ | Location Physical Type Logical Type hodel Cwning RAID Group Capacity (GB) Health Status Runni
T (o004 SAS Free Disk ST330065655 278 | Marmal Cnline
| | 3
oK Apply Cancel Help
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4. Click OK to close the Hot-Spare Disk Management dialog box. Click OK in the
Warning dialog box. Then, click OK in the Info dialog box.
5 Create a host group and host.
1. Choose Logical View from the navigation tree and select the OceanStor S2600 disk array
to be configured.
2. Choose Configuration > Create Host Group from the main menu. The Create Host
Group dialog box will be displayed.
x
Host Group Name: [HostGroupoo
Qperation System: |Linux j
(8] | Apply Cancel | Help |
3. Select Linux, and then click OK.
The Info dialog box is displayed indicating that the operation was completed.
(1 noTE
In this step, the selected OS corresponds to the OS of the server connected to the disk array.
4. Click OK to complete creating the host group.
Choose the host group from the navigation tree, and then choose Configuration > Create
Host from the main menu. The Create Host dialog box will be displayed.
x
o The created virtual host name is the same as the real
service host name.
Host Group Mame: HostGroup001
Qperation System: Linux
Host Name: [Masterserver
QK | Apply | Cancel Help
6. Enter the host name and click OK to continue.
= TIP
It is recommended to enter the host name of the server connected to the disk array so that the host
name is easy to remember.
The Info dialog box will be displayed indicating that the operation was completed.
7. Click OK to complete creating the host.
6 Create a RAID group.
1. Choose Logical View from the navigation tree and select the OceanStor S2600 disk array
to be configured.
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2. Choose Configuration > Create RAID Group from the main menu. In the Create RAID
Group dialog box, modify the settings, as shown in the following figure.

x|

RAID Group Parameters

RAID Group Narme: |RAIDEIEI1

RAID Level: [RAID 5 =]

Select Disks

Disk Type: [543 |
MNurnber of Sub-Groups: | |
(e Murnber of Disks: | =]
& Manual

[¥ | Location Rotation Speed (rpm) Capacity (GB) Type

¥ | (00,00 15,000 264 | ST3300B5E5E
[W | (00,01 14,000 2f4 | ST3300RARSE
¥ | (00,02 15,000 264 | ST3300B5E5E
[¥ | (00,03 15,000 264 | ST3300B5655
[V | (00,04 15,000 279 | ST3300B565E
Remaining Disks: 0 Selected Disks: 5 Total Capacity (GB)Y. 1,335 GB

[8]34 | Anply | Cancel | Help

3. Click OK. The Info dialog box will be displayed indicating that the operation was
completed.

4. Click OK. Creation of the RAID group is completed.

7 Create Lun001.

1. Click the Logical View tab in the navigation tree and select the RAID group where the new
Lun001 locates.

2. Choose Configuration > Create LUN from the main menu. The Create LUN Step 5-1:
RAID Group Information dialog box will be displayed.
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Create LUN Step 5-1: RAID Group Information x|

Infarmation aboutthe selected RAID Group.

Mame: RAIDO0O1
RAID Level: RAID 5
Total Capacity (GE) 1,057.58
Free Space (GB): 1,057.58
HNumber of Disks: 5

To continug, click Next.

pevons |CTREETTY cenesl | b |

3. Click Next. The Create LUN Step 5-2: Type LUN Information dialog box will be
displayed.
Configure the settings as shown in the following figure.
Create LUN Step 5-2- Type LUN Information ﬂ

Type the name, capacity, stripe unit size, and owning controller of the LM,

Mame: fLunnni
Capacity: (s Other Capacity ¢ Awailable Capacity
f1ooo {68 ]

Stipe UnitSize (key: R - |

= ContrallerA ¢ Caontroller B ‘

Owening Controller;

To continue, click Mext.

Previous I Mext I Cancel | Help I

4. Click Next. The Create LUN Step 5-3: Select Cache Strategy dialog box will be
displayed.
Configure the settings as shown in the following figure.
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Create LUN Step 5-3: Select Cache Strategy ﬂ

Select Cache prefetch stratedy and write strateoy.

~ Prefetch Strategy
" MNone

= Intelligent

" Constant  prefetch Value (0-1024 KB): |
" Variable  Prefetch Multiple (0-65538): I

— Wirite Strategy
¢ \Wiite Through

= Witite Back [mirroring |

¢ Force Write Back |Mirmring ]

To continue, click Mext

prevous | IHET] cancel | elo |

5. Click Next. The Create LUN Step 5-4: Select Mapping Mode dialog box will be
displayed.
Configure the settings as shown in the following figure.

x4
Select mapping mode.
|Map x| SelectMapping Objact: |Host Group Mame x|
Hiost Group Marme 05
[T | Default Host Group windows
¥ | HostGroup0od Liom
HostLUNID: [0 ]
Ta continue, click Mext.
Previous |  Mett |  cancel | Help |

6. Click Next. The Create LUN Step 5-5: Confirm dialog box will be displayed.
Configure the settings as shown in the following figure.

Issue 05 (2010-11-19) Huawei Proprietary and Confidential G-15
Copyright © Huawei Technologies Co., Ltd.



iManager U2000 Unified Network Management System
G Configuring the OceanStor S2600 Disk Array by Using the  Single-Server System Software Installation Guide (SUSE
ISM Linux)

Create LUN Step 5-5: Confirm x

Confirm LUM information and narme: Lun0o1

 Basic Information

Stripe Unit Size (kB 16 Capacity (GBY: 1000.00
Owening Contraller: A RAID Level: RAID 5
RAID Group Marmne: RAIDO0

— Cache Strategy
Prefetch Strateay: Intelligent

Write Strategy: Wirite Back Mirraring

— Mapping Information

Host Group Mame: HostGraupdod

0s: Liroux Host LUN ID: 1]

After confirmation, click Finish.

Previous I Elnlsh| Cancel | Helg |

7. Click Finish. The Info dialog box will be displayed indicating that the operation was
completed.

8. Click OK. Creation of Lun001 is complete.
8 Addaport.

1. Choose Host from the navigation tree, and then choose Configuration > Host Port
Management from the main menu. The Port Management dialog box will be displayed.

x|
Host Marme: Masterserver
~ Pont
Mame ldentifier Type
Add Mo dif | Remove . |
Close | Help |

2. Click Add. The Add Port dialog box will be displayed.
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x|
Host Mame: Masterserver
FPort Status: Connected
Type: |FC |
VI |2100001b320672¢0 |
Marme: |F'|:|rﬂ
(8] | Apply | Cancel Help

3. Select the first available option from the WWN drop-down list, enter portl in Name, and
then click Apply. In the dialog box that will be displayed, click OK.

4. Click Add again. The Add Port dialog box will be displayed.

Enter port2 in the Name text box, and click OK. In the dialog box that will be displayed,
click OK.

9 Check the connection of the fiber card.

1. Login to the server OS as user root.

2. Run the following command to check the connection status of the port on the fiber card:
# cd /sys/class/scsi_host/hostport ID
# cat state

1 noTE

In the preceding command, port ID indicates the ports through which the disk array connects to the
server.

You can run the Issci command to query port IDs. the first column in the returned message displays
the port IDs of the fiber card. For example, run the following command:

# lssci

The following message will be displayed:

[0:0:0:0] disk IBM-ESXS CBRBA146C3ETSO N C49B -
[0:0:1:0] disk IBM-ESXS CBRBA146C3ETSO N C49B -
[0:1:0:0] disk LSTLOGIC Logical Volume 3000 /dev/sda
[3:0:0:0] disk HUAWE I 52600 1 /dev/sdb
[4:0:0:0] disk HUAWEI 52600 1 /dev/sdc

Find the last two lines containing S2600 in the fourth column. Information in the first columns
([3:0:0:0] and [4:0:0:0]) indicates that the S2600 disk array connects to the server through port 3
and port 4.

The following message will be displayed:
Link Up - Loop

(1 noTE

If the fiber card is not in the Link Up state, check and ensure the following aspect:
® The fiber is properly connected to the optical module.

® There is not any damage to the fiber.

® The optical module is properly connected to the fiber card.

[

The indicator of the fiber card is functioning properly.
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3. Run the following commands to restart the OS of the server and refresh the disk status:
# sync;sync;sync;sync
# shutdown -r now

—End
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Planning Disk Partitions

This topic describes the disk partitioning scheme that is determined according to the sizes and
quantity of the server hard disks.

Before manually installing the OS, you need to specify the disk partitioning scheme. If the OS
is installed through the rapid installation DVD, you can skip this part. The installation software
automatically performs disk partitioning according to the disk size.

The standard configuration of an SUSE Linux server is two hard disks with the capacity of 146
GB. One of the disks functions as the mirrored disk that need not be partitioned.

Table H-1 Scheme for disk partition

Partiti | Path Form | Load | File Number | Description
on atted | Poin | System of Hard
Type or t Disks (146
Not GB)

Primar | /dev/ Yes / Ext3 10 It is the root partition.
y sdal
partitio
n /dev/ Yes swap | Swap 16 It is used for switching

sda2 data in the system.
Extend | /dev/ Yes Ext3 In addition, the size of
ed sda3 this partition is for
partitio reference and is allocated
n automatically by the

system. Therefore, you
need not set the size of
this partition manually.

Logical | /dev/ Yes /usr Ext3 10 It is a logical partition in

partitio | sda5 the extended partition.

n This partition is used for
storing programs or files
of users.
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Partiti | Path Form | Load | File Number Description
on atted | Poin | System of Hard
Type or t Disks (146
Not GB)
/dev/ Yes /var Ext3 10 It is a logical partition in
sda6 the extended partition.
This partition is used for
storing system logs.
/dev/ Yes /opt Ext3 80 It is a logical partition in
sda7 the extended partition.
/dev/ Yes / Ext3 10 It is a logical partition in
sda8 expor the extended partition.
t/
home

H-2
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I Acronyms

ACL
ASCII

CD-ROM
CPU

DC
DCN
DHCP

ESN

FTP

ID
iMAP
1P

Access Control List

American Standard Code for Information Interchange

Compact Disc-Read Only Memory

Central Processing Unit

Data Center
Data Communication Network

Dynamic Host Configuration Protocol

Equipment Serial Number

File Transfer Protocol

Identity
Integrated Management Application Platform

Internet Protocol
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IPMP IP Network Multipathing
K
KVMS Keyboard, video, mouse (KVM) switch
L
LCT Local Craft Terminal
LAN Local Area Network
M
MML Human-Machine Language (formerly Man-Machine Language)
MPLS MultiProtocol Label Switching
MA Media Service Access
MAC Media Access Control
MAN Metropolitan Area Network
MAU Medium Attachment Unit
N
NBI Northbound Interface
NE Network Element
NIC Network Information Center
NMS Network Management System
NTP Network Time Protocol
(0]
OEM Original Equipment Manufacturer
0S Operation System
0SS Operation Support System
P
PPP Peer-Peer Protocol
PSTN Public Switched Telephone Network
I-2 Huawei Proprietary and Confidential Issue 05 (2010-11-19)

Copyright © Huawei Technologies Co., Ltd.



iManager U2000 Unified Network Management System
Single-Server System Software Installation Guide (SUSE

Linux) I Acronyms
PVC Permanent Virtual Circuit
R
RAID Redundant Array of Independent Disks
S
SCSI Small Computer Systems Interface
SDH Synchronous Digital Hierarchy
SNMP Simple Network Management Protocol
SQL Structured Query Language
SSH Secure Shell
T
TCP Transport Control Protocol
TFTP Trivial File Transfer Protocol
8]
UDP User Datagram Protocol
UPS Uninterrupted Power Supply
X
XML Extensible Markup Language
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